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Asout THis Book

What is the OPEN LOOK User Interface?

The OPEN LOOK™ User Interface (Ul) uses windows and menus with
common graphic symbols instead of typed system commands to provide an
intuitive environment.

With the OPEN LOOK UI, users are presented with a consistent screen layout
that can be used across various platforms and operating systems. This
common look and feel benefits end users, application programmers, and
software vendors.

The OPEN LOOK Ul is not a piece of software. Rather, it is a specification for
a user interface that builds on the foundation of graphical user interface
design pioneered by the Xerox Corporation.

While it is possible for the application developer to implement the OPEN
LOOK U! “from scratch.” the usual implementation approach is to use a toolkit
that has been written for a specific windowing platform. The toolkit provides a
set of routines that implement the various interface elements as specified in
this book. The application developer, in turn, uses the routines provided by
the toolkit to create and position the interface elements as needed.

Audience

The primar this DOOK I1s the potential developer of a toolkit that
implements t Sl

Anothe fe application developer who is interested in either
porting r developing a new application for the OPEN
LOOK EN LOOK Graphical User Interface Applicatio

Style G re specifically 1o the application developer
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By providing guidelines for using the elements of the OPEN LOOK UlI, this book
promotes consistency across applications.

A third audience for this book is the nontechnical reader who is interested in
the general design of the interface. Although the primary focus of this book is
the detailed functional description necessary for toolkit and application
development, it is important to remember that this functionality must make
sense from the perspective of the user. To maintain this focus and emphasize
its importance, the functional elements are described from the point of view of
how you, as a user, communicate with the OPEN LOOK UI.

Trademark Licensing

The name “OPEN LOOK" is a trademark of AT&T. The right to use the OPEN
LOOK trademark is subject to a certification procedure. To encourage
consistent OPEN LOOK Ul implementation across a wide variety of hardware
platforms and operating systems, AT&T offers OPEN LOOK trademark licensing
for three levels of certification:

O Level 1 is a complete user interface, containing all the essential features.
This is the minimum features set required for a toolkit to be certified as level
1 compliant. The requirements for Level 1 certification are documented in
The OPEN LOOK Graphical User Interface Trademark Guide, which is avail-
able from AT&T.

O Level 2 is a superset of Level 1. It is anticipated that this level will be the
most common level of compliance. The complete set of Level 2 features
must be provided for an implementation to be certified as Level 2 compliant.

O Level 3 is a superset of Level 2. This level is provided for more specialized
features and to provide a mechanism for extending the functionality of the
OPEN LOOK UI.

Appendix A, “Certification,” for a detailed list of elements required for
level of certification.
book presents the technical specifications for the OPEN LOOK UI.
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Part III, Required OPEN LOOK UI Functionality

This part of the book describes the required menus and workspace
properties, the File Manager, the Process Manager, and mouse and keyboard
functionality.

Chapter 10, Required OPEN LOOK Ul Menus: The menus that an
OPEN LOOK Ul implementation must provide: Workspace, Window, Pop-up
Window, Property Window Settings, Scrollbar, and Edit for text fields.

Chapter 11, Workspace Properties: The default global settings provided in the
Workspace Properties window.

Chapter 12, File Manager: The required elements of the OPEN LOOK file
management application.

Chapter 13, Process Manager: The required elements of the OPEN LOOK
process management application.

Chapter 14, Keyboard and Mouse Specifications: How mouse buttons are
used and keyboard operations.

Part IV, Using the OPEN LOOK UI
This part of the book describes how you use the OPEN LOOK UI.

Chapter 15, Using Menus: How you view and choose from menus.

Chapter 16, Selecting and Operating on Windows, Icons, and Panes: How you
select and operate on single and multiple windows, icons, and panes.

Chapter 17, Selecting and Operating on Text and Graphics: How you select
d operate on text and graphics.

Chapter 18, Using Property Windows: How to apply settings with property

C

endices

k has four appendices, as described in the following paragraphs.

< A, Certification: Three levels of certification for the OPEN LOOK UI.




About This Book

Appendix B, Details of Design Elements: Bitmap renditions for pointers,
carets, icons, workspace and menu drop shadow patterns in pixels. Engi-
neering drawings for the visual elements of an OPEN LOOK Ul implementation
specified in points and inches. Tolerances are provided to allow for variation
in pixel and display size.

Appendix C, OPEN LOOK Ul Help Text: Help text for the basic required OPEN
LOOK Ul elements.

Appendix D, International Considerations for the OPEN LOOK User Interface:
Issues tc consider when designing an international implementation of the
OPEN LOOK UI.

Glossary: An alphabetical list of terms used in this book with definitions.

Conventions Used in This Book

The following conventions are used in this book:

0O Terms introduced for the first time are in italic type and are defined in the
Glossary.

O Mouse buttons are referred to by function, not by location on the mouse. For
example, “click SELECT" is used, not “click LEFT."

O The names of mouse buttons are capitalized. For example, “press SELECT."

O Keyboard keys have an initial capital letter. For example, "to validate a text
field, press the Tab key.”

O To perform certain functions, you hold down one key while you press a sec-
ond key or mouse button. This combination of keystrokes is shown in the
following way: “Press Ctrl/MENU."

O Keyboard functions are also referred 1o by function. not by the location or
name of a specific ey on the keyboard. For example, SELECTCHAR s used
to define the functits selecting a single character by pressing both a
modifier key and I mouse button at the same time

O The tern nplementation” refers to toolkits and applications

that have meet this functional specification
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Device Independence

One of the most innovative aspects of the OPEN LOOK Ul is that it is the first
graphical user interface designed to run on a wide variety of machines. As an
open industry standard, the OPEN LOOK Ul must accommodate displays of
different sizes and resolutions; monochrome, grayscale, and color; and
different keyboards and pointing devices.

Consequently, the OPEN LOOK Ul is specified in terms of units that are
independent of any particular device. The unit used in this specification is the
point—the basic unit of typographical measurement—equal to approximately
1/72 of an inch (0.352 millimeters). Refer to Appendix B for detailed specifica-
tions of each element.

When units refer to the screen display itself, the unit used in this specifica-
tion is the pixel, an abbreviation for picture element.

International Considerations

The OPEN LOOK Ul does not provide specifications for international
markets. Instead, Appendix D provides a discussion of issues that should be
considered in the process of designing a toolkit that can be used in a
multinational market.

This book describes the user interface as localized for an American English
audience, and therefore reflects that bias in the following ways:

O The orientation of text is from left to right and top to bottom.

0 Capitalization styles are recommended based on English usage.

O Customary American spelling is used.

O A sans serif variable width font is specified for the required elements of the
user interface.

1 Some icons and glyphs may be inappropriate for other languages and
locations.

Style Guidelines

<amples in this book show some of the ways elements can be used

bined. The OPEN LOOK Ul offers the application developer a great
bility in deciding how the controls are displayed and grouped

examples in this book are for purposes of illustration only and
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Table 1-1 shows the goals of the OPEN LOOK Ul project and the approach

taken to meet them.

Table 1-1 OPEN LOOK Ul design goals

Goal

Approach

Benefit

Easy to learn

Base the interface on a
small number of simple
concepts.

The system is easy to
learn initially, and users
can get work done right
away.

Easy to learn new
applications for
experienced user

Provide a consistent
interface. For example,
both the window
manager and
applications work the
same way.

The user can leverage
knowledge and learn
new applications.

Efficient for experts

Minimize keystrokes and
mouse travel.

Increased productivity.

Distinctive user interface

Design a visually
uncluttered and
consistent look.

The OPEN LOCK Ul
becomes a signature
that people recognize.

Easy migration for other
interface users

Harmonize with other
user interfaces.

Users can move easily
among the major user
interfaces with minimal
retraining.

The OPEN LOOK Ul takes advantage of current bitmap workstation design
and operates efficiently in a multi-tasking operating system environment. You
n begin an operation in one window and continue working in another

t needing to learn the concept of “background processing.”
levice independence of the OPEN LOOK Ul means that applications
d using the interface will adapt well to new technology as it is

ad




Design Philosophy

The OPEN LOOK Ul design builds on familiar concepts pioneered by Xerox
Corporation. Because of the attention paid to functional consistency among
user interface designs, you can easily switch between systems without
needing to refocus attention on how the interface works.

Visual Style

The visual design of OPEN LOOK Ul elements is restrained. The design of
each element is clean and simple. It provides a consistent environment that
acts as the background against which the application’s information is
featured. When the interface 1s uncluttered, the application becomes the
center of focus and attention.

The OPEN LOOK Ul is based on a standard set of elements. Each element—
for example, a font, a button, a symbol, or a menu—is designed with a focus
on how it fits into the whole. Borders are used to define different areas of the
screen, such as a window, a menu, or a pane. Controls are arranged in
groups within these borders.

There are two visual designs for the OPEN LOOK UI:

O A black-and-white design for use on monochrome displays.
O A three-dimensional design for use on grayscale and color displays.

Fonts

A sans serif, vanable width font is used for the common elements of the
OPEN LOOK Ul Consistent use of the same font in all the elements of the
interface contributes to the design concept of the interface as a backdrop
against which the application is featured. Of course, an application can use
whatever fonts the developer chooses In the part of the window that is

reserved for the display of application information
Color

An OPEN ' plementation can be used on monochrome or color
displays. A ; tanon can use either black-and-white or three-
dimensiotial d ts Whean a color implementation uses black-
and-whitg 08 the borders are usually black, and color Is added
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to the window background. On systems with a limited number of highly
saturated colors, the borders may be in color.

A color implementation provides different sets of colors, called palettes, you
can use to set colors for various workspace and window elements. The OPEN
LOOK Ul also provides a way for the application to control the color of its
window background independently. There are no restrictions on the way an
application can use color in the area of the window controlled exclusively by
the application. See Chapter 9 for more information.

International Considerations

The OPEN LOOK Ul encourages the development of internationalized
implementations and applications to permit localization to specific markets.
Issues that should be considered when designing a toolkit for a multinational
market are discussed in Appendix D.

Providing a toolkit that supports application development for international or
multinational markets requires development work at three levels:

0 The platform
0O The programmatic interface
O The user interface

The platform is the lowest level. For example, the hardware and operating
system determine the character encoding, the interchange protocol, and what
characters are permitted for file names. This specification does not define
international considerations at this level.

When the programmatic interface level provides the appropriate tools, an
application developer can use them to develop an application for multi-
national markets. The programmatic interface level must provide the capa-
bility for elements such as text, sorting sequence, units, and dates to be
localized, that is, to meet the unique needs of specific languages and
cultures.

The user interface level is closely related to the programmatic interface

el, but concerns the specific elements of the OPEN LOOK Ul. For example,

he direction of text display might require the vertical display of window
lers and menus. lcons, glyphs, and color should also be appropriate to
cal environment.




OVERVIEW

This chapter provides an overview of the OPEN LOOK User Interface by
describing how you, a user, interact with an OPEN LOOK Ul implementation.

The OPEN LOOK Ul contains a rich set of features and capabilities designed
to support a wide range of applications, from the simplest utility to the most
powerful integrated application. This chapter introduces the basic elements
and how they work; it does not attempt to offer a complete description of the
interface.

Keep in mind that documenting the appearance and functionality of a
graphical user interface is quite different from using it. For example, it may be
tedious to describe precisely and completely what happens when you choose
an item from a menu. But in practice, it is simple—you just press a mouse
button, point at the item you want, and then release the mouse button.

When you first see the OPEN LOOK Ul on a computer display, you need to
know only the most basic information about how to use the buttons on the
mouse to start using it

The information in this chapter is presented in the following way:

0O An introduction to the window environment: the work surface (workspace)
and the pointing device (mouse), how you set the insert point where you
type input, the Workspace menu, and the File Manager

0O How application windows and the Window menu look

0O The kinds of cont you can expect to see in control areas of application
windows

O How to move t i1a using OPEN LOOK Ul scrollbars

O What menus ; now to use them

O The kind jows that pop up to perform transitory function:

O How y windows and icons

O How v N {ext ana grapsucs
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The Workspace

In the OPEN LOOK Ul window environment, the background screen area on
which objects such as windows, icons, and menus are displayed is called the
workspace. You use the mouse pointer to control these objects and choose
your activities. Figure 2-1 shows an example of a workspace.

Edit

[ o)

I =
Draw T
@ ? '
x L |
"’-‘1\ F . i
L
% o i
X 7 7 _consoLe |
B\‘ 7 H h ] : i
| PR
| A %: . r mail |
| & |
L Q Edit: Search and Replace
h r |

Search For:

-

Replace With:

[Tanore case ] [Forward |

kuar
W11d Card Searches M
Wraparound Searches

(Searcn ) (Replace & Search) (Replace 411) | £ |
) | ‘

Figure 2-1 A sample workspace in an OPEN LOOK Ul implementation.

Vindows like Draw and Edit in Figure 2-1 represent graphics and text-
\g applications that use the OPEN LOOK Ul. Application graphics or text
displayed in panes within the window borders and are controlled with a
labeled set of buttons that describe the function or label the category
grouped on the button menu.




Overview

Icons (the two small squares on the right side of Figure 2-1) are small
pictorial representations of application windows. Changing a window to its
iconic representation, or closing it, keeps the application out of the way but
readily available.

Application windows that pop up to perform transitory functions can be
kept on the screen for repeated use by "pinning” them to the workspace with
a pushpin. The Edit: Search and Replace window in Figure 2-1 is an example
of such a pop-up window that is pinned to the workspace.

Menus are available both under menu buttons in the control area and as
pop-up menus that pop up at the pointer location. Menus can also have
pushpins. The Edit menu in Figure 2-1 is an example of a button menu in a
control area. It has a pushpin, but the menu is not pinned to the workspace.

Windows and icons can overlap or overlay one another on the workspace.
You control the work area of the workspace by opening, moving, resizing, and
closing or dismissing the windows of the applications you use.

The OPEN LOOK Ul specifies a basic set of standard menus that you use to
control windows and icons. In addition, each application window has its own
control areas, menus, and pop-up windows that allow you to control the
functionality of the application

Pointers

You access most functions using a pointing device to move the pointer to a
specific place on the screen and using the pointing device to perform an
action. The mouse I1s the pointing device described In this book.

The pointer—usually an arrow pointing toward the upper left corner of the
screen—always shows the location of the mouse on the workspace: An OPEN
LOOK U! implementation has standard pointer shapes for specific functions
such as copy and move Each pointer has a hot spot, which indicates the
active place on the screen The tip of the arrow is the hot spot. Applications
may provide additienal puinter shapes

Using the Mouse Buttons

You contr wifkspace and in windows by moving the
pointer ar and pressing and releasing different mouse
buttons (i€ 1@xt In a window, you move the pointer 1o the

window ttan 1o set the place where characlers are
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displayed. This way of directing where you work is called click-to-type. A
Level 2 implementation has an option that lets you choose where you work by
moving the pointer into the window.

This book uses the following terms to describe actions performed with the
mouse:

O Press a mouse button and hold it.

O Release a mouse button to initiate the action.

O Click a mouse button by pressing and releasing it before you move
the pointer.

0O Double-click a mouse button by clicking twice quickly without moving the
pointer.

O Move the pointer by sliding the mouse with no buttons pressed.

O Drag the pointer by sliding the mouse with one or more buttons pressed.

An OPEN LOOK Ul implementation is designed to be used with a pointing
device. The mouse is the most common pointing device. Mouse buttons have
three basic functions:

0 SELECT to select objects or manipulate controls
O ADJUST to extend or reduce the number of selected objects
0O MENU to display and choose from menus

Systems with one- or two-button mice access the three basic mouse
functions by using a key from the keyboard in conjunction with one of the
mouse buttons, for example, Shift/SELECT. This book refers to mouse buttons
by function, not by the location of the button on the mouse.

Figure 2-2 shows the mouse button assignments for one-, two-, and
three-button mice. An OPEN LOOK Ul implementation allows you to change the
mouse button assignments and set other global properties.

ADJUST - Keyboard ADJUST - Keyboard ADJUST
equivalent equivalent

~ AN
@P —— MENU snfcr—#H [| H— weny
:/ ARV

ELECT MENU - SELECT
Keyboard

fquivalent

~ ~

Figure 2-2 Default mouse button function assignments.
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File Manager

You access all file management functions in an OPEN LOOK Ul implementa-
tion in a consistent way using the File Manager application. The File Manager
can be used independently or can be called up from an application window.

The applications you choose from the Workspace menu are displayed on
the workspace as base windows. Figure 2-4 identifies the visual elements of a
simple base window.

Application title

Window menu button Long-term message

Resize Corner T ! : ]
© Title — No file —— Header
(_Button ) ('Menu Button v ) lv— Control area
jos
Scrollbar
Pane
]
New docu | Footer
! e o(ctment Pag‘e 1
Status and error message area State or mode message area

Figure 2-4 A simple base window.

he base window is the framework in which the application contents are
displayed. The following lists provide a general indication of which parts of
the user interface are specified and which parts are defined by the applica-
loper. The lists are not comprehensive.
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The fixed elements of the OPEN LOOK U! include:

0O The specific graphic design of each of the elements
O The fonts used for those elements

0O The functionality of those elements

O The spacing for headers, footers, and scrollbars

O The required menus

The application developer defines these elements in the base window:

O Application title and any long-term messages in the header
0O Status and error messages in the footer

O Size and locations of panes and control areas

0O Names and layout of buttons in the control area

0O Presence or absence of resize corners and scrollbars

0O Application menus

You can change the area of a window by moving the pointer to one of the
four resize corners, pressing SELECT, and dragging the resize corner to
increase or reduce the total area of the window. Resizing a window changes
the window area, but it does not change the scale of the window elements.
You can move a window on the workspace by pressing SELECT on the header
or footer and dragging the window to the new location.

The header is the area at the top of a base window that displays the
Window menu button and the application title. If Close is the default for the
Window menu, you can quickly close a window by clicking SELECT on the
Window menu button. When you close a base window, it is displayed on the
workspace as an icon. The header can also display long-term messages
generated by the application.

The control area contains controls such as buttons and menu buttons. The
control area and controls are described under “Control Areas and Controls”
later in this chapter

The pane is the area of the base window where the application information
is displayed and manipulated. An apphcation can have multiple panes within
the same base window. When all the application information cannot be
displayed at one | have scrollbars to allow you to move around in
the contents vered later in this chapter

Useful sta siate messages from the application are displayed

in the foot
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Window Menu

Each window has a Window menu, which you use to set window properties
and change window characteristics. When a window is displayed as an icon,
it keeps the window menu. You can use the menu to open icons or close
windows, expand the size of the window as specified by the application or
restore it to its original size, set window properties, move the window to the
back of the screen, refresh the window, and quit the application. Figure 2-5
shows the Window menu for base windows.

wWindow

Close

“Full Size
Properties...
Back
Refresh

Figure 2-5 Window menu for base windows.

Pop-up windows have a Window menu with a smaller set of choices.

The basic controls for an application are displayed in control areas within
the base window. The application developer determines the layout and labels
for the controls. A control area can contain any of the controls described in
this section.

An application can have a single, simple control area at the top of its

ndow or several control areas elsewhere in the window. A complex applica-

) divide Its base window into a number of panes, each with its own
noose your activities in an OPEN LOOK Ul implementation using the
I a simple set of controls. Figure 2-6 shows examples of all the
rols that can be used in control areas. Most of the time, control
itton controls. The other controls can be used in any arrange-
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Controls

Buttons used for single commands have the name of the command as the
label on the button. For example, to save a document, you would click
SELECT on a button that says “Save.” When a button has a window mark—
three dots—following the label, choosing it causes a pop-up window to be
displayed. You then choose the command from the controls provided in the
pop-up window.

Menu buttons always have a menu mark, an outlined triangle, following the
label. The triangle points to where the menu is displayed. Menu buttons
always display a menu when you press MENU with the pointer on a menu
button. The menu for a menu button labeled “Insects” might have items
labeled “Crickets,” “Ladybugs,” and “Bumblebees.”

When you press a button, it highlights to provide visual feedback. The
Marsupials button in Figure 2-6 is highlighted since its menu is displayed.

Items are button labels that are displayed on menus without the button
outline. They provide button functionality on menus and, at the same time,
help to keep menus to a manageable size. ltems on menus have the same
feel and functionality as buttons, but have a slightly different look. Just as an
application can use command buttons, window buttons, and menu buttons in
a control area, it can use command items, window items, and menu items on
menus.

Abbreviated buttons are small square buttons with no text label inside them.
They can have a glyph inside the button outline. The most common use for
abbreviated buttons is for scrolling. Scrolling buttons have a solid arrowhead
inside the border of the button. Abbreviated buttons function the same as
buttons.

Abbreviated menu buttons are small square buttons with a menu mark
inside the button. The label for the button is displayed to the left, and the
choice from the button menu is displayed to the right of the abbreviated menu
button. Abbreviated menu buttons function the same as menu buttons.
Abbreviated menu buttons are used when it is helpful to show the current

' without displaying a menu.
ds are used when the application requires input from the keyboard.
e. you use a text field when you type the name of a document you
/hen a text field cannot display the entire text string, scrolling
allow you to scroll the contents of the field. When a
/ contain numbers has increment/decrement scrolling
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buttons, you can click on them to increase or decrease the number displayed
in the text field. Text fields can also be displayed with borders and scrollbars
to permit multi-line text entry.

Exclusive settings are displayed as touching rectangles. You can make one
choice from each group of settings. The chosen setting is shown with a bold
border. Exclusive settings are used when the object has a state, and that
state can be changed. For example, if you want to change the color of a pen
in a drawing application, the pen already has a color setting. You can choose
a different pen color from a palette of exclusive setting color choices, but you
can use only one pen color at a time. Applications can use a variation of
exclusive settings that allows you either to make one choice from each group
of settings or to choose none of the settings.

Nonexclusive settings are displayed as separate rectangles. You can
choose all, none, or any combination of nonexclusive settings for the same
object. Nonexclusive settings are used when you can set many values for one
particular object. For example, text attributes such as bold, italic, and
underline can all be set for the same word.

Check boxes are another kind of nonexclusive setting. You can choose all,
some, or none of the options by toggling the check box to display or suppress
the check mark.

Sliders are used to set a numeric value and give a visual indication of the
setting. Sliders can have numeric fields and type-in fields. Sliders can be
used when an object has a range of possible settings. For example, sliders
can be used to adjust the volume of a beep.

Gauges are used to give a visual indication of how full or empty an object is
or to show what percentage of a job 1s complete.

Read-only messages are used to provide useful information that you
cannot edit

When you need t vé Ihrough the data in an application, you use
scrollbars to chi iz view 1In the pane A pane can have both horizontal
and vertica e 2-7 shows the components of a vertical

scrollbar
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Figure 2-7 Components of a vertical scrollbar.

The elevator shows you where you are in the contents that can be viewed in
the pane. The dark area of the cable (the proportion indicator) shows you how

much of the total contents is displayed in the pane.

You use the SELECT mouse button to operate the scrollbar. When you scroll
upward, you move the view on the data incrementally toward the beginning.
When you scroll downward, you move the view on the data incrementally
toward the end. You can scroll the contents of a pane in the following ways:

O Go to the beginning (click SELECT on the top cable anchor).

O Go to the end (click SELECT on the bottom cable anchor).

O Display the previous unit at the top of the pane (click SELECT on the
up arrow).

O Display the next unit at the bottom of the pane (click SELECT on the
down arrow).

O Display the previous pane of information (click SELECT on the cable above
the elevator).

O Display the next pane of information (click SELECT on the cable below
the elevator).

O Move to any arbitrary location (press SELECT in the drag area and drag
the elevator).

When you scroll, the elevator moves to reflect the new position of the view
to the application data. When the pointer is on the elevator, the pointer
tomatically moves when the elevator moves. This convenient feature

hat you can press or click SELECT to repeat the scrolling action
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without moving the mouse. When you click on the cable, the pointer automat-
cally moves along the cable to prevent the elevator from colliding with it.

An OPEN LOOK Ul implementation uses menus to provide additional control
areas that are hidden from view until you need to use them.

Menus have settings or lists of items that you use to issue commands,
display a submenu with additional items, or settings that you use to set
parameters. In addition, menus can have a pushpin to keep them on the
screen for repeated use

There are two basic types of menus:

O Button menus
O Pop-up menus

Each region of the screen in an OPEN LOOK Ul implementation that is not a
control has a pop-up menu. The pop-up menu that Is displayed depends on
the location of the pointer. When the pointer is on a menu button and you
press MENU, the menu for that button is displayed

Pop-up menus in an apphcation usually duplicate choices from menus
provided in the control area. Pop-up menus save keystrokes, minimize mouse
movement, and make the Interface more efficient for experienced users
When you use pop-up menus. you do not need to move the pointer away from
the work area to iIssue commands

The OPEN LOOK Ul specities the items for required pop-up menus. The
application developer specifles the choices for all other menus. The required
menus are listed below

O Workspace menu

O Window menu

O Pop-up Window

O Settings menu for property windows
O Scrollbar mer

O Edit menu fof

O Scrolling |
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The application developer can add choices to the Workspace, Scrollbar,
and Edit menus. The Window menus and Settings menu cannot be changed
by the application. Figure 2-8 shows examples of menus. The Edit button
menu and Edit pop-up menu in the base window are examples of application-
defined menus. (Note that this figure shows a configuration that you would
never see on the screen, since you have only one pointer and can display
only one menu group at a time.)

Pop-up window i Base window
Pop-up Window menu
T o Button menu Pop-up menu
T L —| Menu button Button Window button
[} Edit: Di Dismiss & - —_
!l Show Caret at Top) iz::esh 9 EdI T
| (o= e (File '9) ‘i@' (print') (Properties..) scrollbar menu
e —— j =}
4 E— It was a dark and s| © t. All of the beagles | 2!
|Line No: ‘Undo )
f - \'c"‘d—oJ were safely in their/(_Cut ) frhe bats flew around :;1
o ut —_ the tower sqeaking, Copy T it T
Copy Paste K e Uy scrollbar
paste Dosolina stood at tf Again find yCut ) —
Delete gazing out over thé Undo fr| “Copy sses \:lere to Top
blowing wildly as th> FEAE Paste op to Here
long overdue. There were evil { Again Previous
i Undo
Text fietd €dit menu the night, and she feared greatl y.
There was something unnatural about the light
flickering through the clouds. The beagles bugled !
their howls, protesting their captivity. ! window —f— Window menu
Property window 'wClose )
b A ~
. Full Size
Settings menu Properties...
Back
|V a— | i -l Refresh
9 __ Clock: Pro f—c“"‘L Workspace menu Quit
Apply
Clock Face: | Anal \m—’ Submenu
Display Options: [Sec
o oL Ceed! ~H \olorkspaﬁ
—— —— Console...
G (Rese) . Leai ]
. - _ _ - J Utilities Draw...
Properties... | Calendar...

Exit

Figure 2-8 Examples of menus in an OPEN LOOK Ul implementation.

J. 5V g

g Menus

s section describes the two basic ways you use the MENU mouse button
10 operate on menus:

Tt

-drag-release
nove-click
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The most common way to use a menu Is by pressing MENU to display the
menu, dragging the pointer to the desired item, and releasing the MENU
mouse button to choose the item and dismiss the menu. You must keep the
MENU button pressed down to keep the menu on the screen.

Alternatively, you can click MENU once to display the menu and keep it on
the screen without holding down the mouse button. You then move the pointer
to the desired item, and click either SELECT or MENU again to choose the item
and dismiss the menu.

Each menu has a default selection, which offers a quick way to choose an
item from a menu. You can view and execute the default selection for a menu
button in a control area—using the SELECT mouse button—without displaying
the button menu. You can also change the default selection for a menu at
any time.

Any menu that has a pushpin can be pinned to the workspace to keep it
accessible. The pinned menu becomes a pop-up window and remains on the
screen until you dismiss 1t.

Pop-up Windows

Each application can provide transitory windows called pop-up windows,
which are displayed to let you fill in information or make choices. A button or
menu item that displays a pop-up window always has a window mark
following the label

All pop-up windows except Notices have a pushpin on the left side of the
header so that you can pin the window to the workspace 1o keep it readily
available for repeated operations

Pop-up windows that allow you to set the properties of objects, such as tab
settings or fonts in a text editing application, are called property windows.
Figure 2-9 shows an example of a text property window.
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IT—UIU Edit: Properties R

CATEGORY: [ Text

Font: [Serif | Sans Serif [ Typewriter |
Style: [ Bold | [italic][ Underline | [ Overstrike |
Size: 233 12 %

Catalog Name: Bold italic,

(Capply 7)) (Reset )

& 5

Figure 2-9 An example of a text property window.

Pop-up windows do not close to an icon. Instead, when a command from a
pop-up window that affects the selected object or takes action on a function is
successfully executed, the pop-up window is dismissed from the screen. For
example, when you click on the Apply button to apply properties to a
selection, the property window is dismissed from the screen after the
properties are applied. You can dismiss a pop-up window without choosing a
command by choosing Dismiss from the pop-up Window menu, or using the
pushpin to dismiss the window.

Help

You view on-screen help in a Help pop-up window. Move the pointer to the
object for which you want help and press the HELP key on the keyboard. A
pinned Help window is displayed. The object at the pointer location is
displayed in the magnifying glass of the Help window along with explanatory
help text. Figure 2-10 shows an example of a Help window.
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The Window Background

The window background is any part of a window that is not enclosed by a
border or covered by a control, a pushpin, or scrollbar. You use the window
background to display the Window menu, select a window, or move a window
by dragging. The shaded area in Figure 2-11 is the window background for a
base window with a control area, one pane, and a scrollbar.

Coutton ) (Menu Button 7))\

[=]

k4

—_T,h, I I
AEEIETTHHEED

AL

Figure 2-11 The shading shows the background of a base window.

Using the Window Menu

You operate on individual windows and icons at the pointer location by
making choices from the Window menu. You access the Window menu by
pressing or clicking MENU anywhere on the window background (or when the
pointer is over any button that has no menu behind it).

To provide a quick way to use the default from the window menu without
displaying the menu, the header of each base window has a Window menu
button. Clicking SELECT on the Window menu button executes the default
item. For example, when the default is Close, clicking SELECT on the Window
menu button closes the window to an icon. Pressing or clicking MENU on the
Window menu button displays the same Window menu that you access from
' iIndow background.
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Selecting Windows and Icons

You select a window by moving the pointer to the background and clicking
SELECT or ADJUST. Select an icon by moving the pointer anywhere on the
icon and clicking SELECT or ADJUST. Since windows can be layered on the
workspace and may not be completely visible, clicking SELECT on the window
background also brings the window or icon to the front of the screen. Clicking
ADJUST selects the window or icon but does not bring 1t to the front of the
screen.

When a window or icon is selected, the border thickens. In Figure 2-12, the
Edit window and Console icon are not selected. The Draw window and Mail
icon are selected.

s Edit Il
(File v) (view v) (Edit v) (Find v)

L4
@) Draw 3

(line) (Rectangle ) (Circle) (Fill)

1 Eﬂ
7 1
e oy mail
Figure 2-12 Selected and unselected windows and icons.

To select more t window or icon, click ADJUST on the additional
objects you warit !
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Operating on Selected Windows and Icons

You move selected windows and icons directly by pressing SELECT on one
of the selected objects and dragging the group to a new location.

You can also operate on groups of selected windows and icons by opening
a pop-up window called Window Controls from the Workspace menu and
using the controls in that window to operate on the selected objects. For
example, you can close selected windows and open selected icons in one
operation using the Open/Close button in the Window Controls pop-up.
Figure 2-13 shows the Window Controls pop-up window.

© Window Controls

[i\ Open/Close )) (Full/Restore Size) (Back ) (Quit )

Figure 2-13 Window Controls pop-up.

Resizing a Window

You can change the dimensions of any window that has resize corners by
pressing SELECT on any resize corner and dragging the corner to a new
location. The diagonally opposite corner of the window is anchored, and the
borders of the window expand or contract as you move the resize corner,
changing the area of the window relative to the anchored corner. Figure 2-14
shows how you resize a window to make it smaller.







OPEN LOOK Graphical User Interface Functional Specification

e T e B T £
out over the moots, /ﬁer ong dark tresses blowing
wildly as the wind gusted, FPietor was long
overdue, There were evil things afoot in tne night,
and she feared greatly for his safety. There was
something unnatural about the light flickering
through the clouds. The beagles bugled their

howls, protesting their captivity,

window -
_|-" —_—
_@__ Close
(File v) Full size
Properties... =
It was a d o All of the beagles |=
were safel e bats flew around ﬂ
the tower,| Refresh ] z
Quit .
Dosoling sthyzme JW wistfully gazing

15 ]

Figure 2-15 Choosing Properties from the Window menu.

When you release MENU, the Window menu is dismissed and the Properties
window is displayed, as shown in Figure 2-16.

@) Edit u
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’ @) Edit R
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he tower, squeaking frantically.
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out over the moors, her long dark tresses blowing
wildly as the wind qusted. Pietor was long
overdue. There were evil things afoot in the night,
and she feared greatly for his safety. There was
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through the clouds. The beagles bugled their
howls, protesting their captivity.
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Figure 2-18 Click SELECT on the Apply button to apply the setting and dismiss the
property window.

You can scale the base window and pop-up windows for an application
independently of each other. Using the Scaling option, you can display the
pop-up windows in a smaller size to conserve space on the workspace and
choose a larger scaling size for the base window of the application.

_ Selecting and Operating on Text and Graphics

To select text, move the pointer to the beginning of the text you want to
select, press SELECT, and drag the mouse to wipe through the selection. As
you move the pointer, the text is highlighted. Release sSELECT to complete the
selection. You can also select text by moving the pointer to the beginning of
the text you want to select, clicking SELECT, and then moving the pointer to
the end of the text you want to select and clicking ADJUST.
















WoRrksPACE, Icons, AND WINDOWS

This chapter begins the technical specifications section of this book with a
description of the workspace, icons, and windows. Refer to Appendix B for
detailed graphic representations of the elements described in this chapter.

In an OPEN LOOK User Interface implementation, windows and icons can
be selected and manipulated both individually and as a group. Since more
than one object can be selected at the same time, the visual distinction
between selected and unselected icons and windows is an important part of
the user interface.

This chapter describes the visual elements of the workspace, icons, and
windows. It shows the distinction between the selected and unselected states
for windows and icons See Chapter 16 for a detailed description of how to
select and operate on icons and windows. See Chapter 18 for information
about how to use property windows

Icons and windows are displayed on the workspace, which has a 50
percent pattern, as speciiied in Appendix B Color implementations set the
workspace color from the Workspace Properties wingow.

The Workspace Grid

The workspace conla wisidle gria which has a default grid incre-
ment of 13 points. ¥ g are positloned on the workspace. they

automaticalty sha &Clng posnts on this grid. You can change the
default ar the gna off trom the Workspace Properties

Al

window. S : e miormaton about e workspace grid
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Reserved Areas

Some OPEN LOOK Ul implementations may permit you to define virtual
edges for the workspace to create a reserved area on the workspace that
permits the display of icons and special application windows. A certain class
of applications can be moved onto the reserved area of the workspace. You
define virtual edges from the Workspace Properties window. A 1-point line
demarcates the boundary between the workspace and the reserved area of
the screen, as shown in Figure 3-1.

JQ wWindow Controls =45 ' @* y .”k;':
J focengose ) (Full/Restore Size) l N . | oeore:

(File_v7) (view v) (Edit v) (Find v)

"I Draw

Figure 3-1 The workspace with a reserved area at the top of the screen.

In this example, a virtual edge is defined near the top of the workspace.
Nindow Controls pop-up is displayed in the reserved area, as are two
The Edit window is partially obscured, just as it would be if the window
ved partially off the actual edge of the screen.
n OPEN LOOK Ul implementation provides reserved areas of the
I can move icons onto the reserved area. Most windows, however,
irtual edge to be the physical edge of the screen, and they
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disappear under the virtual edge when you drag the window beyond that
edge. An application must be able to specify whether or not you can move its
window onto the reserved area of the workspace See Chapter 16 for more
information about moving icons and windows

Default Pointer Shapes

The pointer—usually an arrow pointing up and to the left—shows the
location of the mouse on the workspace The OPEN LOOK Ul has standard
pointer shapes for specific functions such as copy and move

When the pointer is an arrow, the tip of the arrow is the hot spot that
indicates the active place on the screen. Applications may provide additional
pointer shapes.

Table 3-1 shows the default pointers for a Level 1 implementation and tells
you when you see them.

When you initiate an activity, the shape of the pointer changes to give you
visual feedback while you are performing an operation. Generally, the pointer
is displayed when you press a mouse button, when you drag the pointer
beyond the damping factor to initiate a move or copy, or when an event
cannot be acted upon. When you release the mouse button to complete the
action, the appropriate pointer is displayed. The pointer may change to the
busy pointer until the operation is complete, and then change again to the
basic pointer.

Some OPEN LOOK Ul implementations may not be able to support large
pointers efficiently. In addition. some languages, such as Kanji, require a
larger text area than that provided by the text move and text copy pointers. In
these cases, the OPEN LOOK Ul implementation uses the standard move and
copy pointers in place of the text move and text copy pointers.




OPEN LOOK Graphical User Interface Functional Specification

Table 3-1

A

Level 1 default pointers.

The basic pointeris used for such basic functions as selecting objects
and manipulating controls. The hot spot is the tip of the arrow.

When you move an object by dragging, the pointer changes to the
move pointer. The hot spot is the tip of the arrow.

When you copy an object by dragging, the pointer changes to the
duplicate pointer. The hot spot is the tip of the arrow.

When an application is busy and cannot accept input, the pointer
changes to a stopwatch. The hot spot is the middle of the stopwatch.

While a mouse button is pressed on an area that does not accept that
action, or when you drag an object to an inappropriate destination, the
question mark pointer is displayed.

When you copy text by dragging, the pointer changes to the text
duplicate pointer. The at least the first three characters of the text are
displayed in 10-point type in the rectangle, and are followed by a
More arrow then the selection is more than three characters. The hot
spot is the tip of the arrow.

When you move text by dragging, the pointer changes to the text
move pointer. The first three characters of the text are displayed in
10-point type in the rectangle, and are followed by a More arrow when
the selection is more than three characters. The hot spot is the tip of
the arrow.
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Table 3-2 shows the additional default pointers for a Level 2 implementation
and tells you when you see them.

Table 3-2 Level 2 additional default pointers.

In a Level 2 implementation, when you initiate panning (moving the
F entire contents of a pane relative to the pane outline), the pointer Is
changed to the panning pointer The hot spot is the tip of the arrow

In a Level 2 implementation, the basic pointer changes to the target
Q pointer, with a halo around the tip of the arrow when the hot spot is on
the border of a pane that can be selected

See Chapter 7 for information about panning. See Chapter 16 for informa-
tion about selecting panes.

This book uses the term icon specifically to mean a graphic representation
of a closed window Other graphic images used in an OPEN LOOK Ul imple-
mentation are referred to as glyphs. When a base window is closed to an
icon, the only change to the application is In its visual representation on the
workspace. The application keeps running even when it is closed to an icon.
When the icon is opened. it 1s replaced on the screen by its opened window.

The OPEN LOOK UI specifies a basic icon size (65 by 65 points) and design
for bordered and borderless icons. However, an OPEN LOOK Ul implementa-
tion can use icors of a nonstandard size and configuration, If an OPEN LOOK

Ul implementation provides an icon editor application, it would be helpful to
provide the application developer with the ability to scale an application
design to the threx 1 commonly required for different display

resolutions

O Low resolut
O Medium re
O High res
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In addition, such an application could provide a way to scale to the
standard glyph size required for display in the File Manager. See “Images for
Use with the File Manager” later in this chapter and Chapter 12 for more
information about File Manager glyphs.

Any icon can be displayed in an unselected or selected state. In addition,
an unselected or selected icon can show the standard busy pattern as the
icon background. An icon is “busy” when its application cannot accept user
input—for example, when a mail application is incorporating new mail. The
following sections describe default bordered and borderless icons and
nonstandard icons.

Default Icon Elements

Each default icon has three elements:

O A border
O An optional image
O An optional text label

Figure 3-2 shows examples of unselected icons.

Figure 3-2 Examples of default bordered icons.

To present a uniform appearance, the pictures on each icon should be
approximately the same size. The default text label on the icon is the same as
the title that is displayed in the header of the opened window.

When an application has more than one base window, the application
determines the text that is displayed in the text area of the icon for additional
base windows.
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Borders

On monochrome displays, unselected icons are enclosed in a 1-point white
square border and a 1-point dotted line (alternating dark and white points).
The icon size is 65 points square The top two-thirds of the icon is the symbol
image area. The bottom third is the text area Figure 3-3 shows the border
and the image and text areas.

Figure 3-3 The icon border and the image and text areas.

Images

The graphic image for an icon should be a unique design that is easily
recognizable whether or not a title is displayed in the icon text area. The
image can change to represent a change in state of the application. The
examples in this book of a mail application icon show a rural American mail
box with a flag When the flag is down, there are no new mail files in the mail
box. When the flag is up and the door to the mailbox is opened, you have new
mail messages. Any application can use a graphic mnemonic such as this to
show a change in the state of the application while the window is displayed as
an icon.

Images for Use with the File Manager

The File Manager displays files as glyphs and has a set of default glyphs
that represent folders, cata files, and applications See Chapter 12 for a
complete specifical | the File Manager.

An application ¢an [ & two additional image designs to use for display
in the File Manages

O The Imagi i it {duit icon that can be displayed in place of thé
defal ; iGN glyph
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O An image that fits inside the 32-by-40-point border of the File Manager data
file glyph.

Figure 3-4 shows an example of the image area from a mail application on
the left, and a smaller version of the same image inside the border of a File
Manager data file glyph on the right.

s

Figure 3-4 Examples of glyphs for use with the File Manager.

You would use the image on the left to open the mail application, and the
image on the right to open a data file that contained a message bound to the
mail application.

Title

Each icon can have a title that, by default, is the same as the title on the
application window. The application can use a shorter title for the icon if
needed or choose not to display a title. The application can specify whether
or not long-term messages such as file names are displayed in the icon.

State Feedback

Default bordered icons that are selected have a 3-point border. The icon
can be in a busy state whether or not the icon is selected. The top two icons
in Figure 3-5 show unselected and selected default icons. The bottom two
icons show unselected and selected busy icons.
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Figure 3-9 shows examples of nonstandard, nonrectangular icons.

Unselected Folder

Unselected busy

Selected busy

Figure 3-9 Examples of nonstandard, nonrectangular icons.

You can drag File Manager folders and data file glyphs out of the File
Manager pane and put them on the workspace. Applications determine how
' file is displayed as an icon on the workspace. A folder glyph can be
iyed as a nonrectangular icon that has all the attributes of other icons:

onal image or text label inside the border
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O The required base Window menu
O A bold border when you select the icon
O Standard busy feedback when appropriate

The icon can be opened to display a base window. An opened data file
icon is displayed in a base window of the application to which the data file 1s
bound. See Chapter 12 for a description of the File Manager.

Positions

Icons snap to an invisible grid on the workspace. This permits you to
position icons immediately adjacent to one another, or show an equal amount
of the workspace between icons.

When an application is started or when an open window is closed, the first
icon is displayed in the initia! default region at the edge of the screen that you
specified from the Workspace Properties window. Subsequent icons are
positioned 65 points to the right or below the previous icon position so that the
borders of icons are immediately adjacent to one another. When you use the
Top setting, the first icon is displayed at the upper left corner of the work-
space. Subsequent icons are displayed one icon width to the right of the
previous icon. When the last icon reaches the top right corner of the screen,
the next icon is moved one icon width down from the top of the screen, and a
second row Is formed following the same placement pattern.

This same pattern is used for each of the other settings. When you use the
Bottom setting, the first icon is displayed at the lower left corner. When you
use the Left setting. the first icon 1s displayed at the upper left corner. When
you use the Right setting, the first icon 1s displayed at the upper right corner
The Location setting applies to future placement of icons and does not affect
the location of any icons already displayed on the workspace.

You choose the defaul: icon reglon (top, bottom, left, or nght) from the
Workspace Properties winaow Tne default icon region defines the part of the
screen that the icons move 1o wiien they are closed

Icons cart b s anywhere on the workspace that is permitted by the
workspace gfit fing any reserved areas of the workspace. When you
move an iton | faul posihon, the new position IS recorded and is

used the nex e window IS opaned and then closed again
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An OPEN LOOK Ul implementation has two kinds of windows:

O Base windows (the application’s primary window)
O Pop-up windows (transient windows that pop up to accomplish a specific
purpose and are dismissed by you or by the application when appropriate)

This section describes base windows. Pop-up windows are described later
in this chapter.

The base window is the application’'s main window. Each base window has
required and optional elements. These elements are described in the
following sections.

Required Elements for Standard Base Windows

Standard base windows have the following required elements:

O The standard base Window menu
ad A 2-point border
O A header, with the name of the application centered
0 A Window menu button in the upper left corner of the header
O At least one of the following two elements:
o Control area (an unbordered area where controls such as buttons are
located)
o Pane (a bordered rectangle where the application displays text and
graphics)

Figure 3-10 shows the required elements of a base window except for the
Window menu. The window on the top has a control area but no pane, while
the window on the bottom has a pane but no control area.
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Nonstandard Base Windows

As an alternative to rectangular windows with required elements, a Level 2
implementation must provide a way for an application to design a window that
does not contain the standard base window elements. For example, a clock
application, a map display of a continent, a dial, and a notebook do not need
headers, footers, or panes. The window must always have a Window menu,
some background area so that you can select it, and some visual feedback to
show the selected state. Figure 3-12 shows an example of a clock application
and a notebook application with nonstandard window layouts.

Figure 3-12 Examples of nonstandard base windows.

Each of the required elements of a base window is described in the
following sections.

Base Window Menu

Each window in an OPEN LOOK Ul implementation has a Window menu. The
base window and pop-up window menus have different items. You use the
Window menu for actions such as closing a window or opening an icon,
displaying the window you use to set window properties, temporarily adjusting
the area of a window to an application-specified larger size, moving a window
to the back of the screen, and refreshing the window. See Chapter 10 for a

Jescription of window menus.

'he base window menu always has a Properties item that is used to set
S¥ properties for the window. An OPEN LOOK U! implementation has a
ba equired set of window properties. The application cannot add settings
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to this property window. See “Property Windows" later in this chapter for a
description of the window properties.

Header

The header of each window has a Window menu button and a title.

Window Menu Buttons

The Window menu button is displayed on the left side of the header in every
base window. Clicking SELECT on the Window menu button activates the
default item from the Window menu without displaying the menu. An ADJUST
click on the Window menu button displays the question mark pointer. Clicking
or pressing MENU on the Window menu button displays the Window menu,
just as it does anywhere on the window background.

Title

Each base window has a title. By default, the title is the same as the title on
the icon. The title and any long-term messages are centered, in sans serif
bold type.

Control Areas

A control area is any area within the borders of the base window, excluding
the header or footer, where controls are displayed. A control area can be
positioned anywhere in the window or within a pane. The standard configura-
tion is for control areas to be above a pane that uses those controls. See
Chapter 5 for a detailed description of control areas

Panes

Panes are tiled (not averlapping) within the base window and are outlined

with a 1-point border All text panes in an OPEN LOOK Ulimplementation
support text cut/copy/pasia aperations from the keyboard. and use the
clipboard for thes: ralons

A Level 2 Implemenation supports the Clipboard ‘window, which you can
access from tha VWS neny You can use the C‘Ipboard window 10 view

the data that ¥ 1 by & pasie opafaton
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An application can provide Replace and Append functions on a Copy
button menu; these allow you to replace the contents of the clipboard with the
current selection or to append the current selection to the existing contents of
the clipboard.

The OPEN LOOK Ul does not restrict the kinds of panes that an implementa-
tion can provide for an application. The two most basic types of panes used
by applications are a text pane that has some editing capabilities and a
graphics pane. However, applications can combine text and graphics
capabilities within the same pane.

Any pane that is used in an OPEN LOOK Ul implementation supports basic
text or graphics selection and operation functionality, as described in detail in
Chapter 17.

You can select a pane when you apply functions to that pane such as
resizing or setting application properties. When a pane is selected, it has a
2-point border. See Chapter 16 for a description of selecting panes.

Optional Elements

Base windows have the following optional elements, if needed by the
application: resize corners, a scrollbar, and a footer for displaying one-line
status and error messages. Long-term messages can be displayed in the
header, such as the name of a file that is being edited in a text window.

The optional elements of a base window are shown in Figure 3-13.
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The contents of the window background behave in the following manner
when the window is resized:

O The contents of the window are “anchored” in the upper left corner of the
window. The borders of the window are expanded downward and to the
right, and are contracted leftward from the right border and upward from the
bottom border.

O The Window menu button is always displayed in the header of a base win-
dow. The pushpin is always displayed in the header of a pop-up window.

O The title is always centered in the header. If the title cannot be completely
displayed in the given space, it is truncated from the right and an inactive
more arrow is displayed at the end of the text to indicate that some informa-
tion is hidden from view. (Note that this information is not scrollable.) Any
information messages are treated in the same way. Figure 3-14 shows the
header of a resized window with the title truncated and a more arrow.

Figure 3-14 A resized window with truncated title and a More arrow.

O In the window footer, any information or error message in the left message
area is truncated from the right and an inactive more arrow is displayed at
the end of the text to show that some information is hidden from view. When
the left message disappears, the right message is truncated from the right.

Controls in control areas need not automatically be rearranged so that they
are visiple after the window is resized. For example, some buttons may be
only partially visible or may fall outside the new window boundaries. The
application determines whether or not buttons in the control area are re-

irranged after you resize a window. The application also determines how the
1 Of panes in a multi-pane window is reallocated.
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Scrollbars

Scrollbars allow you to move through the application data and change the
view in the pane when the information you work with does not fit within the
borders of the pane. Scrollbars can be displayed vertically and/or horizontally
See Chapter 7 for a description of scrollbars

Footers

The application uses the footer area of the base window to display one-line
information and error messages. The footer has two message areas, right and
left. Status and error messages on the left of the footer are left-justified. State
messages, such as mode or page, on the right of the footer are right-justified.

An OPEN LOOK Ul implementation provides the following ways of displaying
messages in a base window:

O Normal messages such as prompts and status information are displayed in
the footer, header, control area, or pane without flashing or beeping.

O Important messages are displayed in the footer. An “important” message
always flashes several times and beeps. You can turn off the beep from the
Workspace Properties window.

In a Level 2 mplementation, the application can use the Help pop-up
window to display more information about a specific error message that is
displayed in the left message area When you move the pointer onto the left
side of the footer and press the HELP key, a Help window is displayed that
contains the more detailed explanation of the error message. The application
can also use the Help window to display help text for status or state mes-
sages that are displayed on the right side of the footer. See “Help” later in this
chapter for more information about the Help pop-up window.

In a Leve! 2 implemeritation. if an application requires more space for
messages. it can replace the message area in the footer with a scrollable text
pane of two or more lines. Massage logs can be implemented as pop-up
windows with a scroliabie lext pane
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Minimum Window Sizes

When you resize a base window to reduce or shrink the area of the window,
it cannot shrink beyond a minimum window size, according to the following
rules:

O Headers, footers, and control areas keep the same height.

O The header must always be wide enough to display the Window menu but-
ton. The title need not be displayed if the width of the header is too small to
accommodate any truncated title information.

O The width of the vertical scrollbar area or the height of the horizontal scroll-
bar always remains the same.

O Scrollbars cannot shrink smaller than the height of the minimum scrollbar.

O Panes cannot shrink smaller than 16 points in any direction.

O Panes with scrollbars cannot shrink smaller than the height of the minimum
scrollbar. See Chapter 7 for a description of minimum scrollbars. The mini-
mum dimension of a pane without a scrollbar is 16 points square.

Figure 3-15 show some examples of minimum window sizes for different
pane configurations of a window that has a control area and a footer.

@Y @Y @Y [(@or] [@o>)

| 08| 08| 8| |
y;jﬂrr ]

I, ) LS

1 v

Figure 3-15  An example of minimum window sizes for base windows.

size a pop-up window, the width of the header is always large
npinned pushpin, as shown in Figure 3-16.
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Figure 3-16 Minimum width for pop-up windows.

Multiple Base Windows

Although most applications have only one base window, more complex
applications may have several Each base window Is equal to any other base
window in the same application. It can be operated on independently and it
has its own icon. The application determines the title that 1s displayed in the
icon for each base window.

An application can also use multiple base windows, where one base
window is designated as a “control base window,” and other base windows,
which close to independent icons. are subsidiary to the control base window
An example of this kind of application is a spreadsheet application in which
each spreadsheet is a base window. A control base window contains a
separate set of controls that act on the individual spreadsheet windows.

When an application uses multiple base windows In the way described in
the preceding paragraphs, selecting Quit from the Window menu of the
control base window quits all the base windows. Selecting Quit from the
Window menu of a subsidiary base window (a spreadsheet window in this
example) quits only that window

Window Background and Foreground

An OPEN LOOK | eritation makes a functional distinction between
the background-and 1 reground of a window. You use the background to
access the Wind i 10 SakeCt a window, and to move It by dragging
The window backorou any part of the window that is not enclosed by a
border or ; nirod Buch as a bution, a setling, a text field, or a
scrolibar nd read-only messages in the header or in a

contro Erid the WirSOW ha{‘h;;r;)ux.o
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The various elements of the window such as resize corners, the Window
menu button, scrollbars, controls, and panes are foreground objects and are
displayed against the window background.

The shaded area in Figure 3-17 is the background of a window with a
control area and a pane.

RRrRsRSRSaOasrsrsrsrsrerhrhrh hrhrrmTSEs

Figure 3-17 The shaded area is the background of a window with a control area and a
pane.

The shaded area in Figure 3-18 is the background of a window with a
control area, a footer, and a pane with a vertical scrollbar.

{ Button o Menu éuttqn ‘7)\&\\\\\\\

 New document

Figure 3-18  The shaded area is the background of a window with a footer and
vertical scrollbar,

I —
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Base Window Positions at Startup

When you start up base windows, the OPEN LOOK Ul default specifies that
they are positioned on the screen in the following way: The first base window
is positioned in the upper left corner of the screen. Subsequent base windows
are positioned along the diagonal from the upper left to the lower right corner
of the screen. When the lower right corner is reached, subsequent base
windows start again at the upper left corner of the screen.

The application can define different defaults for base window positions at
startup, and you can change those default window startup positions from the
Workspace Properties window.

When you move a window to a new location, the window remembers that
location. When you close a window and then reopen it, the window returns to
its last location.

Base window positions at startup and icon positions at startup are defined
separately.

State Feedback

Each window can be displayed in three states:

O Unselected
O Selected
O Busy

Unselected windows show the specified 2-point border.

Selected Windows

When you select a window, the border thickens. Figure 3-21 shows an
unselected window with a selected window overlapping it. See Chapter 16 for
information about selecting windows.
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Figure 3-21 Selected window feedback.

Busy Windows

When the application is busy and cannot accept any user Input, such as
when a mail application Is Incorporating new mall, the header displays the
standard busy pattern Nindow menu button is not busy, and you can
access all Window menu tunctions from it. The standard busy pattern is
specified in Appendix B The standard busy pattern is always gray. even in
color implementatic re 3-22 shows the header of a busy base window
and a busy p ]




OPEN LOOK Graphical User Interface Functional Specification

oo geri@shargola Tue Jan 10
o1 geri@shargola Tue Jan 10
=102 winsor Tue Jan 10

Printer:

Messages:

Figure 3-22 Busy windows.

When an application is busy, it does not accept user input. Any keystrokes
or mouse clicks are discarded, and the system beeps. When you move the
pointer over a busy window, the busy pointer is displayed.

Input Area

An input area is the region on the screen that accepts input from the
keyboard. When an input area displays the characters you type, you set the
place where characters are displayed by clicking SELECT or ADJUST to set
the insert point. These areas include text panes, single-line text fields
commonly found in control areas, and pop-up windows. The insert point is
marked by a caret—a solid triangle at the text baseline—to show the exact
place where characters typed from the keyboard are inserted into the text
area.

Active Caret

You can set the initial insert point by positioning the pointer at the exact
ation where you want the caret and clicking SELECT or ADJUST. When you
e the mouse button, the header of the window is highlighted and the

iret is displayed, as shown in Figure 3-23.
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It was a dark and stormy night. All of the beagles
were safely in their kennels. The bats flew around E
the tower, squeaking franticallv.@
—da
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Figure 3-24 A window with an inactive caret.

When the window contains read-only information, the header of the window
is not highlighted, and any caret in that window is displayed as inactive.

Activating an Inactive Caret

When a window has an inactive caret, you can change the inactive caret to
an active caret by clicking SELECT anywhere on the window background. The
window is selected and the border thickens when you press SELECT. When
you release SELECT, the window is brought to the front of the screen, the
header highlights, and the inactive caret becomes active. Clicking ADJUST on
the window background does not restore the insert point. An ADJUST click
toggles the state of the window, selecting it if unselected and deselecting it if
selected.

Move Pointer Option

A Level 2 implementation has an option that allows you to change the input
area without clicking SELECT. The Move Pointer option allows you to move the
pointer into the window to change the input area to that window and activate
the inactive caret. You set this option from the Workspace Properties window.
You set the insert point to a different place in the window by moving the
pointer and clicking SELECT as described above.

Vhen you set the Move Pointer option from the Workspace Properties
the header of a window that has the active input area does not

Instead. it displays 2-point lines at the top and bottom of the header,
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Number of Active Carets

You can have only one active caret at a time. There are times when you
may not have an active caret at all. For example, there may not be any input
areas displayed on the screen at system startup, when you click SELECT to
set the input area to the workspace, or when a window that had the input area
is closed to an icon.

Number of Carets per Window

You can never have more than one caret for each window, even though you
may have more than one text area or pane in a window. Limiting the window
to only one caret allows you to reset the input area to a window by clicking
SELECT on the window background. If there were more than one inactive
caret, the window manager would be unable to determine which caret to
activate.

When an application permits you to split panes, you may see multiple
carets in a window. However, there is actually only one caret with multiple
views of it displayed in a window.

Input Area Without a Caret

Most of the time you set the input area to type text. In some cases the
keystrokes are used to activate a control or to select an item in a scrolling list.
When a window accepts keyboard input but does not have a caret, the
header of the window with the input area still highlights, as shown in
Figure 3-27.
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Figure 3-27 Kevboard input area teedback.
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0 When you dismiss or close a window with the input area, the input area is
automatically restored to the previous window. If the previous one is not
available because it was in the window that you dismissed or closed, the
input area goes to the workspace.

O In a Level 2 implementation, the window manager uses this information
when you use the TOGGLEINPUT navigation accelerator to change the input
area to the most recently used window.

A Level 2 implementation also records the sequence of input areas, and
uses this information when you use the NEXTWINDOW or PREVWINDOW keys to
change the input area from window to window.

~ Pop-up Windows

You invoke pop-up windows from an application by using a button or an
item on a menu that has a window mark. You also invoke pop-up windows
when you request Help. Pop-up Notices are automatically displayed by the
application to inform you about certain conditions.

Pop-up windows are displayed to accomplish a specific purpose and are
usually dismissed, either by you or by the application, when they have
accomplished that purpose. They are never displayed as icons.

Kinds of Pop-up Windows

The various kinds of pop-up windows are listed below and are described in
the following sections:

O Command windows give operands and set parameters needed for a
command.

O Property windows set more persistent properties associated with an object,
an application, or a window.
Help windows display help text for the object under the pointer.
Notices are special pop-up windows that are used to confirm requests for
ictions that cannot be undone and to display messages and conditions

must be brought to your attention.
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Pop-up Window Ownership

Pop-up windows are owned by the originating base window and operate on
that base window's application. You use pop-up windows to enter commands,
change properties, or access help for that application. For example, an Edit:
Load command window can only be used to load information into the Edit
window that invoked the pop-up

Multiple Invocations of a Pop-up Window

You cannot display multiple versions of the same pop-up window from an
application. If you choose the control (window button or menu command) that
displays a pop-up window, the opened window is moved to the front of the
screen.

Pop-up Windows That Block Input to the Application

The application can specify that an individual pop-up window blocks all
input to the rest of the application. Notices, for example, always block input to
the application until you respond by clicking on a button in the Notice. When a
Notice is displayed. each window for that application displays the standard
busy pattern in the header

Command windows and property windows, when specified as blocking
pop-up windows, can also block input to the application. When a blocking
pop-up window is displayed. the header of each opened window in that
application, except for the pop-up window itself, displays the standard busy
pattern.

Help windows never block input to the application

The Pop-up Window Menu

Each pop-up wincow hias a pop-up Window menu that you access from the
pop-up window backg 1 The choices on the pop-up Window menu vary
shghtly from the ba Nindow menu. See Chapter 10

You do not p-up wandow, since that term is reserved for
changing a reprasentation Instead, you “dismiss’ pop-up
windows { e hirst buton on the pop-up Window menu is Dismiss
Property I vanaton irom this Convention. When you have
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made changes to the property window but have not yet applied them, the
Dismiss label is changed to Cancel. For more information, see Chapter 10.

Grouping Pop-up Windows

When you close a base window, the pop-up windows associated with that
base window are also dismissed. When the base window is opened, the
pop-up windows are also opened if they were open when you closed the
base window.

In a Level 2 implementation, one of the window properties is a Manage
Windows setting that you can use to group all pop-up windows for an
application with their base window so that you can move all the windows to
the front or back of the screen as a group. The Manage Windows setting also
determines whether or not dragging a base window also drags its associated
pop-up windows. See “Level 2 Window Properties” later in this chapter for
more information about grouping windows.

You can dismiss pop-up windows individually or in groups from the pop-up
Window menu using the Dismiss submenu buttons labeled This Window and
All Pop-ups.

Pointer Jumping

Most of the time you control the movement of the pointer on the screen.
However, in some cases an OPEN LOOK Ul implementation moves the pointer
independently of the mouse and jumps it directly to a specific place on the
screen. Pointer jumping, as it is called, makes the user interface efficient by
minimizing unnecessary mouse movement. The pointer jumps to pop-up
windows in the following ways:

O In Notices, the pointer jumps to the default button.
O In command windows, the pointer jumps to the default button or to the
pushpin when there is no default button.
1 In property windows, the pointer jumps to the Apply button.
In help windows, the pointer jumps to the pushpin.

You can disable all pointer jumping from the Workspace Properties window.
\s long as you do not move the pointer off the button, the pointer jumps
) its previous location when the pop-up window is dismissed.
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When you move the pointer from the initial control in the pop-up window, the
pointer does not jump back. It remains at its last location when the pop-up
window is dismissed.

When an application is invoked, or when you open an application from an
icon, the pointer does not jump to any pop-up windows that are initially
displayed.

An application can suppress pointer jumping for situations in which it is
inappropriate. As an example, it makes little sense to jump the pointer to a
read-only window in a graphics application that magnifies the pixels in a
drawing and has no other controls. In this instance, the application can
specify that the pointer does not jump to that specific pop-up window when it
is invoked. In addition, an application can specify that certain pop-up
windows do not accept keyboard input and, therefore, cannot become the
input area.

Restoring the Insert Point

When the pointer jumps 1o a pop-up window that has an input area, the
application moves the insert point to the pop-up window. When there is more
than one possible place for the insert point, the insert point is moved to the
first field the first time the window Is Invoked, or to the last field that was
accessed.

When the pop-up window with the insert point is dismissed, the previous
insert point is restored in one of the following ways:

O The insert point is restored to the most recently active caret.

O If the most recently active caret is not shown because it has been scrolled
off the screen, the header of the window with the active input area high-
lights. The first character you type in the pane with the active caret scrolls
the text with the caret so that it is repositioned at the first line in the pane

O If the most recently active caret Is in @ window that has been closed, the
input area 1s set to the workspace

A commant s . W 1O set parameters for a command. Com-
mand windows ihe required eleménis of a base window
except! i\ tion. Comimand windows can use any or all
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the optional elements of a base window. The default is for command windows
not to have resize corners. However, an application with many command
windows may need to specify them for command windows.

Pushpins

All command windows have one additional element: a pushpin on the left
side of the header that can be used to keep the command window displayed
after a command has been executed.

A pushpin has two states: pinned and unpinned. Clicking SELECT on the
pushpin toggles between the two states. The application specifies the default
state for the pushpin. Each time you display a pop-up window, it uses the
application-specified pushpin state.

Unpinned Windows

When a command window is unpinned, the command is executed and the
window is dismissed when you choose a command that affects the selected
object or takes action on a function. When a command window is pinned,
clicking SELECT on a button in the command window executes the command.
However, the command window remains on the screen, available for repeated
use, until you dismiss it by unpinning the pushpin or choosing Dismiss from
the Window menu.

Figure 3-28 shows an unpinned command window. In this example, clicking
SELECT on the Load button loads the file and dismisses the command window
from the screen. When the command cannot be executed, the pop-up
window is not automatically dismissed. It remains displayed so that you can
issue another command.

Relal Edit: lLoad

File: sample.text

' (Load )

Figure 3-28 A sample unpinned command window.
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If you do not want to load a file, you can dismiss the window by choosing
Dismiss from the Window menu or by first chicking SELECT on the pushpin to
pin the window and then clicking SELECT on the pushpin to unpin it and
dismiss the window.

Pinned Windows

Clicking SELECT on the pushpin pins the window to the workspace, as
shown in Figure 3-29. It remains available for repeated use.

© Edit: Load

File: sample.text‘

(Load)

Figure 3-29 A sample pinned command window.

After the window is pinned, clicking SELECT on the Load button loads the
file but does not remove the command window from the screen. Clicking
SELECT on the pushpin unpins the window and dismisses it. As with any other
window, you can dismiss the command window whether it is pinned or
unpinned by choosing Dismiss from the Window menu.

Default Controls

A default control is specified for each command window to determine
where the pointer jumps when the window s displayed, and what action is

performed when you use the DEFAULTACTION key from the keyboard

When a command window has one pbutton, the application designates that
button as the default fr¢ that command window. When a command window
has more than one i na apphcation designates one button as the
default When : dow has no buttons. but contains other controls
or read-only irfor! PEN LOOK Ul implementation designates the
pushpin as f

Buttons are caftarad af iheDolom Ot the pane ol a command window. See

the OFt rarface Application Style Guidelines for
gUidt: i wandows
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Locations

The application determines where the command windows pop up. If you
move a command window, it pops up in the new location the next time it is
displayed. The locations of pop-up windows are remembered during a single
invocation of an application. When you quit the application, the next time the
application is invoked, all application-defined default positions for base and
pop-up windows are used.

In a Level 2 implementation, one of the window properties allows you to
record the current state and location of base windows, pop-up windows, and
menus. Use the Pop-up Windows button to record the existing configuration
and state of pop-up windows for an application. You can open or close
pop-up windows, move them to specific locations on the screen, click SELECT
on the Pop-up Windows button, and then click SELECT on the Apply button to
preserve that configuration. See “Property Windows” in this chapter for more
information.

State of Parameters

When you dismiss a command window without executing a command, any
changes that have been made in the window are retained. The next time the
window is opened, that information is displayed. For example, in Figure 3-28,
if a different file name is typed in the File field, but you do not click SELECT on
the Load button, the field is not reset or cleared when the window is dis-
missed.

The state of the pushpin is not remembered. Each time a pop-up window is
displayed, the application uses the default pushpin state.

Titles

The command window is titled according to the following conventions: The
title of the application is followed by a colon and the function of the window.
For example, the title of a graphics window that displays fill patterns is Draw:

itterns. If the window is too narrow to display the application title and
function, the application name and the colon are dropped. In this case, the

f the window is “Patterns.”

g —
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Property Windows

A property window is a pop-up window that allows you to set properties for
the currently selected object or objects. These objects can be windows or
icons on the workspace, panes in a window, or text and graphics

You set properties by following these steps:

1 Select the object.

2 Choose the Properties item on a menu, by using the Properties button in a
control area, or pressing the Properties key on the keyboard. The property
window is displayed.

3 Change the settings in the property window.

4 Click SELECT on the Apply button in the property window to apply those
settings. The property window is dismissed unless it is pinned.

See Chapter 18 for information about how to apply properties.

Property windows have all the required elements of a command window.
They always have a control area within a pane, and they may have the
optional elements of a base window

Required Property Window Buttons

In addition to the usual required elements, property windows have the
following required buttons centered at the bottom of the window, as shown in
Figure 3-30:

O An Apply button that you use to apply the settings in the property window to
the selection. Apply 1s always the default and is the only button in a prop-

erty window that dismisses the unpinned window when its command is
executed When the propérty window Is displayed, the pointer jumps to the
Apply button

O A Reset button that 542 10 reset the settings in the property window to

the values for Iné chon
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Titles

The property window displays the application title followed by a colon and
the word Properties. However, when a property window sets only one kind of
property, that property is displayed in the header following the title of the
application.

Single Category

Figure 3-34 shows an example of a simple text property window with only
one category. In this example, first you select text, then you press the
Properties key on the keyboard or use the Properties button in a control area
to display the property window. The settings for the selected text are reflected
in the property window.

1 Edit: Text
‘ Font: [Serif | Sans Serif [ Typewriter | f
Style: [ Bold ] [Italic] [ Underline | [ Overstrike | |

size:  [E]12[16]20]

Catalog Name:  Bold italic,
| I

l (Apply 7) (Reset )

h, A

Figure 3-34 A sample text property window.

Multiple Categories

When there is more than one category for a property window, the property
indow has a control area above the pane. The application uses that control
irea to display a list of the classes of properties that you can display in the
erty window pane. The examples in this book show the label “CATEGORY."
er, an application can use a label that is appropriate to the information
wyed in the property window. For example, an application could change
GORY" label to “DISPLAY."
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you can make from the new category. Clicking SELECT on the abbreviated
menu button returns the current category to the default setting.

Changing categories does not apply any changes to settings in categories
that are not visible in the pane.

More Than One Value for the Same Selection

If the selection consists of a single object, the controls in the property
window reflect the state of the object by accurately reporting on all of the
settings. For example, when all the words in a selected sentence have the
same font, style, size, and catalog name, each setting is shown in the text
property window.

However, when there is more than one setting within the selection—for
example, when a word in a selected sentence is in italics but the rest of the
sentence is in the regular font—the property window shows you that informa-
tion using the following conventions:

O The setting reflects the value of the first object in the selection. For text, this is
the first character in reading order. For graphics, it is the first object selected.

O The setting of the current control in the property window is in an indetermi-
nate state. The border of the setting (but not the label) is dimmed to show
that there are multiple values in the selection. See Chapter 4 for information
about the visual design of indeterminate state controls.

Figure 3-37 shows the borders for the Size settings dimmed.

Mu"’/‘
- e: | Bold | [ italic|

( [ Underline | [ Overstrike |

j  Size: ETI2T6T 200

Figure 3-37 A sample property window with an indeterminate setting.
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Settings that are in this indeterminate state are not applied to selected
objects when you click on the Apply button. Clicking SELECT on a setting or
editing a text field returns the feedback to normal, and the setting is then
applied when you click SELECT on the Apply button. In this way, you can
selectively change one or more settings across a range of objects.

Change Bars

A Level 2 implementation supports change bars in property windows. The
application can display a change bar on the left side of the pane to show
which settings have been modified. Change bars make it easy for you to
determine whether any settings have been changed

Suppose that you click SELECT on the “12" in the example in Figure 3-37.
The dimmed border is replaced by a specific setting, and a change bar is
displayed on the left side of the pane, as shown in Figure 3-38.

CATEGORY: (7] Text

Font: [Serif | sans Serif | Typewriter |

Style: [Bold ] [Ttalic ] [ Underline | [ Overstrike |

l Size: [g[12] _|76_‘_T_—120
Catalog Name: Bold italic,

\E_—ﬂ—’—‘\\

Figure 3-38 Property window with a change bar.

When you make a chafige in a text field and the contents of the text field
have not been validated. the application can display a dmmed change bar to
the left of the text field e contents have been validated. When the
contents have bex el the change bar is displayed as a solid vertical
line. _

When you i 1y 10 the property window from one category 10
another and arties that have not yet been appled. a
change ba 2t af the Category label to show that you have
Chaﬂt;:‘ i yones and tha those changes have not yet

beer
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As an additional visual indication that changes to other categories have not
been applied, the Apply label in the property window and on the Settings
menu changes to Apply All as soon as you change from one category with
new settings to a different category.

When you apply settings to a pinned property window, the change bars are
removed from the property window.

Dismissing Property Windows

When a property window is dismissed before you apply the changes to the
selection, the changes are discarded and a Notice is not displayed. The
Window menu button displays the word Cancel rather than Dismiss.

Two Active Selections

Property windows support two active selections at the same time so that
you can make other selections anywhere on the workspace without losing the
original selection for the property window.

When you make a selection, display a property window, and then make
another selection anywhere else on the workspace—including a selection of
the same type within the same window—the highlighting on the original |
selection dims. A color implementation may display the dimmed selection
either as a lighter shade of the specified selection color or as gray. The
property window is still active, and you can apply properties from the property
window to the original selection at any time.

The example in Figure 3-39 shows a dimmed original selection that results
from the following steps:

1 Select “windshield viper,” in the Edit window.
2 Use the Properties button on a menu to display the Edit: Properties win-
dow.
3 Move the pointer to the text field in the Edit: Properties window and select
Bold ltalic.”
4 The highlighting on “windshield viper" dims to show that it is not the
rimary selection.
1N type a different catalog name and apply that setting to the text
e dimmed highlighting using the Original Selection item from the
N menu.
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-~ Properties: Draw

Initial State:

Initial Location: |Default |
Specified] x = 100. , ¥ =200 |

Initial Size |
Height: _20 (a[¥] pixels
Width: 30 [a[3] pixels

Record Current: (Base Window State )

Capply ) (Reset )

L |

i &

Figure 3-40 Level 1 window properties.

You use this property window to specify whether the application is dis-
played as a window or an icon at startup, the initial location of the base
window, and the initial size of the window. When you apply these settings,
they apply to subsequent invocations of the application and do not change
the current location, state, or size.

The initial location is specified for subsequent invocations of this application
by typing in x and y coordinates—x = 0, and y = 0—at the upper left corner of
the screen. Alternatively, clicking SELECT on the Base Window State button
fills in the current x and y coordinates of the window and the current size of
the window. You can use these values or edit the field to modify them. When
you set the initial location to Default, the x and y numeric fields are not
displayed.

This example shows the initial size specified by number of pixels in height
and width.
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The Measure in: Category

The Measure in: category has an abbreviated menu button that displays the
units in which you can specify window size and location. Typical units of
measurement provided on this menu are:

O Pixels
O Millimeters
O Inches

When you click SELECT on the Apply button, the configurations are
recorded and used the next time you start up the application.

The Record Current State Button

In a Level 2 implementation the Record Current State category has three
buttons:

O Base Window
O Pop-up Window
O Menu

The Base Window button is the same as the Base Window State button in a
Level 1 implementation. You can click SELECT on the button to enter the
current location and location in the numeric fields.

Clicking SELECT on the Pop-up Windows button records the current position
and state of the pop-up windows for the application. Clicking SELECT on the
Menu button records the current state and default settings for all application
menus.

When you click SELECT on the Apply button, the configurations are
recorded and used the next time you start up the application.

Grouping Windows

The Manage Windows setting lets you operate on a base window and its
Ip windows either individually or as a group. When you choose the
1 Group setting, the pop-up windows are always associated with the base
v when you initiate the following operations from it:
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O Clicking SELECT on the background of the base window brings the base
window and all of its opened pop-up windows to the front of the screen. The
pop-up windows are layered in front of the base window

O Choosing Back from the Window menu of the base window moves the base
window and all of its opened pop-up windows to the back of the screen.
The pop-up windows are layered in front of the base window.

O Moving the pointer to the background of the base window, pressing
SELECT, and dragging the base window moves the base window and all of
its opened pop-up windows, keeping the pop-up windows in the same posi-
tions relative to the base window. None of the windows in the group can be
moved completely off the screen

To provide maximum flexibility in moving and layering pop-up windows,
when As a Group is set you can still operate individually on any pop-up
window in the group by initiating operations from the pop-up window instead
of from the base window, as follows:

O Clicking SELECT on a pop-up window brings only that window to the front of
the screen.

O Choosing Back from the pop-up Window menu moves only that window to
the back of the screen.

D Moving the pointer to the background of a pop-up window. pressing
SELECT, and dragging the pop-up window moves only that window.

Scaling Windows

The Scale settings allow you to set the scale of the base window and
pop-up windows for any application independently When you change the
scale of a window, the upper left corner of the window is anchored at its

previous location, and the window expands from that point unless the new
scaling size would maove the right and bottom border of the window off the
screen. In that Instanie, the window origin is adjusted so that as much of the
window as possible is displayed on the screen. A window's 0Origin can never
be adjusted so that 1 per lett corner of the window moves off the screen
The scaling siz i rovided depend on the individual OPEN LOOK Ul
implementa isplayed on the property window as exclusive

settings nited. The minimum requirement is 10 provide
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two scaling sizes. When a slider is used and the number of sizes is limited,
the slider moves smoothly when you drag it, but it jumps to the closest tick
mark when you release SELECT.

An OPEN LOOK Ul implementation supports on-screen context-sensitive
help both for elements of the interface and for applications. Help text for
required elements of the OPEN LOOK Ul is provided in Appendix C. The
Window menu button displays help text for that element. In addition, it
displays help text about selecting and operating on windows and panes.

Each application has its own Help window. There is no limit to the number of
Help windows that you can display at the same time: You can display one
Help window for each application that is displayed on the workspace. The
application provides help text for all application elements, within the borders
of windows and panes. A general description of the application (provided by
the application developer) is displayed when the pointer is on the window
background and you press the HELP key.

The name of the object under the pointer is displayed in the header of the
Help window, the object under the pointer is displayed in the magnifying
glass, and the help text for that object is displayed in the pane of the Help
window.

An OPEN LOOK Ul implementation must provide a way for the application to
add help text to the standard help for scrollbars if that functionality is expan-
ded by the application developer.

The Help Window

The Help window has the standard elements of a control pop-up window
header, and has a pane but no control area. In addition, the portion of the
screen at the pointer location is displayed in the magnifying glass to the left of
the help text. The Help window is always displayed with the pushpin pinned,
and the pointer jumps to the pushpin.

The pane of a Help window is large enough to display 50 characters and 10
lines of help text. The help text is centered vertically in the pane.

A sample Help window is shown in Figure 3-42.
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Accessing Other On-Line Help Functionality

The Help window is designed to provide context-sensitive help for visual
elements of the user interface and the application. When an on-line help
browser is available, the Help window can have an optional More button or
other buttons with labels appropriate to the expanded help functionality,
centered at the bottom of the Help window, as shown in Figure 3-44.

Q Mail Help: Selection Boxes

T
- : =
Each mail header has a selection box that
shows the status of each mail message.
I Current mail item
i
=

[N] New mail
[U] unread mail
] unselected mail

Click SELECT with the pointer on the selection
box to select a header. Click ADJUST to

] ]

Figure 3-44 A sample Help window with a More button.

What happens when you click SELECT on the More button is determined by
the application and the expanded help facility available on your system. The
application might use the More button to display on-line documentation in the
pane of the Help window. Alternatively, it could display a menu of other help
items or a new window.

The More button can also be used in the Help window that displays
information about the Window menu button to allow you to access help text
from the application.

Conversely, an application can use a More button in the Help window that
displays general information about the application to allow you to access help
text about how to select and operate on windows and panes.

Using Help

Not every keyboard has a key labeled “Help," but an OPEN LOOK Ul imple-
mentation requires that a key on the keyboard be specified as the HELP key.
You set the key used to access Help from the Workspace Properties window.

9
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You access help text in the folldwmg way:

1 Move the pointer to the object for which you want help.

2 Press the HELP key. A Help window is displayed. The pointer jumps to the
pushpin in the Help window.

3 Click SELECT on the pushpin to dismiss the Help window. The Help window
is dismissed, and the pointer jumps back to its last location.

Alternatively, you can move the pointer to another object in the same
application and press the HELP key again. The new help text is displayed in
the pane of the same Help window. As with all pop-up windows, once you
move the pointer from its original position in the pop-up window, the pointer
does not jump back when you dismiss the window.

The OPEN LOOK Ul implementation determines whether or not output to the
screen is frozen when a menu is displayed. When you use the HELP key while
a menu is displayed, if the output to the screen is frozen, the menu is
dismissed, the Help window is displayed showing help text for the object that
was under the pointer (either the menu background or a specific control)
when the menu was displayed, and the pointer jumps to the Help window.

If the output to the screen is not frozen, the Help window is displayed and
the pointer remains on the menu. Pointer jumping is automatically suppressed
in this situation so that you can read the help text and activate the control
immediately if it is the one you want to use.

The OPEN LOOK UI does not specify how help text strings are referenced,
how objects are linked to the help text. or where the messages are stored.

Notices are used to confirm major operations that cannot be undone and to
report serious warnings and errors. Notices differ from other pop-up windows
in the following ways

O Notices are initistad by the application

O Notices consist | few sentences that describe the situation and tell you
how to proces

O Notices limit i £5 yOu can make to a few buttons

O Notices caf |

0O A defatl 4 eneciliag

O Notice lars and I00iers
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O Notices are displayed in a font that is one scaling size larger than the win-
dow font to attract attention. When the window is in the largest font, the
Notice uses that font.

O Notices block input to the originating application, not to the entire screen.

O When a Notice is displayed, the OPEN LOOK Ul implementation flushes the
buffer queue, discarding keystrokes and mouse clicks for the application.
Flushing the buffer queue prevents you from inadvertently dismissing a
Notice by typing or mousing ahead.

The Notice Window

The Notice window has the following required elements:

O A 2-point border with a pane positioned 2 points from the Notice border.
O At least one button.

WFen the OPEN LOOK Ul implementation can support nonrectangular
shapes, the Notice has an optional three-dimensional triangular shadow
pointing to the place on the screen that originated the Notice, as shown in
Figure 3-45.

File Exists. Overwrite it?

(Sage) (Cancel)

Figure 3-45 A sample Notice.
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Notice Use and Placement

The Notice window pops up from the place of ongin of the Notice function
1o give you a visual reminder of the action that originated the Notice, The
pointer jumps to the default button but is not constrained to the buttons. The
header of the base window and any open pop-up windows of the application
that generated the Notice display the standard busy pattern. When you click
SELECT on one of the buttons, the Notice is dismissed and the pointer jumps
back to its last location

You can move the pointer out of the Notice and perform operations in other
windows. However, If you do this, when you return to the Notice and choose
an option, the pointer will not jump back

Buttons in a Notice are centered under the text within the pane. The
application specifies where the text lines are broken. When the application
does not specify where to break the lines, the OPEN LOOK Ul implementation,
by default, breaks the text to keep the area of the Notice as close to square
as possible to avoid creating long skinny rectangles.

Notices always pop up toward the center of the screen. In the example
shown in Figure 3-45, the originating window is in the lower left corner of the
screen. Figure 3-46 shows the same Notice when the originating window is
positioned in the upper right corner of the screen.

File Exists. Overwrite it? /

{(save ) ( Cancel ) ,/

Figure 3-16 The Notue window &S always displayed toward the eenter of the screen

When tha M ies Irom @ pop-up menuy hat has been removed
the ments 1§ 3 n the Implementation can support that functiot
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On a small screen, the implementation automatically adjusts the Notice
window and its associated shadow so that the buttons always remain on the
screen. Figure 3-47 shows the progression of steps an implementation takes
to make sure the useful part of the Notice always remains visible. In the top
example, the space between the Notice window and the originating button
has been shortened. In the second example, the shadow is displayed only
from one side of the window. In the third example, the originating button is
under the Notice, and no shadow is displayed. In the extreme case (not
shown), the borders of the Notice window are moved off the screen.

File Exists. Overwrite it?

(save ) (Cancel)

File Exists. Overwrite it?

((save ) (Cancel)

Nque

File Exists. Overwrite it?

("save ) (Cancel)

Figure 3-47 The Notice shadow is automatically adjusted to keep the Notice window
on the screen.

The OPEN LOOK Graphical User Interface Application Style Guidelines
les suggestions for Notice messages and layout.
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Visual Feedback

Each control has a consistent visual feedback convention that shows the
following conditions when appropriate for the control:

O The selection or setting feedback is used to show that you have pressed
SELECT with the pointer on a control. An ADJUST click momentarily displays
the question mark pointer. When appropriate, the visual feedback for press-
ing MENU is described. When MENU is not an appropriate input, the menu
click is ignored and the question mark pointer is momentarily displayed.

O The default ring is used on buttons in pop-up windows and on menu items
and settings to show the individual control that is the default choice.

O The inactive state is used to show that a command cannot be executed or
is not currently available.

O The indeterminate state is used only in property windows to show that a
selection has more than one value for an individual setting.

O The busy state is used on button controls and menu items to show that a
button is executing an application command and cannot accept further
input until the process is complete.

The following sections describe each control and the visual feedback for
each state.

Button controls are the most common kind of control. There are two kinds of
button controls:

O Buttons
Menu buttons

Buttons are used for single commands. The label on the button describes
he function that is executed.
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Visual Feedback for Button Controls

Each button control consistently uses visual feedback conventions to show
the conditions described below:

O When the pointer is on a button and you press SELECT, the button high-
lights. An ADJUST or MENU click momentarily displays the question mark
pointer.

O When the pointer is on a menu button and you press MENU, the menu but-
ton highlights and the button menu is displayed. An ADJUST click momen-
tarily displays the question mark pointer.

O When the pointer is on a menu button and you press SELECT, the default
setting from the first menu under the menu button is displayed in place of
the menu button. (See Chapter 5 for examples of this feedback.)

O When a button or menu button is the default, a ring is displayed inside the
button outline.

O When a button is inactive, the button outline and label are dimmed.

0 When a button is busy, the button background shows the standard busy
pattern. The standard busy pattern is always gray, even in color
implementations.

Buttons do not have an indeterminate state.
Figure 4-3 shows examples of the visual feedback for button controls.
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Buttons

Buttons are used for single commands. The label on the button relates to
the name of the function executed by it. When the image or label that is
displayed within the border of the button requires more space than is
specified by the default button size, the corners of the button retain the same
shape, and the height of the button is adjusted. The application specifies the
width for buttons.

Figure 4-5 shows horizontal and vertical arrays of buttons and examples of
buttons that are taller than the default size.

Cut ZRAD,
((cut ) (copy ) (Paste ) (Copy ) (ar— )

Figure 4-5 Horizontal and vertical button arrays.

When the command that is executed displays either a base window or a
pop-up window, the button is called a window button. The button label always
has a window mark (...) following it.

Figure 4-6 shows horizontal and vertical window buttons.

(Load... ) ("store... ) (Include File... ) (store... )

Include File ...

Figure 4-6 Horizontal and vertical window buttons.

When a window that originated from a window button is already displayed
he workspace, clicking SELECT again on that button does not display a
vindow. Instead, the current pop-up window is brought to the front of the
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The button menu is like a control area that is kept out of the way until you
need to use it. When menu buttons are displayed in control areas, the
application developer can choose whether the button menu appears cen-
tered beneath the button for horizontal arrays, or to the right of the button for
vertical arrays.

Menu Items

When button controls are displayed on menus, they keep their labels and/or
glyphs but do not display the button borders. These borderless button labels
are called menu items. Menu items have the same “feel” as buttons, but have
a slightly different look. You can choose whether or not to display the sub-
menu for items that have a menu mark, depending on how you drag the
pointer onto or within the item. See Chapter 6 for more information about
menu items.

Abbreviated Button Controls

Button controls can be displayed in a small form without a title. Abbreviated
button controls function in the same way as other button controls, and use the
same visual feedback conventions. This section describes abbreviated
buttons and abbreviated menu buttons.

Abbreviated Buttons

Abbreviated buttons have the following elements:

O A 1-point square border with a drop shadow

O An optional bold, right-justified label followed by a colon positioned to the
left of the abbreviated menu button

O A Level 2 implementation supports an optional glyph within the border of
the abbreviated button

Figure 4-9 shows some typical examples of abbreviated buttons that are
Ised for scrolling.
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Category: (7] Text

Category: [_@\Text

lcons

Color

Menus
ez
Messages

Mouse Settings

Keyboard Equivalents

Category: Text,

Figure 4-10 Examples of abbreviated menu buttons.

The first example in Figure 4-10, shows an abbreviated menu button for a
property window with the current item displayed to the right.

The second example shows how the abbreviated menu button looks when
you press MENU to display the button menu. The left side of an abbreviated
button menu is aligned with the left side of the menu button, and the top of the
menu is aligned with the bottom menu button line.

An OPEN LOOK Ul implementation also supports a text field to the right of
the abbreviated menu button that shows the current item from the menu. This
variation is used when you can add items to the menu. In the third example,
the current value is presented as a text field. When the application validates
the text field, the contents of the text field are added to the choices on the
menu.

When you move the pointer onto the abbreviated menu button and press
SELECT, the default item on the menu is displayed to the right of the button.
Releasing SELECT chooses the default item.
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Figure 4-12  Exclusive settings in a three-dimensional implementation.

Setting Feedback

To change a setting, move the pointer to another setting and click SELECT.
The bold border on the previous setting is moved to the new setting. An
ADJUST or MENU click momentarily displays the question mark pointer.

The OPEN LOOK Ul implementation may need to adjust the bold border that
shows a chosen setting, depending on the resolution of the display. For
example, on a medium-resolution display, a 2-pixel border provides enough
visual feedback. However, on a high-resolution display, a 3-pixel border is
required.

To make the current setting stand out more on grayscale or high-resolution
screens, the interior borders of settings, both vertical and horizontal, can be
lighter than the outline without using a dotted line. For example, on a gray-
scale screen, the interior borders could be gray and the outer borders black.
Medium- and low-resolution screens do not make a visual distinction between
the interior and exterior border.

Default Settings

When exclusive settings are used on menus and while you are pressing
the default modifier key and MENU, the default setting has a 3-point
dark-light-dark border. In the example on the left in Figure 4-13, Small is the

default setting. In the example on the right, the solid pattern is the default
setting
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Nonexclusive settings can be used to show a single choice that can be
either “on” or “off.” Figure 4-17 shows a single nonexclusive setting without a
label for a graphics application in which you can choose whether or not to
constrain objects to a grid in the drawing area.

| Constrain to Grid |

Figure 4-17 A single nonexclusive setting.

When nonexclusive settings are arrayed horizontally, each setting label is
centered within the border, as shown in Figure 4-18.

Font Style: [ Bold | [ttalic ] [ Underline | | Overstrike |

Figure 4-18 Nonexclusive settings arrayed horizontally.

When nonexclusive settings are arrayed vertically, the settings are dis-
played in rectangles of the same size with left-justified setting names, as
shown in Figure 4-19.

Font Style:

Overstrike

Figure 4-19 Nonexclusive settings arrayed vertically.

Nonexclusive settings can also be grouped in other combinations. The
application developer determines whether the settings are displayed in
rectangles of the same size with left-justified setting names or arranged in
some other layout. Figure 4-20 shows examples of different layouts of

lusive settings.
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In the example shown in Figure 4-21, the selected text has bold at the
beginning of the selection and underline in the middle of the selection. When
you display a property window for this selection, the current setting for Bold
and the unselected border for Underline are dimmed. See Chapter 3 for more
information about indeterminate settings in property windows.

Font Style: : Bold :
| Italic |
- Underline

| Overstrike |

Figure 4-21 Indeterminate state nonexclusive settings.

Inactive State

The entire setting is dimmed, including the label, the borders, and the text.

- Check Boxes

Check boxes are a kind of nonexclusive setting provided for lists of items
that have a yes/no or on/off response when a label is not required. Check
boxes cannot be used in menus.

Check boxes have the following elements:

0 A square 1-point border when the check box setting is “off” or “no”
O A check mark in the check box when the setting is “on” or “yes”

Figure 4-22 shows a check box in the “off” and “on” states.

U
v

Figure 4-22 Check boxes.
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Sliders are used to set a value and give a visual indication about a setting.
Sliders can be horizontal or vertical, and they can be displayed in a variety of
ways. Sliders cannot be used in menus.

A Level 1 implementation requires the basic horizontal slider with the
following elements:

O A slider bar with a drag box

O An optional label

O Optional maximum/minimum value labels (either text or numeric)
O An optional read-only current value field

O An optional type-in field

The examples in this section show the placement, usage, and descriptions
for default placement of slider controls. The OPEN LOOK Ul implementation
can provide additional display variations.

Figure 4-24 shows examples of Level 1 horizontal sliders.

D— Basic slider
Density: D—- with label
Density: 0 emsn[] 100 With min/max values
Density: 17 —[} ) wWith read-only current value field
Density: 5_3+ D: With type-in current value field

Figure 4-24 Level 1 horizontal sliders.

Figure 4-25 shows a three-dimensional slider.

Figure 4-25 A three-dimensional slider.
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Figure 4-27 Vertical sliders.

The application can specify whether tick marks are present or not. When
tick marks are used, the application can specify the interval between tick
marks for each individual slider.

In addition, the application can specify the action of the slider drag box
when tick marks are present. The slider can work in one of two ways:

O The drag box snaps to the nearest tick mark when you release SELECT.
O You can position the drag box at any point along the slider, and the tick
marks provide visual feedback.

Setting Feedback

The drag box and end boxes highlight when you press SELECT. An ADJUST
or MENU click momentarily displays the question mark pointer.

Default Setting

Sliders cannot be used on menus; they therefore lack default settings.

Indeterminate State

he slider is dimmed; the label is not.

Inactive State

label and the entire slider are dimmed.
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Controls

Using Sliders

You can change the value of the shider in the following ways. depending on
the functionality implemented by an application

O Move the pointer to the slider drag box and press SELECT. The drag box
highlights, and the pointer stays in the drag box. Drag the pointer to change
the setting, and then release SELECT

O Click SELECT on the slider bar to the left or right of the slider drag box to
change the setting by one increment. The drag box pushes the pointer
ahead of it as the settings change, If necessary. 10 allow repeated clicks.

O Click SELECT in the open rectangle at either end of the slider to change the
setting to either the minimum or the maximum. The rectangle is highlighted
while you press SELECT

O Type the value in the field. When you press Return, the drag box on the
slider moves to correspond with the typed value. If you type a number be-
yond either end of the numeric range. when the field is validated, the shider
drag box moves to the maximum or minimum, and the value in the numeric
field automatically changes to reflect the correct number.

The slider responds to typed input in a text or numeric field only when you

validate the data by pressing the validation character (typically Tab or Return)
specified by the applicaton

The OPEN LOOK Ul specifies read-only gauges that an application can use

to provide useful informarios Gauges can be used to show status information
such as percent of Ciss LSED Of buffer storage capacity. Gauges cannot be
used in menus

Read_onl\’ ga nEs Maye (ng 1inow ng e'eme’\[S
O A 1-point OLithnEe
oA dark aréa I ' ¢ e outline
O Optional tiak mat! i hofzontal gauge or to the right of a vertical

gauge
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O Optional numbers or labels at the first and last tick mark
O An optional right-justified bold label followed by a colon to the left of the
gauge

Gauges can be displayed horizontally or vertically. Figure 4-28 shows
examples of horizontal and vertical gauges.

Temperature: [ |- 30 Disk Usage: (eomsess )
1

Figure 4-28 Gauges.

Gauges show no selection or setting feedback, have no default setting, and
have no indeterminate or busy state.

Gauges can have an inactive state when the information shown by the
gauge is not current or has not been updated.

In a three-dimensional implementation, gauges look much like sliders.

- Text Fields

Type-in text or numeric fields are used to type information from the key-
board. Text fields are never used on menus. Text fields can be displayed
anywhere in a control area or a pane, and may follow other controls such as
nonexclusive settings or sliders.

Text fields have the following elements:

A right-justified bold label followed by a colon to the left of the text field

A 1-point underline defining the length of the field for single-line text fields

A 1-point rectangular or square border defining the area of the field for

multi-line text fields. Multi-line text fields can be a fixed size or scrollable. A
rollable multi-line text field has a scrollbar.
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direction shown by the arrow. The scrolling buttons are displayed interactively
only when the text string is longer than the display field.

Text fields should generally be long enough that scrolling buttons are not
needed for normal operation.

Figure 4-31 illustrates how the scrolling buttons function. Note that if
“*ABCDEF" is a value expected in normal operation, the application should
define a field long enough to contain those characters without requiring the
scrolling buttons.

Name: ABCD, Type characters in a 4—character
T field

Name: E]DEF‘_ YWhen you type more characters,
(E and F in this example), the
first character of the field is
replaced by a scrolling button to
show that the field contains
more characters to the left.

Name: [JCD, D) if you click SELECT on the
left arrow, the text scrolls
one character to the right,
and a scrolling button is
displayed at the right of the
field to show that the field
also contains more characters
to the right.

Figure 4-31 A text field with horizontal scrolling buttons.

When you press SELECT on one of the scrolling arrows, it displays the
standard highlighting feedback. When you release SELECT, the text in the field
scrolls one “a" character width. |

When a text field with scrolling buttons contains proportionally spaced {
characters, the text field always displays complete characters. The new text is
aligned with the end of the text field, and white space is added as padding at

eginning of the line to adjust the spacing.
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When there is no restriction on the number of characters that can be typed
in a multi-line text field, the application defines the size of the multi-line text
field border and displays a scrollbar to the right of the border, as shown in
Figure 4-33.

]

Product Description: | desighed to allow the user to
combine and manipulate both
text and graphic objects easily.
The goal of the design team is
to provide an intuitive, logical
interface.

a

Figure 4-33 A multi-line text field with a scrollbar.

Text Field Example

Figure 4-34 shows an example of a numeric field, a single-line text field,
and a nonscrollable multi-line text field.

Number: 13 (a]+]

i

Product Name: Draw

Comments: | thic broduct is in Beta test. All customers
have installed the product, and the

Beta Test coordinator is circulating

copies of the test reports.

Figure 4-34  An example of text fields.




—
Controls

Validating Text Fields

The application determines whether or not to validate a given text field.
Validation commonly includes checking the information in the field to be sure
that it contains data that the application can use. For example, If you type
numeric characters in a field that accepts only alphabetic characters, when
the field is validated, the application informs you that alphabetic input is
required. Validation from the application can occur on a per-field or per-form
(when all changes are applied) basis. Per-field validation occurs when you
press Tab or Return, or when the insert point is set to another text field.

All numeric fields, including those for sliders, provide immediate error
checking for invalid characters. When you type an illegal character, the
system beeps and displays the message “Not a number” in the footer.

In a Level 2 implementation, when you make a change in a text field and
have not validated the contents of that field, an application can display a
dimmed change bar to the left of the text field until the contents have been
validated.

Setting Feedback

The active caret is set when you press SELECT or ADJUST. An ADJUST click
extends or reduces the selection. In a Level 1 implementation, a MENU click
momentarily displays the question mark pointer

In a Level 2 implementation. pressing MENU displays the text field Edit
menu. See Chapter 10 for a description of the Edit menu

Default Settings

Text fields cannot be used in menus, they therefore lack default settings

Indeterminate State

The text fine or (2a! ractangla is dimmed 1o show an indeterminate state text
field. The labe mimed

Inactive State

The laps & recltangle are cimmed for text fields
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An OPEN LOOK Ul implementation supports the display of read-only
messages in panes or control areas. Read-only messages can consist of a
text string or a glyph. For example, the information about file size, modifica-

tion, access, and type in the example shown in Figure 4-35 are read-only
messages that provide information about a file.

"~ File Manager: File Properties

Name: jester.doc,

owner: t.insor

Group: staff

Read-only text strings
Last Accessed: Thu Sep 22 10:33:22 1988

Type: ascii text

Figure 4-35 Text messages in a property window.

Size: 1997 bytes
Flast Modified: Thu Sep 22 10:32:31 1988

When read-only messages are displayed on the window background or in a
pane, they do not interfere with the normal functioning of that area of the
window. For example, the application title in the header is a read-only
message. You can click SELECT anywhere on the header, whether the pointer
is on the title or not, to select the window. When you press MENU with the
pointer on a read-only message, the menu appropriate to that area of the
window is displayed.
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The following examples show various combinations of controls in command
window panes. Figure 5-4 shows an example of a command window with text
fields, buttons, and exclusive and nonexclusive settings.

© Edit: Search and Replace

Search For:

Replace With:

| Ignore Case | Foruard
Backward

[Wild Card Searches |

| Wraparound Searches |

((Search) (Replace & Search) (Replace A11)

Figure 5-4 A control area pane in a command window.

The application developer determines the layout of controls within a pane.
Figure 5-5 shows an example of check boxes and sliders within a pane.

CQ Draw: Angle Constraints

! i angle 1. 30

¥ Angle 22 45

] Angle 3¢ 20 _I:'; )

- J

Figure 5-5 A control area pane with check boxes and sliders.
F

jure 5-6 shows an example of a command window with exclusive and
lusive settings, a numeric field, a slider, and a button.
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Then press SELECT. The window button highlights as shown in Figure 5-8.

Draw T

(Line) (Rectangle) (Circle) i’m

Figure 5-8 Press SELECT to highlight the button.

To activate the button, release SELECT. The button displays the standard
busy pattern while it is executing the command, as shown in Figure 5-9. The
busy pattern may be displayed momentarily. If you do not want to activate the
button, move the pointer off the button and release SELECT.

Draw T

(Line) (Rectangle) (Circle)

Figure 5-9 Release SELECT to activate the command that displays the pop-up
window.

When the command is complete, the button returns to its normal appear-
aince. In this example, the Patterns pop-up window is displayed and the
pointer jJumps to the pushpin, as shown in Figure 5-10. See Chapter 3 for
nformation about pointer jumping.
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Using Menu Buttons in a Control Area

You can use menu buttons in a control area in two ways:

O Press SELECT to view the default from the button menu in the control area.
Release SELECT to execute the default.

O Press MENU to display the menu for the menu button. To dismiss the menu,
move the pointer off it and release MENU. To execute a command, press
MENU, drag the pointer onto an item in the menu, and release MENU.

The following sections describe how to use menu buttons in a control area
to display menu defaults and how to choose from menu buttons in a control
area. For a detailed description of viewing and choosing from menus see
Chapter 15.

Menu Defaults for Menu Buttons

The default control for a button menu is the one that is automatically used
when you click SELECT on a menu button in a control area or on a stay-up
menu. Menu defaults provide a quick and convenient way to activate a
function, while still providing the flexibility of making a different choice or
quickly changing the default setting. The visual designs for control default
settings are described in Chapter 4. See Chapter 6 for more information about
menu defaults and Chapter 15 for information about how to change the menu
default.

Viewing Menu Button Defaults in a Control Area

When menu buttons are displayed in a control area, you can view the |
default for the menu immediately under the menu button without displaying
the menu.

You do this by moving the pointer to a menu button in the control area and
pressing SELECT. The default choice for the menu immediately under the
menu button is displayed in the area occupied by the menu button. Releasing

ECT executes the default and returns the menu button to its normal state.
ing the pointer off the button before releasing SELECT returns the menu
to its normal state without executing the default.
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Inactive Default Settings

When a default setting on the button menu is inactive, the default is shown
dimmed when you press SELECT. When you release SELECT, the system
beeps to let you know that the default setting is unavailable. Figure 5-16
shows an example of viewing an inactive default item.

Move the
pointer to a
menu button.

Press SELECT
to view the
default.

Release SELECT.
The system beeps
to show that

it cannot use

the default.

oo

(_File 7) (View v ) ( Edit v?

L

i

N

(View v) (Zut o

000

(File v) (View v) (Edit 7)

Figure 5-16 Viewing an inactive default item.

Viewing Menu Button Menus with Press-Drag-Release

When a menu button is displayed in a control area, you view its menu by
pressing MENU on the menu button, as shown in Figure 5-17. Drag the pointer
off the menu button or the menu and release MENU to dismiss the menu.
When the pointer is on a menu button and you press MENU, the button
highlights and the menu is displayed. The pointer never jumps into the menu;
it remains on the menu button until you drag the pointer into the menu.

Drag the pointer onto an item in the menu and release MENU to make a
choice. If you do not want to make a selection, drag the pointer off the menu
and release MENU.
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(_File_7)

(Display 7) ( Find 7)

Figure 5-18 A menu button displays the standard busy pattern when the menu is dis-
played in stay-up mode.

Viewing menu button defaults with SELECT works exactly the same way it
does in control areas. Clicking MENU with the pointer on an item with a menu
mark without moving the pointer beyond the damping factor displays the
submenu in stay-up mode. Pressing MENU without moving the pointer
displays the submenu in press-drag-release mode.

Clicking SELECT or MENU anywhere off the stay-up menu items dismisses
the menu from the screen and does nothing else. For example, if you click
SELECT on a button in the control area with a stay-up menu displayed on the
screen, the menu is dismissed. You must click SELECT again on the button in
the control area to choose that function. An ADJUST click momentarily
displays the question mark pointer.

See Chapter 15 for more information about viewing menus and submenus
and choosing from them.
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Required Menu Elements

Each menu has the following elements:

0 Menu outline

O Drop shadow

O Items and/or settings

O One default choice per menu

O Pop-up menus always have a title

The specifications for menu titles are provided under “Menu Titles” later in
this chapter.

The only optional menu element is the pushpin. Pushpins on menus are
described under “The Optional Pushpin” later in this chapter.

Border and Drop Shadow

Menu borders are rectangles with a drop shadow, as shown in Figure 6-1.

Figure 6-1 A sample menu border and drop shadow.

The border is a 1-point rectangle. The drop shadow is 6 points wide, and
starts at the seventh point from the upper right and lower left corners of the
menu outline.

On monochrome systems, the drop shadow is 75 percent gray. The shadow
/ays visible. When possible in an OPEN LOOK Ul implementation, the
icdlow is transparent, allowing the information behind the drop shadow to

A ‘M':l'l(}h
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Menu Elements

In a color implementation, the drop shadow is a darkening of the color under
the drop shadow. The drop shadow can be an overlay of a 75 percent stippled
pattern over the color background, increased in saturation, or grayed.

When the shadow cannot be implemented as transparent, the opaque
shadow obscures the information behind it.

Controls

Each menu has at least one control. The application developer chooses the
appropriate control to provide efficient interaction with the application. A
menu can have the following controls

O ltems
0O Exclusive settings
O Nonexclusive settings

These controls can be used on menus in any combination. The functionality of
settings is described in Chapter 4. The following sections describe these
controls and show examples of how they can be used in menus and submenus

Items on Menus

Items on menus are similar to buttons, as described in Chapter 4, and they
provide the same functionality as command, window, and menu buttons:

O A command item s like a command button. You use it to execute the com-
mand named in the item

O A window itemis like a window button. When the item 1s followed by a win-
dow mark, a window Is displayed

O A menu item'is like a menu button. You use it to display a submenu

ltems on menus are displayed vertically, and the width of the menu is
always enough to accaimimaa ile the longest text item, whether that is an item
or a setting on the ma r ine title ot a pop-up menu. Window marks follow
the item label Menu marks are always right-justified and are aligned following

the longest tex! ilam on ha manu. Figuta 6-2 shows an example of a button
menu with a 6e ! & Of ems
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.—4 Workspace

% Programs__ © )
“Utilities B

Properties...

Exit

Figure 6-2 A menu with three kinds of items.

Programs and Utilities are menu items. The menu mark points to the right to
show that the submenus will be displayed to the right of the item. Properties is
an item with a window mark; choosing it displays a property window. Exit is a
command item; choosing it exits the workspace.

The Programs item has a default ring to show that it is the default item on the
menu. See “Menu Defaults” later in this chapter for more information about
menu defaults, and Chapter 15 for information about changing a menu default.

Highlighting Feedback. When you drag the pointer onto a menu item, an oval
with the same dimensions as the default ring highlights, as shown in Figure 6-3.

Figure 6-3 A menu with a highlighted item.

The highlighting follows the pointer as you drag it from item to item. As soon
as you drag the pointer onto any menu item, the default ring is no longer
displayed on the menu. Releasing MENU when an item is highlighted activates
the item. See Chapter 15 for more information about choosing from menus.
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When they are displayed in groups, nonexclusive settings are formatted in
the same way as exclusive settings.

Menus with nonexclusive settings show the current state of each setting
unless the pointer is on the setting. Moving the pointer onto a setting toggles
the setting to its opposite state. When the pointer is on the menu, no default
ring is displayed.

A menu with nonexclusive settings is dismissed when you choose one
setting, even if the choice you make is to turn the setting off. An application
that provides menus with nonexclusive settings may also provide a pushpin
on the menu so that you can pin the menu to the workspace if you want to
make more than one choice from the nonexclusive settings.

Mixing Controls on Menus

A Level 2 implementation allows an application to mix items and exclusive
and nonexclusive settings on the same menu. Figure 6-9 shows an example
of a menu that has both an item with a window mark and exclusive settings.

~4

)

[Angle 1: 90 degrees]

[ Angle Constraints 7

{ All Settings...

[Angle 2: 45 degrees|
[Angle 3:

30 degrees]|

Figure 6-9 An example of mixed controls on a menu.

Menu Titles

Pop-up menus always have titles. Menus or submenus that originate from
menu buttons or menu items do not have titles, since the name of the menu
button or item that you press to display the menu or submenu acts as the title
for the submenu.

A menu with a title is always wide enough to display the menu title. The title is

ntered, in bold type, and has a 1-point line beneath it, as shown in Figure 6-10.




m—— e
Menu Elements

—=

Figure 6-10 An example of a menu title.

Menu Defaults

Each menu or submenu has only one detault (even when nonexclusive
settings permit more than one choice from a menu). When the application
does not specify a default, an OPEN LOOK Ul implementation uses the first
item on the menu as the default. When a menu has a pushpin, the pushpin Is
the first item on the menu. If the default is removed from a menu by an
application, the application is responsible for setting a new detfault. When the
application does not reset the default, the first item on the menu becomes the
default. Chapter 4 shows the visual designs for exclusive and nonexclusive
setting defaults.

Default settings are displayed only when the pointer is not on a menu
control. They are never displayed on submenus unless you press the
SETMENUDEFAULT modilfier key to display or set the menu default.

An OPEN LOOK U! implementation searches for menu detfaults from the
originating menu down through the levels of submenus (from left to right) and
executes the default at the end of the search chain.

How Menu Defaults Affect Other Windows

The default for each menu. Including window and scrollbar menus, is set

individually for each menu in each invocation of an application, even if you
have several windows opafi that are running the same application. The
default setting Is not saved across invocations of that application

Level 2 implemeniai liow you to save the application configuration for
window propertie whing the current default settings, for all menus. In this
way. you can customize the manu oefaults for an application. See Chapter 3

for more Infor i 4 vnOOW pfoperties
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The Optional Pushpin

Any OPEN LOOK Ul implementation menu or submenu can have a pushpin
at the top left side of the menu. Some OPEN LOOK Ul implementations, based
on earlier versions of the OPEN LOOK Graphical User Interface Functional
Specification have pushpins positioned at the top right side of the menu.

The application developer determines which menus have pushpins. When
a menu has a pushpin, you can use it to keep a frequently used menu pinned
to the workspace.

The pushpin can be set as the menu default either by the application or by
you. When the pushpin is the default, the unpinned pushpin has a circle
around the pinhole. Figure 6-11 shows a pushpin with a default ring.

Pattern v ) #

e
L

Figure 6-11 The pushpin as the default on a menu.

See Chapter 15 for a description of how to pin a menu to the workspace.
Figure 6-12 shows a menu group in which both the button menu and the
submenu have pushpins. In this example, you can pin each menu separately.
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Move the pointer
to the Edit
menu button.

Edit

(File_7) (View 7) (Edit7)

| The cliffs fell steeply away from the tortuous

| mountain road‘

I To

Bottom of
the screen

Press MENU.

(_File 7) (View ¥

The cliffs fell stee
mountain road‘

m 3
%onv find 7)

Regions &

the tortuous

Text 4

e

Bottom of
the screen

Figure 6-17 Alignment for menus at the bottom of the screen.

The menu is centered on the originating menu button, as usual. The bottom
of the drop shadow aligns with the bottom of the screen. The pointer moves
as needed so that it is positioned a few points to the left of the default item on

the button menu.

When the menu or submenu bumps against the right side of the screen, the
pointer moves as needed so that it is positioned a few points on the left side
of the default item on the button menu. The menu is pushed to the left so that
the right side of the drop shadow aligns with the right side of the screen.

See Chapter 15 for menu placement specifications.






















Scrolling

top of the pane) An ADJUST click momentarily displays the question mark

pointer. Clicking or pressing MENU anywhere in the scrollbar area displays the
Scrollbar menu.

Normalization

The application developer determines whether scrolled objects are
adjusted so they are always fully displayed (normalized). For example, when
you scroll text in a pane, it moves line by line so that the full height of the
characters is displayed.

Drag Area

Press SELECT, and drag in the drag area of the elevator to move the view in
the pane forward or backward in the application data. The drag area high-
lights, and the pointer rides the drag area. The mouse can be moved any-
where, but the pointer remains constrained to the drag area until you release
SELECHT.

In a Leve! 2 implementation, the contents of the pane are updated as you
drag the elevator. When you release SELECT, the drag area returns to normal.

An OPEN LOOK Ul implementation permits you to move rapidly to a relative
position in a large file. If you scroll so quickly that the view In the pane cannot
keep up with the position in the data. you do not need to wait for all the data
to scroll through the pane. The scrolling display can jump ahead to the new
point Iin the data

Up and Down Arrows

When the up or down arrw cannot be used to scroll up or down because
you are at the beginning or the end of the data that can be scrolled, the arrow
is dimmed When all the data are visible in the pane, both the up and down
arrows are dimmed

When you click SELECT on the up arrow, it highlights. the elevator moves up
one unit (displaying one new unit 3t the top of the pane), and the up arrow
returns to NorifiAl

When you click S n the down armowy, it nighlights, the elevator moves
down one unit (g . g new unil a8t the bottom of the pane). and the

down arr
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Pressing SELECT repeats the click function. The pointer is locked on the
elevator and rides it up or down until you release SELECT. This allows you to
keep the mouse in the same position on the pad as you scroll through data in
a pane.

If you are using the scrollbar with an absolute pointing device, such as a
light pen, you can disable the scrollbar pointer jumping from the Workspace
Properties window.

Cable Area

Clicking SELECT below the elevator anywhere in the scrollbar region be-
tween the elevator and the bottom cable anchor moves the view on the data
downward one pane. The elevator is repositioned downward accordingly.

Clicking SELECT above the elevator moves the view on the data upward one
pane. The elevator is repositioned upward accordingly.

Pressing SELECT repeats. The pointer jumps ahead on the cable to stay out
of the way of the elevator, if necessary.

Cable Anchors

You move the view to the beginning of the data by clicking SELECT on the
top cable anchor. The following actions are performed:

1 The top cable anchor highlights while you press SELECT.

2 The view in the pane is moved to show the beginning of the data.

3 The elevator is moved to the top of the pane, and the proportion indicator
is displayed below it.

4 The top cable anchor returns to its normal state.

You move the view to the end of the data by clicking SELECT on the bottom
cable anchor. The following actions are performed:

1 The bottom cable anchor highlights while SELECT is pressed.

2 The view in the pane is moved to show the end of the data. The last line of
the contents is displayed in the middle of the pane.

3 The elevator is moved to the bottom of the pane, and the proportion indi-
cator is displayed above it.

4 The bottom cable anchor returns to its normal state.
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Scrolling

Splitting Panes

In some applications such as text or graphics editors, you may want to view
different parts of the contents of a pane at the same time. A new view may be
created by dividing a single pane into two or more parts, This process is called
“pane splitting.” A Level 2 implementation provides pane splitting functionality.
An application can specify whether a given pane can be split.

You can split a pane either from the Scrollbar menu or by using the cable
anchors. When a pane can be split, the application displays the Split View
item on the Scrollbar menu for that pane. The following section, “How to Split
a Pane Using the Scrollbar Menu,” discusses using the Split View item. See
“How to Split a Pane Using the Cable Anchors” later in this chapter for infor-
mation about splitting panes by direct manipulation.

When the application provides splitting functionality, you can create
different views in the same pane. Splitting panes does not create separate
copies of the contents; it provides a sphit view of the same object. Any
changes made to the contents in one pane are reflected in the other splits of
that pane.

The limit to the number of times you can split a pane is determined by the
number of minimum scrollbars that can be displayed in the scrollbar area.

When you have split a pane, the application interactively adds the Join
Views item to the items on the Scrollbar menu. See “Removing a Spiit Pane”
later in this chapter for more information about using the Join Views item.

The following sections describe basic information about creating and
removing split panes See Chapter 16 for detailed information about creating
and removing multiple split panes

How to Split a Pane Using the Scrollbar Menu

You use the Scrollbar menu to split a pane in the following way, First, move
the pointer into the scrolibar area position it next to the place where you want
to split the pane, and press MENU. The Scrolibar menu is displayed. as shown
in Figure 7-7
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— prose
(File_v) (View v) (Edit v) (Find v)
"It was a dark and stormy night. All of the beagles IS
| were safely in their kennels. The bats flew around
the tower, squeaking frantically. &7
Dosolina stood at the open window wistfully
gazing out over the moors, her long dark tresses
blowing wildly as the wind gusted. Pietor was Scrolibar
| long 9verdue. Thefre were evil th;ngs a_nfootf in Here to Top
the night, and she feared greatly for his safety. Top to Here
. | Previous
There was something unnatural about the light split View
flickering through the clouds. The beagles bugled
their howls, protesting their captivity. l’
=
[

Figure 7-7 Position the pointer where you want to split the pane and press MENU.

Drag the pointer onto the Split View item on the Scrollbar menu. The item
highlights, as shown in Figure 7-8.

(File_v) (view v) (Edit v) (Find v)

It was a dark and_stormv night. All of the beagles
were safely in their kennels. The bats flew around
the tower, squeaking frantically.

'U

4

|
Dosolina stood at the open window wistfully
gazing out over the moors, her long dark tresses ‘

blowing wildly as the wind gusted. Pietor was Scrollbar
long overdue. There were evil things afoot in Here to Top
the night, and she feared greatly for his safety. | Top to Here

. . l Previous
There was something unnatural about the light

flickering through the clouds. The beagles bugled
their howls, protesting their captivity.

Figure 7-8 Drag the pointer onto the Split View item.

Release the MENU button. The Scrollbar menu is dismissed and the pane is
t the place the pointer occupied when you pressed MENU, as shown in
7-9, not at the current pointer location. Each split has its own scrollbar

ar menu, and the item Join Views is added to each Scrollbar menu.
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k| Draw

Figure 7-10 A pane with a vertical split.

Edit — prose
(File_ 7) (view v) (Edit @) (Find 7)
'It wvas a dark and stormy night. All of the beagles

were safely in their kennels. The bats flew around

It tvas a dark and stormy night. All of the beagles
were safely in their kennels. The bats flew around
the tower, squeaking frantically.

(| [0 060

It was a dark and stormy night, All of the beagles
wvere safely in their kennels. The bats flew around
the tower, squeaking frantically.

Dosolina stood at the open window wistfully
gazing out over the moors, her long dark tresses
blowing wildly as the wind gusted. Pietor was
long overdue. There were evil things afoot in v

-
the night, and she feared greatly for his safety.
-
[ There was something unnatural about the light
flickering through the clouds. The beagles bugled
their howls. protesting their captivity.
. " =
]

Figure 7-11 A pane that has been split twice.
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Edit — prose
(File v) (vView v) (Edit v) (Find 7)

It was a dark and stormy night. Al of the beagles
were safely in their kennels. The bats flew around
the tower, squeaking frantically.

3]

Dosolina stood at the open window wistfully
gazing out over the moors, her long dark tresses
blowing wildly as the wind gusted. Pietor was
long overdue. There were evil things afoot in
the night, and she feared greatly for his safety.

There was something unnatural about the light
flickering through the clouds. The beagles bugled
I their howls, protesting their captivity.
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Figure 7-13 To split a pane, move the pointer to one of the cable anchors and press
SELECT.

2 Drag the pointer downward. A 1-point horizontal line is displayed from the
left edge of the pane to the center of the cable anchor to show where the
split will occur, as shown in Figure 7-14.

= Edit - prose
(File_7) (View 7) (Edit v) (Find v)
1 It was a dark and stormy night. All of the beagles

were safely in their kennels. The bats flew around
the tower, squeaking frantically.

Direction
of pointer
movement

Dosolina stood at the open window wistfully

gazing out over the moors, her long dark tresses

| blowing wildly as the wind gusted. Pietor was

| long overdue. There were evil things afoot in !
the night, and she feared greatly for his safety. “

|

There was something unnatural about the light
flickering through the clouds. The beagles bugled
their howls, protesting their captivity.

Figure 7-14 Drag the cable anchor downward.

3 Release SELECT. The pane is split, and the highlighted cable anchor that
fragged with the pointer becomes the bottom cable anchor for the

e ——
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2 Drag the pointer to the Join Views item. The item highlights. The OPEN
LOOK Ul implementation provides visual feedback for the pane to show
you that the pane will be removed when you release MENU. This visual
feedback may be as simple as dimming the border of the pane or as com-
plicated as dimming the border and the contents of the pane.

3 Release MENU.

In the example shown in Figure 7-16, both the border and the contents of
the top pane are dimmed to show that it will be removed when you release

MENU.

(7] Edit - prose
('Flle 7) (view v) (Edit v) (Fmd )

as a dark and stormy i QM

snuels. Th

all of the 1"0(4‘(‘5
'\:5‘% How around

It was a dark and stmmv nlght AII of the beagles
were safely in their kennels. The bats flew around
the tower, squeaking frantically.

Scrollbar

Here to Top
Top to Here
Previous
Split View

It was a dark and stormy night. All of the beagles
were safely in their kennels. The bats flew around
the tower, squeaking frantically.

Dosolina stood at the open window wistfully
gazing out over the moors, her long dark tresses
blowing wildly as the wind gusted. Pietor was
long overdue. There were evil things afoot in
the night, and she feared greatly for his safety.

There was something unnatural about the light
flickering through the clouds. The beagles bugled
their howls, protesting their captivity.

L

h

*
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Figure 7-16  When the Join Views item is highlighted, the border and the contents of

the pane are dimmed.

When you release MENU, the dimmed pane is removed, and the contents of
the adjacent pane expand to fill the area previously occupied by the pane.
See Chapter 16 for more information about how an application fills in split

pane areas.
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Edit — prose
(File v) (View v) (Edit v) (Find v)

It was a dark and stormy night. All of the beagles
were safely in their kennels. The bats flew around

It was a dark and stormy night. All of the beagles |
were safely in their kennels. The bafs flew around
the tower, squeaking frantically.

illoL5 [ioo)

It was a dark and stormy night. All of the beagles
were safely in their kennels. The bats flew around
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| N sses

Figure 7-18 To remove a split pane, drag the pointer toward the bottom cable anchor.

3 Drag the pointer until the top and bottom cable anchor overlap. The OPEN
LOOK Ul implementation provides visual feedback for the pane to show
you that the pane will be removed when you release MENU. This visual
feedback may be as simple as dimming the border of the pane or as com-
plicated as dimming both the border and the contents of the pane. In
Figure 7-19, the border and the contents of the pane are dimmed to show
that it will be removed when you release SELECT.

Edit - prose
(File_v) (View v) (Edit v) (Find v)

[It was a dark and stormy night. All of the beagles
were safely in their kennels. The bats flew around

11 of the bea

—_— —
It was a dark and stormy night. All of the beagles
were safely in their kennels. The bats flew around

| the tower, squeaking frantically.
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Figure 7-19  When the cable anchors overlap, both the border and the contents of the
pane are dimmed.




Scrolling

4 Release SELECT. The dimmed pane is removed, and the contents of the
adjacent pane expand to fill the area previously occupied by the pane. In
the example shown in Figure 7-20, the top pane expands downward to fill
the available space. See Chapter 16 for more information about how an
application fills in split pane areas

[v] Edit - prose

(File v) (View 7) (Edit ) (Find 7)

It was a dark and stormy night. All of the beagles
were safely in their kennels. The bats flew around
the tower, squeaking frantically.

—
|
|

Dosolina stood at the open window wistfully |
et
It was a dark and stormy night. All of the beagles 1\
were safely in their kennels. The bats flew around |

the tower, squeaking frantically.

B

wistfully
sses

Figure 7-20 Release SELECT to remove the split view.

Page-Oriented Scrollbars

Applications with separate pages. such as document preparation systems,
can use a page-oriented scrollbar to show this onentation. The only time a
page number is displayed is when you press SELECT with the pointer over the
drag area of a page-oriented scrollbar. The page number display does not
prevent you from dragging the elevator

=

You use the page-oriented scrollbar in the following ways

O To view the page ¢& the pointer to the drag area of the elevator
and press SELE niaining the page number i1s displayed to the
left of the ele

O To drag the & [poimter to the drag area of the elevator and
press SE 1101 1S displayed and does not interfere wiil
dragging ! - rag the pointer, the box Interactively ex-

pands iccommodate different numbers of digits
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The page numbers change as the text is scrolled. When you release the
pointer, the view in the pane snaps to display the top of the current page.
The elevator may also make a slight adjustment to reflect its position in the

data accurately.

The top window in Figure 7-21 has a 1-digit page number. The bottom

window has a 3-digit page number.

i Edit F
(File 7) (View 7) (Edit v) (Find v)
[ pietor felt the hot breath of the ravening monsters ID
as they followed closely on his heels. He feared [Z@
| for his very life. o
n 2
=) Edit R
(File 7) (View v) (Edit v) (Find v)
cd
The skies were clear and the weather balmy, giving
the illusion of innocence. Dosolina and Pietor walked
| with determined steps across the moors, searching
| for traces of the monsters that continuously dogged
| their very existence.
[ “Oh, here’s a footprint,” Pietor cried. "1 knew that
there was something tangible in that horrid blackness =
! that was following me.” 387
v
k.
“and here's a piece of something ... Ugh, it is so
| disgusting,” said Dosolina. “What is this awful curse
|‘ that prevents us from being like normal folks?”
“We must be brave, and not let them know how
frightened we really are.” s
L 1
Figure 7-21 Two windows with page-oriented scrollbars.

Abbreviated and minimum scrollbars do not show page orientation, even
if the application provides this scrolling feature, since they do not have a

drag area.

Scrollbar Menu

T :
€ SCro

bar has a pop-up menu that you access by pressing MENU in the

1. See Chapter 10 for a description of scrollbar menus.
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Scrolling Without Scrollbars

An OPEN LOOK Ul implementation supports two additional kinds of scrolling
that are not accessed from the scrollbar

0 Automatic scrolling
0O Panning

Automatic Scrolling

A Level 2 implementation provides automatic scrolling. Automatic scrolling
occurs when you select objects by pressing SELECT and dragging the
pointer. When the pointer reaches the border of a pane, a scrolling list, or the
beginning or end of a text field. the contents automatically scroll to display
more information. A graphics application displays the next point. A text
application displays the next line. A text field displays the next character. The
pointer is not constrained to the boundary of the object. Automatic scrolling
lets you extend selections beyond the Information that is currently visible in
the pane or scrolling list

Panning

A Level 1 implementation provides a PAN modifier key—set from the Work-
space Properties window—1o allow you to “glue” the contents of a pane to
the pointer and move them In any direction. This method ot scrolling i1s called
panning. because It is like moving a video camera to change the view in the
lens. Applications that implement panning use the PAN modifier key to allow

you to access that furctonality. A Level 2 implementation provides panning
functionality for panes

When you scroll by panning, you anchor the pointer on a location that is
visible in the pane. Yau can ihen move the contents to any border of the pane
by dragging e | af The anchored contents move with the pointer. You

cannot move ] ler pulside the borders of the pane
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You initiate panning by following the steps below:

1 Move the pointer to the place where you want to start panning.

2 Press the PAN modifier key on the keyboard and then SELECT. When the
pointer changes to the panning pointer, you can release the PAN modifier
key.

3 Drag the pointer to a new location within the pane.

4 Release SELECT.

When the basic pointer is at the bottom of a pane, the panning pointer
moves upward to keep the hot spot inside the border of the pane.

A text application can permit you to move the pointer in any direction within
the pane. Alternatively, a text application can constrain panning so that the
contents of the pane scroll vertically. When only vertical panning is supported,
the panning pointer remains anchored at the horizontal position and can only
be moved vertically within the pane.

The following examples show vertical panning in a text application. To
initiate panning, first you move the pointer into the pane. In the example
shown in Figure 7-22, the pointer is at the bottom of the pane to permit you to
pan the contents of the pane upward.

Edit — prose
(File_7) (View 7) (Edit 7) (Find 7)

“ It was a dark and stormy night. All of the beagles

were safely in their kennels. The bats flew around
| the tower, squeaking frantically.A

\
| Dosolina stood at the open window wistfully
[ quing out over the moors, her long dark tresses

amnl|

b, O—

[

Figure 7-22 To initiate panning, move the pointer into the pane.

Then press the PAN modifier key on the keyboard and SELECT. The pointer
changes to the panning pointer, as shown in Figure 7-23. When the panning
pointer is displayed, you can release the PAN modifier key.
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A text application customarily normalizes scrolling so that text is displayed

line by line. The application determines whether or not scrolling is normalized.

In an application that supports unconstrained panning, you can drag the
pointer in any direction and move the contents of the pane directly. The next
examples illustrate how you can use panning to move the view in the pane.
The left part of Figure 7-26 shows the complete image, while the right shows
the portion of the image that is visible in the pane. When you initiate panning
with the pointer in the middle of the image, you can move the pointer in any
direction within the pane.

""[i] Draw

(Line) (Rectangle ) (Circle)

Figure 7-26 Panning is unconstrained when the image is not at the edge of the pane.

When you get to the edge of the image, the pointer stops, and you cannot
move It closer to the side of the pane. For example, the pane in Figure 7-27 is
at the rightmost side of the image. If you initiate panning with the pointer at
the center of the pane, your movement in the right half of the pane is uncon-

trained. However, you cannot move the pointer into the left half of the image.
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When a scrolling list is displayed in a pop-up window and the window is
dismissed, the current state of the scrolling list is retained and is redisplayed
when the pop-up window is invoked again. The application can clear current
items from the scrolling list before redisplaying it, when appropriate.

When the scrolling list is the active input area, the OPEN LOOK Ul specifies
that the implementation provide minimum pattern matching functionality, as
follows: You can search for items on the list by typing a letter from the key-
board. When an item on the list begins with that letter, the item is selected or
made current, as specified by the application. If no item on the list matches
the keyboard input, the system beeps to let you know that there is no match
for that character. If you type a second character, the next item that begins
with that character becomes current. Any application can implement alterna-
tive, more sophisticated, pattern matching functionality.

See the OPEN LOOK Graphical User Interface Application Style Guidelines
for suggestions about how to implement scrolling list functionality.

_ Required Elements of a Level 1 Scrolling List

A Level 1 scrolling list has the following required elements:

0 A 2-point rectangular border

O A scrollbar

O A list of text items

O A Scrolling List menu

O A one-point border around the current item or items
O An optional bold label followed by a colon

Figure 8-1 shows an example of a scrolling list that displays suggested
alternate spellings for a spelling checker. The current item is “charade.”

Suggested

, charcoal
Corrections:

shortly

shirttail

shortage

[charade ]
shrewdly

charged

CImE|

D S—

Figure 8-1 A basic scrolling list with one current item.
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Fonts: | Eourier |

Courier Bold
Courier Bold Italic
Courier ltalic
Gacha

Gacha Bold
Helvetica

CmE)

DW

Figure 8-3 You can choose one current item from an exclusive scrolling list.

When the window containing a scrolling list with a current item is dismissed,
the current item is remembered and is redisplayed the next time you open the
window.

If you delete the current item while editing an exclusive scrolling list, the
OPEN LOOK Ul implementation specifies the first item in the list as the current
item.

Variation of Exclusive Scrolling Lists

Just as a Level 1 implementation provides a variation of exclusive settings
that lets you choose none of the settings, a variation of an exclusive scrolling
list lets you choose none or one of the items on the list. You choose none of
the items by moving the pointer to the current item and clicking SELECT to
remove the current item border. An ADJUST click momentarily displays the
question mark pointer.

You might see this kind of scrolling list in an application that provides a list
of suggested alternate spellings when no appropriate alternate is provided on
the list. Figure 8-4 shows an exclusive scrolling list with no current items. The
suggested corrections are for the word “shargola.”
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- - D
Recipients: | Betty |M
[ Dosolina Scrolling List

Ignatz w Locate Next Choice )

@ Clear All Choices

Joy 1
.Y Edit List

Figure 8-6 The nonexclusive Scrolling List menu.

You use the Locate Next Choice item to scroll the next choice on the list that
is not visible into the scrolling list pane. You use the Clear All Choices item to
quickly clear all of the current choices, leaving no current items.

List

All scrolling lists can be edited. However, applications may restrict access
to editing functionality to a limited group of users who have the appropriate
permissions to make changes to a scrolling list. When you do not have
permission to edit a list, the application determines whether the Edit List item
on the Scrolling List menu is dimmed or not displayed.

To put a scrolling list into edit mode, choose Edit List from the Scrolling List
pop-up menu. Current items are displayed with a dimmed border.

When the scrolling list is in edit mode, you select items in the same way that
you select other graphic objects: to select one item, move the pointer onto the
item and click SELECT. An ADJUST click toggles the state of the item.

When you select a current item, the normal selection highlighting is displayed,
and the dimmed border is included in the highlighting.

Figure 8-7 shows a scrolling list in edit mode with one item selected.







OPEN LOOK Graphical User Interface Functional Specification

Fonts:

Courier

[« T3]

Courier Bold

Courier Bold Italic

Courier lItalic

Gacha
Gacha Bold
Helvetica

Q

Figure 8-9 A scrolling list with nonadjacent items selected.

~ Using Items on the Scrolling List Menu

Once you have selected items for editing, press MENU to display the Scrolling
List menu. Applications can add items to this menu to provide sort, filtering, or
item numbering capabilities. Figure 8-10 shows the minimum editing Scrolling
List menu.

Scrolling List

w_Change
Insert e P
Delete

End Editing

R R

T

Figure 8-10 The minimum Scrolling List menu for edit mode.

The following sections describe how to use each of these items.

Change

The Change item lets you edit the contents of one selected item at a time.
When multiple items are selected, the Change item is inactive. When an item is
selected and you choose Change from the Scrolling List menu, the highlighting
s replaced by a fixed length text entry line with an active caret. The header of
the window containing the scrolling list is highlighted, since the scrolling list is
the input area.

Figure 8-11 shows a scrolling list with a text entry field.
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the property window and click on the Apply button to enter that information into
the scrolling list. When multiple items are selected, the Properties item on the
Scrolling Menu is inactive.

Figure 8-13 shows an example of a property window for a scrolling list that
contains fonts. The path name showing the location of the font is an integral
part of the information in the scrolling list, although that information is not
displayed.

Courier

Courier bold
Courier Bold Italic
Courier_Italir

Gachi .~ TextTool: Properties
Gach:

[« T3]

Name: Helvetica

Path: /usr/fonts/special/helvetica

(Reset )

Figure 8-13 Choosing Properties from the Scrolling List menu displays a property
window.

Insert

The Insert menu item lets you make multiple line entries in a scrolling list.
The Insert submenu has two items that you use to position the text entry line:

Before
After

Choosing Before opens a text entry line before the first selected item in the
ling list. When there is no selected item, the text entry line is opened
e the first item in the scrolling list. When you have completed an entry,
j the Return key validates the entry, enters the new item into the list,
the text entry field down one line. You can add as many items to




— e
Scrolling Lists

the list as you want by typing an entry and pressing the Return key. Each time
you press the Return key, the entry for that line is validated and a new text
entry line is displayed. When you have entered as many items as you want,
press the Return key when the active caret Is at the beginning of the line to
remove the text entry line

Choosing After opens a text entry line after the last selected item in the
scrolling list. When there is no selected item, a text entry line is opened after
the last item in the scrolling list.

Delete

When you choose Delete from the Scrolling List menu, the highlighted items
are removed from the scrolling list. The application determines whether a
Notice is displayed to confirm the deletion or when there is additional
information, such as a path name for font location, that is attached to an item.

End Editing

When you choose End Editing from the Scrolling List menu, any opened
text entry lines are validated and closed. and the scrolling list is no longer in
edit mode. The next time you press MENU, the default Scrolling List menu is
displayed. You can return to edit mode at any time by choosing Edit List from
the menu.

Maulti-Level Scrolling Lists

In a Level 2 implementation. when a scrollable list can access multiple
levels in a hierarchy. such as a file system, it has the following additional
elements:

O Title area

O Scrolling buttorn

O Levels menu

0 Glyphs and/or texi i the scrolling list to show levels in the hierarchy

A multi-leve 15 ONE currant kam par level
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The elements of a multi-level scrolling list are described in general terms in
the following sections. The section “Using Multi-Level Scrolling Lists” gives a
more detailed example.

Title Area and Scrolling Buttons

A title area with a 1-point line beneath it contains a title in bold type, aligned
left, that describes the level of the hierarchy. Scrolling buttons for moving up
and down in the hierarchy are displayed to the right of the title area. The
scrolling buttons are used to trace a previous path through the hierarchy, and
have a Levels menu attached to them. When you have not gone to another
level in the scrolling list, the default path is the first item at each level of the
scrolling list that has a hierarchy. The title area and scrolling buttons are
shown in Figure 8-14.

Level 1

Figure 8-14 Title area of a multi-level scrolling list.

When you are at any level below the first level in the hierarchy, one dot for
each level above the current level is displayed, left-justified, above the title. In
the example in Figure 8-15, you are at level 2 in a hierarchy. There is one level
above, represented by the dot.

Level 2 @

Figure 8-15 A level 2 header of a multi-level scrolling list has one dot.

One dot is added to the right of the first dot for each additional level of the
hierarchy into which you descend. In the example in Figure 8-16, you are at
vel 3 in a hierarchy
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Levels

- _LaAsis |
Level 2

fevel 2

Levels
o0

=l
Level 2 |
tevel 3 [

Figure 8-18 Examples of a Levels menu with a history.

When you move from level 3 back to level 2, the level 3 item is still present
and active on the Levels menu, as shown in Figure 8-19.

Levels

level 2 _;/

fevel 2

Level 3

Figure 8-19 The Levels history is displayed when moved in the hierarchy.

Glyphs and/or Text Items

Multi-level scrolling lists always have a glyph that shows you whether or not
there are additional levels in the hierarchy. The hierarchical glyph is displayed
at the left of the item. Additional glyphs can also be used in a multi-level
scrolling list and, when present, are displayed to the right of the hierarchical
glyph. For example, in a file system hierarchy, glyphs representing folders
and documents could be used. A folder has levels beneath it (the documents
contained in the folder), but a document is at the lowest level of the hierarchy.

The default hierarchical glyph is a dot that is the same size as the dots that
are displayed in the title area. This glyph is present only when there are

idditional levels available for the item on the list. In Figure 8-20, the glyphs
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Figure 8-24 shows the scrolling list and its Levels menu after you have clicked
once on the top scrolling arrow. You are back at the Programs level of the
hierarchy. The menu continues to show the Programs item, and both scrolling
arrows are dark to show that you can move up or down in the hierarchy when
you click SELECT.

Levels

Programs §% Workspace )
Console... \ffz'os;z'&ms
Shell...

Office Automation

| » Office Automation |
¢ Communications

Figure 8-24 Using the Levels menu to move back up a level in a multi-level scrolling
list.

Note that as you move back up through the hierarchy, the item that is current
is the last choice you made to descend the hierarchy.

Suppose that you double-click SELECT on the Communications item to
descend to another branch in the hierarchy. The scrolling list now contains the
items Network and Telecommunications, as shown in Figure 8-25, and the
Levels menu shows the Workspace, Programs, and Communications levels.

Levels
o X X :
Communications 3w Workspace Ok
[ » Network ] 1 Programs

= ' sunicati
e Telecommunications ~ommunicalions

Figure 8-25 Moving down a different branch in a multi-level scrolling list replaces the
item on the Levels menu.

if you double-click SELECT on Network, it is added to the Levels menu, as
hown in Figure 8-26.
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You can set the color of the following elements in the interface region from
the Workspace Properties window:

0O The workspace

O The background for the icon and windows of an application

O The selection

O The active caret and header highlighting that show the input area
O Individual controls

Palettes

To ensure that the colors in the interface work well together, the OPEN LOOK
Ul uses the concept of a palette. A palette is a set of colors that harmonize
well.

Each palette is divided into three subpalettes, one for each of the following
visual elements:

O Workspace background
O Window background
O Selection/input area

The workspace and window background palettes are neutral, lightly
saturated colors. The selection/input area palette consists of bright, highly
saturated colors that stand out against the neutral background colors.

You specify a system-wide palette from the Workspace Properties window.
From within that palette, you choose specific colors for the workspace
background, the selection, the caret, and the default window background.

You can override the default background color for any application by
setting a new color from the property window of that application. All the
windows for the application use this color. This provides an easy way for you
to associate a base window with its pop-up windows. The icon for the
application also uses this color.

In most color implementations, the borders of the window are not part of the
window background. However, systems that have a limited number of highly
saturated colors can display the borders of the window using the window

ickground palette choices. In this case the window background is consid-

I to be the window borders. The OPEN LOOK Ul implementation uses




s
Color and Three-Dimensional Design

aesthetic considerations to determine whether the borders or the window
background display the color.

See Chapter 3 for an illustration of required window properties. See Chapter 11
for illustrations of system-wide color properties.

To offer flexibility, applications can be written that permit you to edit existing
palettes and create new ones.

Use of Color for a Three-Dimensional Effect

Color in controls calls for the following elements:

DO Text in black

0O Outline of controls in white
0 Window background color
O Highlighting color

O Button shadow color

Depending on the quality and resolution of a given color implementation,
these elements can be applied at three different levels.

The complete use of color requires all five elements, where the highlighting
color is a little darker than the background color, and the shadow color is
darker than the highlighting color.

Implementations that support the use of four colors for these elements
substitute black for the shadow color

Implementations that support the use of three colors use the
black-and-white design for controls, and specify a light color for the back-
ground

The specifications described in this chapter are illustrated with
black-and-white reproductions of color plates

The outlines of butt manu buttons, and the scrollbar elevator create a
three-dimenslonal effect The wp and left borders are accented with a light
background color while tha pottom and right corners are accented with a
dark backgroun

When you prs 3 button or @ menu item, the light and dark
accents are réve } | the bution area is darkened, which gives the
illusion that i i iy pushed o the surtace. This effect is
equivalent ! reversal retgmed o n this specification as

highhight
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Individual Color for Controls

The OPEN LOOK Ul allows the application (but not the user) to specify the
color of individual controls such as buttons and sliders. It is recommended
that this capability be used sparingly and purposefully.

When icons are shown on monochrome displays, they are always enclosed
in a border. The border is needed because the black text of the label on the
icon would not be clearly visible against the 50 percent gray workspace
background.

On a color display, the border is not needed, since the background color
can be lightly saturated and yet provide enough contrast to make the label on
the icon clearly visible. In color implementations, you can choose whether or
not to display borders for icons from the Workspace Properties window.

Color Guidelines

The following guidelines are included as background to help you under-
stand the motivation behind the OPEN LOOK Ul color design. These guidelines
apply equally well to the design of applications.

The design must work first in black and white. Although the use of color is
becoming more prevalent, a large number of the displays that an OPEN LOOK Ul
implementation will run on are, and will continue to be, monochrome. The basic
design cannot rely on color. Each of the elements must look good on a mono-
chrome display. When color is added, this look should be enhanced.

Use monochromatic, neutral tones for the background. The workspace is the
background against which the windows are displayed. Within the windows, all
the unbordered space is the background against which the various elements

(such as the window menu button, pushpin, buttons, scrollbars, and applica-

tion panes) are displayed. Both the workspace and the window backgrounds

should use muted and lightly saturated colors.

|
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Use color to add information to the interface. Color can be used as a code
for items such as the current selection, error information, and active areas.
Color codes are most effective when they meet the following criteria:

O They are easily identifiable

O They are used consistently (for example, the selection is yellow wherever it
is displayed).

O They reflect commonly held color associations, such as red for error or criti-
cal conditions.

O They are restrained. Research has demonstrated that the more color codes
used, the longer It takes the user to distinguish each one.

Use bright colors sparingly. Color is fun. The appropriate place to use bright
or intense color is where information transfer 1s at a minimum. Providing a
brightly colored display at power-up or log-on can create a strong first
impression without getting in the way of the interface

Allow users to set their own colors. Color preferences vary from individual to
individual. Users will want to change the colors, no matter how nice the
default palette is There are many valid reasons for allowing users to set
colors for the interface: personal preference, the need for variety, and
individual deficiencies in color perception

Consider color blindness when choosing colors. The most common color
deficiencies are in distinguishing between red and green (8 percent of men
.4 percent of women) and blue and yellow. Designing the interface in black
and white. and then adding color. ensures that color-blind individuals can use
the system

Vary brightness to show depth. Brightness can be varied as a sort of
“dimmer switch™ 1o canvey dumeEnsion

Consider the size of the ()h|0tt or area when choosing colors. Since large

areas of saturat nd 1o leave afer-images and cause faligue, nevel
use highly saturated for large areas Sudh as the background of a
window Howavs 195 Such a8 bOrders Or small glyphs that

deperid o nighly sawraied colors are valuable
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Consider the proximity of areas of color to avoid blending. Do not put small
areas of color that need to be distinguished or identified next to or near other
colors that they blend with. For example, a 1-point yellow line next to a 1-point
blue line will be perceived as a 2-point green line.

Do not use spectral extremes together. Don't use red text on blue and green
backgrounds. Colors at considerably different wavelengths appear to vibrate
when placed together.

Use high contrast between text and background. Maximum contrast, such as
white characters on a black background, or vice versa, provides the easiest
character recognition.

Consider light on dark versus dark on light when choosing a typeface. The
effect of screen elements “glowing” and giving off ambient light is called
halation. Halation causes white characters on a black background to appear
bolder and brighter than dark characters on a white background. It may be
advisable to use a bold typeface, particularly in smaller sizes, when placing
white or light characters on a dark background.

- Color Plates

Figure 9-1 (see color insert) shows a three-dimensional design using the
kinds of colors recommended for the OPEN LOOK UI, as follows:

8 Workspace: Darker muted colors imply that the background is farther away.
This creates a sense of depth for the icons and windows displayed on the
workspace.

O Windows: Very light, unsaturated colors identify windows and allow you to
distinguish among application windows.

O Selection: Saturated colors for selection allow the selection to stand out.

Figure 9-2 (see color insert) shows an example of a grayscale three-
dimensional implementation.
Figure 9-3 (see color insert) shows the Summer palette. Figure 9-4 (see
olor insert) shows the Winter palette.
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Open/Close. The Open/Close button (the default) opens selected icons,
closes selected windows, and dismisses or cancels selected pop-up
windows in the same operation.

Full/Restore Size. The Full/Restore Size button applies to all selected
windows and icons, as appropriate. When Full Size is applied to a selected
icon, the icon is opened, the window is displayed in the application-specified
expanded size, and the window is brought to the front of the screen along
with its associated pop-up windows. Any selected pop-up windows that do
not recognize the Full/Restore Size command do not change size. Closing a
window to an icon does not alter the Full/Restore Size setting for that window.

Back. The Back button moves selected windows or icons to the back of the
screen. When the window property for Group Windows is set, unselected
pop-up windows that are owned by a selected base window are also moved
to the back of the screen.

Quit. The Quit button quits the selected windows or icons.

It is recommended that the Window Controls pop-up window have resize
corners and that the controls redisplay to conform to the shape of the window.
This allows you to configure the window in a way that is convenient for your
workspace layout. Figure 10-4 shows three suggested configurations for the
Window Controls pop-up with resize corners.

i © window Controls R
((Open/Ciose ) (Full/Restore Size) (Back ) (Quit )
. Iz
’H{Q window Controls R ‘H@ window Controls |
(Open/Close ) (Back) (Open/Close )
(_Full/Restore Size ) ( Quit ) @
_ - (‘Back )
(quit )
- .

Figure 10-4  Three configurations of Window Controls when the window has resize
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also contain options for defining a destination printer and for printing the
screen to a file.

Properties

Properties displays the property window for all the properties you can set
for the workspace. Chapter 11 contains a complete specification for the
default contents of the Workspace Properties window.

Exit

Exit quits all elements of the workspace. Any applications running are also quit.

Customizing the Workspace Menu

in a Level 1 implementation the only part of the Workspace menu that you
can customize is the Programs submenu. All other items must be provided as
specified.

A Leve!l 2 implementation allows you to customize the Workspace menu
and its submenus. You edit the Workspace menu and its submenus from the
Workspace Properties window. See Chapter 11 for information about work-
space properties.

Base Window Menu

[n addition to standard menu elements, the Window menu, shown in
Figure 10-6, has the following elements:

O Title: Window
O ltems
o Open or Close
= Full Size or Restore Size
o Properties (with a window mark)
o Back
o Refresh
s Quit







OPEN LOOK Graphical User Interface Functional Specification

When a window size has been expanded, the item label is Restore Size.
Restore Size returns an expanded window to its originally specified size.
Closing a window to an icon does not alter the Full Size/Restore Size setting
for that window.

When Full Size or Restore Size is selected from an icon Window menu, the
icon is opened, and the window is displayed in the appropriate size and
brought to the front of the screen.

Properties

Properties displays a property window that you use to set window proper-
ties. Window properties are specified in Chapter 3. The application cannot
add other properties to this window.

Back

The Back option moves the window or icon to the back of the screen. When
the window property for Group Windows is set, pop-up windows that are
owned by a base window are also moved to the back of the screen.

Refresh

Refresh redraws the window or icon.

Quit

The Quit option quits the window or icon.

_Pop-up WindowMenu |
In addition to standard menu elements, the pop-up Window menu, shown in
Figure 10-7, has the following elements:

Title: Window

Dismic
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Apply to New Selection

When a property window has & second selection of the same kind in the
same window, use the Apply to New Selection item to apply properties to the
new selection. When there is only one selection, the Apply to New Selection
item is not displayed. See Chapters 3 and 18 for more information.

Set Default

You can change the default settings for a property window to the settings
that are displayed in the property window using the Set Default item. When
this option is not available, the Set Default item is not displayed.

Scrollbar Menu

When a pane has a vertical scrollbar, the scrollbar area has a Scrollbar
menu with the following required elements, as shown in Figure 10-10.

O Title: Scrollbar
O ltems:
o Here to Top
o Top to Here
° Previous

Scrollbar

w Here to Top |

Top to Here
Previous

e R

Figure 10-10  The minimum vertical Scrollbar menu.

When a pane has a horizontal scrollbar, the scrollbar area has a Scrollbar
menu with the following elements, as shown in Figure 10-11:

Title: Scrollbar
ltems:
Here to Left
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1 Move the pointer so that it is in the scrollbar area next to the line of text.

2 Press MENU to display the Scrollbar menu at the pointer location.

3 Choose the Here to Top item.

4 Release MENU. The Scrollbar menu is dismissed, and the view in the pane
is repositioned so that the line next to the pointer is at the top of the pane.
The position of the pointer does not change.

Top to Here/Left to Here

This item moves the first object at the top (or left) of the pane to the pointer
location. Suppose you want to move a line of text that is displayed at the top
of the pane down, so that you can see the text immediately above it. You can
do so with the following steps:

1 Move the pointer so that it is in the scrollbar area next to the place where
you want the top line to move.

2 Press MENU to display the Scrollbar menu at the pointer location.

3 Choose the Top to Here item.

4 Release MENU. The Scrollbar menu is dismissed, and the view in the pane
is repositioned so that the line of text that was at the top of the pane is now
positioned next to the pointer. The position of the pointer does not change.

Previous

This choice returns the contents of the pane to the previous scrolling
position.

Ihe pane of each scrolling list has a pop-up Scrolling List menu with a
minimum sel of required items, as shown in Figure 10-13:

litle: Scrolling List
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Locate Choice

This choice is the default item. Choosing it scrolls the current item so that it
is visible.

Edit List

Choosing it puts the scrolling list into edit mode to allow you to insert,
delete, or change items in the list.

Change

This choice is displayed on the menu when all information about an item is
visible in the scrolling list. Choosing it adds a text line and an active caret to
the selected item in the list to allow you to edit the information. This item is the
default. When there is no selection or when there are multiple selections in the
scrolling list, this item is inactive.

Properties

This choice is displayed instead of the Change item on the Scrolling List
menu when a scrolling list has additional editable information that is attached
to the items. Choosing it displays a property window that allows you to change
the properties of selected items in the scrolling list and edit additional informa-
tion that is not visible in the scrolling list itself. When there is no selection in the
scrolling list or when there are multiple selections, this item is inactive.

Insert

This menu item displays a submenu that contains the items Before and
After.

Before

his choice inserts a text field with an active caret before the first selected

m in the scrolling list. When there is no selected item, it inserts a text field at
tart of the scrolling list. You use this text field to enter new information into
crolling hist. This item is the default. When there is no selection in the

ng list, this item 1s inactive.
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Number:

Product Name: .D¥ai

Comments: | 1his product is in Beta tesr. ANl customer

have installed the product, and th
Beta Test coordinator is circulating
copies of the test rep :eports

Figure 10-15 The shaded areas show the part of the text field from which you can dis-
play the Edit menu.

The Edit menu has the following minimum required elements, as shown in
Figure 10-16:

O Title: Edit
O ltems:

o Undo

o Cut

o Copy

o Paste

o Delete

Edit

‘L;Undo )

Cut
Copy
Paste
Delete

Figure 10-16 The minimum text ficld Edit menu.

plications can add items to the minimum text field Edit menu.
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WORKSPACE PROPERTIES

Introduction

Global preferences are set from the Workspace Properties window, which
you access from the Workspace menu. In addition, each base window has a
property window that is used for setting individual window properties.

This chapter describes the minimum requirements for a basic set of
user-settable properties, specifies the required workspace properties, and
shows suggested designs and layouts for these properties. An OPEN LOOK Ul
implementation can add other user-settable properties to this minimum set
and should include options to tailor the iImplementation to specific hardware
or software. For example. if the hardware supports adjustable volume and
sound, the controls for a system “beep” could be set with a shder rather than
using an option for “on” or “off.” The figures in this chapter show a combina-
tion of Level 1. Level 2. recommended. and optional workspace properties

Some workspace praperties apply to future events and do not change the

properties of windows or icons already displayed on the workspace. For
example, changing the dataull Solor setting tor windows never changes the
background color of any windows already displayed. In an OPEN LOOK UI
implementation of any laval, the properties that apply 10 future events are set
when you cliCr ; w Apply button. The next time you display a
window, 1T us# s1lings o gatermme what properties to display.

Other proj nanging the selection color, are global ang must
be the sa! & workspace For example. you cannot set

green for ! e window and biue tor the selection color i
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another window. For global properties that affect the entire workspace, the
level of implementation determines when changes are applied.

O In a Level 1 implementation, you must click SELECT on the Apply button,
exit the workspace, and reenter it to apply global properties such as selec-
tion color or keyboard mappings.

O When a Level 2 implementation can support the immediate application of
global properties, clicking SELECT on the Apply button applies global prop-
erties to all objects currently displayed on the workspace. When a Level 2
implementation cannot support it, you must exit the workspace and reenter
it to apply global properties.

Control Area

The Workspace Properties window has the following suggested elements:

O A header with the following elements
s A Pushpin
2 The title “Workspace: Properties”
O A control area with two controls
e Category abbreviated menu button
o Factory/Custom exclusive settings
O A pane to contain the property settings
O Apply and Reset buttons centered at the bottom of the pane

The layout and design of the control area are determined by the OPEN
LOOK Ul implementation. Figure 11-1 shows the suggested elements with
Category and Settings on the same line.
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The Factory setting is the same for all levels of implementation and is used
to display the default settings for the OPEN LOOK Ul implementation as
read-only information. No controls are displayed in the pane. Since you
cannot change any of the settings, the Apply and Reset buttons are inactive.
Figure 11-2 shows the Color category with the Factory setting chosen.

. N o
B workspace: Properties
CATEGORY: Color Settings:
|
Color Sample : ‘
Palette: Fall S s =
i ( File_v) (View v ) {Edit v
Workspace: [ e i
L —— — Use this area to dynamically l
windows: [ ] preview the color of the |
selected window. {10
Selection: _ choices you make from
this property window are
T Girere _ immediately reflected here.
Colors are not applied until 1
you click on the Apply button., ||
|
S — —
. |

Figure 11-2  The Color category with factory settings.

In a Level 1 implementation, clicking SELECT on the Custom setting
redisplays the contents with the appropriate controls, using the default
settings. When the controls are displayed, you can make changes to the
settings for that category. Figure 11-3 shows the Color category with the
Custom setting chosen. Changes are applied when you click SELECT on the

ply button

=
| L Workspace: Properties
CATEGORY Z] Color Settings: | Factory
—_ ~

ire 11-3  The Workspace Properties control area with Level 1 custom settings.
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=) Workspace: Properties
CATEGORY: color Settings:

| Color Sample
palette: [T Fall (File v) {View v ) { Edit V)

LT _ il Use this area to dynamically
windows: [@) ‘W preview the color of the

selected window. GG

selection: [T [N | choices you make from
| this property window are
| input 2rea: [©) [N {| immediately reflected here.
| Colors are not applied until
you click on the Apply button.,

‘

Figure 11-5 Color category.

Note: Black-and-white patterns are used as representations of different colors
on the palettes.

Each color control is an abbreviated menu button. Any changes made to
the color settings are immediately reflected in the Color Sample window at the
right. In this way, you can preview the choices before applying them. The area
around the Color Sample window shows the chosen workspace color.

The changes displayed in the Color Sample area are not applied until you
click SELECT on the Apply button.
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. Workspace: Propertiesj)
CATEGORY: (J) Color /

Palette: Fall

Workspace: & =
Windows: R

Selection: ‘ ,::
Input Area: W

i
o

Figure 11-7 Color category, Workspace menu.

The Windows Palette Menu

The Windows palette menu is the same as the Workspace palette menu.
The color that you choose from this menu sets the default background color
for any new windows you open. You can choose a different background color
from the property window for the application. Setting a color from the property
window for the application overrides the default selection from the Workspace
Properties window. The Windows color that you choose does not affect the
background color of windows already displayed. It applies to any new
windows you open after you click SELECT on the Apply button. Some OPEN
LOOK Ul implementations may require you to quit the workspace and reenter it
before this property is applied.

The Selection Palette Menu

Figure 11-8 shows an example of the Selection menu. The color you choose
from this menu determines the color that is used for highlighting text selec-
tions. The color you choose is displayed in the highlighted text of the Color

ample window. The Selection color is a global property.
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~ The Icons Category

The Icons category settings are listed below and are shown in Figure 11-10.

O Location (Level 1)

O Border (Level 2)

O Align to Grid (Level 2)
O Grid Origin (Level 2)
O Grid Spacing (Level 2)

i ~—H Workspace: Properties N
CATEGORY: @ Icons Settings:
Location: [Top | Bottom [ Left [Right |
Border: [
Align to Grid:
Grid Origin: Top Left
Grid Spacing: 13 [=83]
& &

Figure 11-10 Icons category settings.

The Location Setting

Use the Location setting to specify the side of the screen that icons move to
when an application is started up or when a window is closed. When you use
the Top setting, the first icon is displayed at the upper left corner of the
workspace. Subsequent icons are displayed one icon width to the right of the
previous icon. When the last icon reaches the top right corner of the screen,
the next icon is moved one icon height down from the top of the screen, and a
second row is formed following the same placement pattern. This same
pattern 1s used for each of the other settings. When you use the Bottom

lting, the first icon is displayed in the lower left corner. When you use the

setting. the first icon is displayed in the upper left corner. When you use
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- The Menus Catego

The Menus category, shown in Figure 11-13, contains the following settings:

O Drag-Right Distance (Level 1)
O SELECT mouse press (optional)
O MENU mouse click (Level 2)

ra

s workspace: Properties
CATEGORY: [T Menus Settings:
Drag-Right Distance: 5, [a[¥) pixels
SELECT Mouse Press: [Displays Default | Displays Menu |
MENU Mouse Click: [Displays Stay-up Menu | Executes Default |
(Gwply)

! ]
. 7

Figure 11-13 Menus category.

The Drag-Right Distance Setting

The Drag-Right Distance setting allows you to specify how far you must
drag the pointer to the right to display a submenu. The default distance is
5 pixels. The Drag-Right Distance is a global property.

The SELECT Mouse Press Setting

The optional SELECT Mouse Press setting allows you to specify the way
button menus are displayed when you press SELECT. The SELECT Mouse
Press is a global property.




Workspace Properties

0O When you choose the Displays Default setting, pressing SELECT when the
pointer is on a menu button In a control area displays the default setting with-
in the button border as specified in Chapter 5 for Level 1 implementations.

O When you choose the Displays Menu setting, pressing SELECT when the
pointer is on a menu button In a control area displays the button menu. This
option lets you make selections and choose from menus using only one
mouse button. Choosing from a menu with SELECT works in the same way
as using MENU, as described in Chapter 15.

The MENU Mouse Click Setting

The Level 2 MENU Mouse Click setting allows you to choose how menus are
displayed when you click MENU. The MENU Mouse Click is a global property.

0 When you choose Displays Stay-up Menu, menus operate as specified for
Level 1 implementations, allowing both press-drag-release and
click-move-click operations, as described in Chapter 15

O When you choose Executes Default, clicking MENU for a pop-up menu im-
mediately executes the default choice from the menu. See Chapter 15 for
more information about using this option. When you choose this option, the
click-move-click method is disabled. Instead. clicking MENU on a menu but-
ton in the control area briefly displays the menu

The Miscellaneous Category

The Miscellaneous category, shown In Figure 11-14, Is used to define the
following settings

O System beeping (Levat 1

O Scale at Startup (Level =

O Set Input Aréa

O Scrollbar HFlacesn 3

0 Set Virl :

O SELECT Ahwayi & miciow Fotward (Level 2)

e
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=
= Workspace: Properties L‘w
CATEGORY: [T Miscellaneous Settings:
Beep: [ Always | Notices Only | Never |

Scale at Startup: Small FD‘__.' Large

Set Input Area: [ Click SELECT | Move Pointer |

Scrollbar Placement: [Left ] Right |

SELECT Always Brings
Window Forward:

r Top: 65 points
Bottom: ¢
Left: 0

] »

Right: 0
J———'—.

Set Virtual Edges:

L oy

Figure 11-14 Miscellaneous category.

The Beep Setting

Use the Beep setting to specify when you want the system to beep: Always,
for Notices Only, or Never. The Always setting does not set a continuous
peep. It permits you to hear all beeps that are generated by both the OPEN
LOOK Ul implementation and the applications displayed on the workspace.
The OPEN LOOK Ul implementation specifies that the system beeps for
important messages, when clicking SELECT on a menu button cannot execute
the default because the default is inactive and when you set the workspace
as the input area. Applications are not restricted to beeping for these
purposes, and can implement beeping to notify you of other application-

pecific functions. The Beep setting is a global property.




Workspace Properties

The Scale at Startup Slider

Use the Scale at Startup slider to specify the initial scaling size for applica-
tions when they are first started. You can use the property window that you
access from the application’s Window menu to specify scale at startup the
next time you start up the application. The Scale at Startup setting applies to
future invocations of application windows and does not affect any applica-
tions already displayed on the workspace.

Some OPEN LOOK Ul implementations may display exclusive settings for
Scale at Startup instead of using a slider.

The Set Input Area Setting

Use the Set Input Area setting to specify whether you must click SELECT to
type or simply move the pointer into the window to set the input area. Set
Input Area is a global property

When the Move Pointer option is set, the highlighting of the window header
with the input area is changed to two-point lines at the top and bottom of the
window header as specified in Chapter 3.

The Scrollbar Placement Setting

Use the Scrollbar Placement setting to specify whether vertical scrollbars
are positioned at the right or left side of the pane. Horizontal scrollbars are
always positioned below the pane The Scrollbar Placement setting is a global

property.

The SELECT Always Brings Window Forward Setting

Use the SELECT Always Brings Window Forward check box when you want
the window brought 1 ront of the screen any time you click SELECT
anywhere in the & /iu do not choose this option. chicking SELECT in a
pane to set the Ins &s not automatically bring the window to the
front of the scre irilally obscured This setting 1s a global property

0]
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The Virtual Edges Setting

Use the Virtual Edges setting to define an artificial edge to the screen.
Windows treat the virtual edge of the screen as the actual edge of the screen.
The OPEN LOOK Ul implementation must provide a way for a specific class of
applications to display in the area between the virtual edge and the physical
edge of the screen. Icons can be moved directly beyond the virtual edge of
the screen.

Press SELECT on one of the grab handles and drag the bounding box to
define a virtual edge. Virtual edges are not mutually exclusive—they can be
set on one, two, three, or four sides of the screen. As you drag the grab
handle, the number of points between the physical edge of the screen and
the virtual edge of the screen is displayed in the readonly field to the right.

When you apply properties to set virtual edges, a 1-point line is displayed
on the workspace to show the dividing line between the workspace area and
the virtual edge or edges. Set Virtual Edges is a global property.

See Chapter 3 for more information about the virtual edge setting.

The Mouse Modifiers Category

The Mouse Modifiers category, shown in Figure 11-15, is used to change
the default mouse modifier keys.

" 47 workspace: Properties N
CATEGORY: [T Mouse Modifiers Settings:
Modifier Left Middle Right
None @) select @ adjust Menu
shift @ Adjust Adjust Menu
ctrl (©) Duplicate Adjust Set Menu Default
Meta (@} Scroll by Panning (T) Adjust Menu
Alt [@) Menu T Adjust [F} menu
Middle [T} Constrain Adjust [@ Menu
| Right @) Select Adjust @\Menu |
[
‘ select | Duplicate |
(Apply ) adjust | scroll by Panning |
Menu | Constrain ]
. None Set Menu Default |

Select Character

Figure 11-15  Mouse Modifiers category.
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The Scrollbar Pointer Jumping Setting

When the Scrollbar Pointer Jumping check box is checked, the pointer
tracks the movement of the scrolling buttons and jumps ahead of the scrollbar
elevator. When the check box is not checked, scrollbar pointer jumping is
disabled. See Chapter 7 for more information about scrollbar pointer jumping.
Scrollbar pointer jumping is a global property.

The Pop-up Pointer Jumping Setting

When the Pop-up Pointer Jumping check box is checked, the pointer jumps
to a pop-up window when it is displayed and, when appropriate, the input
area is set to that pop-up window. When the check box is not checked, the
pointer never jumps to pop-up windows. See Chapter 3 for more information
about pointer jumping. Pop-up pointer jumping is a global property.

The Mouse Acceleration Slider

Use the Mouse Acceleration slider to set the ratio between the distance the
mouse moves on the mouse pad and the distance the pointer moves on the
screen based on the speed with which you move the pointer. When you move
the mouse slowly, the pointer does not accelerate. When you move the mouse
quickly, the pointer moves a greater distance the higher the mouse accelera-
tion slider is set. Mouse Acceleration is a global property.

The Multi-Click Timeout Slider

Use the Multi-Click Timeout slider to set the maximum permitted time
between clicks—when you release the mouse button and then press it
again—for multiple clicking operations. If the time between clicks is longer
than the multi-click timeout factor, the clicks are treated as separate events,
not as a single command. Multi-click timeout is a global property.
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FiLE M ANAGER

An OPEN LOOK File Manager provides such basic functions as browsing,
copying and deleting files, and initiating programs. This chapter describes the
elements and functionality for a basic File Manager implementation. Any File
Manager implementation can provide additional functionality to augment the
basic functionality specified in this chapter. Implementations of the File Manager
that run in a network environment should provide a method with which you can
access other parts of the network as part of the File Manager functionality.

Introduction

The File Manager displays glyphs to represent directories, data files, and
applications in the file system. These glyphs can be selected and operated
on directly or indirectly within the File Manager base window. You operate on
glyphs directly by selecting. dragging, and releasing them over folders and
panes within the File Manager. You operate on glyphs indirectly by selecting
and cutting or copying them to the clipboard, and then pasting them else-
where in the file structure within the File Manager window. The File Manager
thus provides both a direct and Intultive way for you to manage your files and
maintains consistency with the familiar cut/copy/paste clipboard paradigm

When the File Manager glyphs are moved out of the File Manager and onto

the workspace, they become independent icons, providing you with a way 1o
start applications without using the Workspace menu. When supported by an
application, you caf i(3 approprate glyphs from the Flle Manager direcily
onto an applicH Iizad the file Into the application

From within ] an that provides a Browse button—i{ollowing the
recommen st ! PEN LOOK Graphical User Inferiace Application

Style Gu : ess the File Manager and browse through the
file struct 1 irs the File Manager window. Suppose that you
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want to load a document into a word processing application. When you use
the Browse button, the File Manager window automatically opens, comes to
the front of the screen, and displays the files in the appropriate folder. You
then use a control in the File Manager to load the file. The File Manager is
dismissed and returns to its previous location and state.

File Manager Functionality

This section outlines the basic functionality the File Manager must provide.
The functionality is explained later in this chapter.
A File Manager implementation has the following visual elements:

0O A required base window configuration (described in detail in the
following section)

O File Manager glyphs that represent data files, applications (executable
files), and folders (directories)

A File Manager implementation requires the following functionality:

O A way to associate each data file with its appropriate application so that the
application automatically starts when you select and open a data file
O A way to support interactions between the File Manager and other
applications
O Two ways to manipulate File Manager glyphs:
= Direct manipulation—by dragging and dropping selected glyphs onto a
folder, the File Manager pane, a separate application pane, an indepen-
dent icon, or the workspace
e Using the clipboard for cut/copy/paste operations
O The following file management operations:
o Create folder
o Create file
o Display folder contents
e Change folders
o Rename files and folders
» Delete files and folders
Change file properties
Sort (by name, size, and date)
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The glyphs for folders and data files are shown in Figure 12-1. Folders can
be closed or opened. The last folder in the path pane of the base window is
always open, indicating that the contents of that folder are displayed as
glyphs in the scrollable pane below.

The following sections describe the elements of the control area, the path
pane, and the folder pane. Later sections in this chapter contain information
about how to use the File Manager and describe additional types of glyphs.

Elements of the Control Area

The control area has the following required controls:

O File menu button
o Open
o Print
o Create Folder
o Create File

O Edit menu button
o Undo
o Select All
= Copy
o Paste
o Cut
o Delete
o File Properties

The control area can have an optional Goto button and text field.

When you use the Browse button from an application to open the File
Manager, a Load menu button (with Load File and Cancel items on the menu)
is added to the control area. The Goto button and its text field move to the
right to allow space for the Load menu button in the control area, as shown in
Figure 12-2.
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" .~ File Manager: File Properties

| Name: print.icon‘

owner: winsor

Group: staff

Size: 1997 bytes
Last Modified: Thu Sep 22 10:32:31 1988

Last Accessed: Thu Sep 22 10:33:22 1988

Type: ascii text

Permissions Read Write Execute

Oowner: v O
Group: d O
World: ¥ ad a

CApply ) ( Reset )

) ;

Figure 12-3 An example of the File Properties window.

The information shown in this File Properties window is an example that is
specific to the UNIX operating system. Implementations of the File Manager for

different operating systems show statistics appropriate to that operating system.

You use the File Properties window shown in this example to change the
Name, Owner, Group, and Permissions of the selected object. Additional
read-only information is displayed about the selected object. When you
change properties and click SELECT on the Apply button, the new properties
are applied to the selected object.

When multiple glyphs are selected, all choices are indeterminate. See
Chapter 3 for information about indeterminate properties and Chapter 4 for
information about indeterminate settings.

The Goto Button and Text Field

You can type a path into the Goto text field and click SELECT on the Goto
button to open that folder. Alternatively, you can type a file name and click
I on the Goto button to select a data file or application.

.
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Figure 12-8 Examples of folders in a folder pane.

Data Files. The File Manager default is to bind each data file glyph to the
default text editor. Any data file can be bound to a specific application. When
data files are bound to a specific application other than the default text editor,
the image area for the application’s icon design can be displayed within the
border of the standard data file glyph.

In the examples shown in Figure 12-9, the data files with a .rs suffix are
bound to a graphics editor and display an image of the Draw application
glyph within the border of the data file. Data files with a .wks suffix are bound
to a spreadsheet and display an image of a grid representing a spreadsheet
application within the border of the data file. Other files that are not bound to a
specific application are, by default, bound to the default text editor. The data
files with the suffix .doc in Figure 12-9 are bound to the default text editor and,
therefore, show no glyph within the border of the data file.
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fo_}_g File Manager: Properties B
Display Options: [ Permissions | [ Group ]
[ Links | [ Size |
[ Owner | [ Date ]
Sort By: | Name
Date
Size
Y 4

Figure 12-11 A suggested UNIX operating system File Manager Properties category.

A File Manager implementation can add other properties to this window,
such as a way for you to specify your default printer.
Each setting in this example is described in the following paragraphs.

Display Options

Any display options that you choose are displayed in the folder pane,
followed by the file name.

Sort By

You can choose the order in which the contents of the folder pane are
displayed. Sort the contents alphabetically by name; in reverse chronological
order by date, with the most recent files first; or by size with the largest files first.

This section describes binding—logically connecting data files, glyphs, and
applications to File Manager functionality. The following kinds of binding are
required elements of a File Manager implementation:

Binding a specific glyph to a data file or application so that the glyph image
played in the folder pane instead of the default File Manager glyph




File Manager

O Binding a specific application to a data file so that the application 1S auto-
matically invoked when you open the data file

These methods of binding can be used separately or together. For exam-
ple, you can bind an application to a data file without displaying a special
glyph in the border. A glyph image can be bound to a data file without binding
the application. A printer command can be specified for a data file.

Default Bindings

When no default bindings are provided, the File Manager default is to bind
all data files to the text editor.

It is recommended that a File Manager implementation provide a standard
set of default bindings in a dedicated file that is read by the File Manager
during initialization. This file should include standard system bindings for
applications (such as the console window and shell windows, and mail,
calendar, and clock applications) and data files (including standard editing
tools such as edit and draw applications). When appropriate, bindings for a
spreadsheet and data base application may also be provided. Each applica-
tion should specify a bind entry as part of the installation script.

Some operating systems have built-in file typing. When available, use file
typing to identify data files for binding. When file typing is not available, use
name patterns and/or magic numbers

A ANACE
- -

You can perform many operations in the File Manager either by using the
clipboard to cut, copy. and paste File Manager glyphs, or by directly manipu-
lating glyphs by selecting them and then dragging and dropping the glyphs
onto the destination

This section describes how 1o use the File Manager to perform the following
functions:

O Change folders
O Copy. move.
0O Use the glyphs i der pane
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Changing Folders

This section describes how to change folders in the file structure. You can
change folders in the following ways:

O Type the name of a folder in the path in the Goto text field and click SELECT
on the Goto button.

O Move to a higher level in the file system using folders in the path pane.

O Move to a lower level in the file system using folders in the folder pane.

Each of these methods is explained in the paragraphs that follow.

Using the Goto Text Field

To open any folder in the file system hierarchy, type a path name for a folder
in the Goto text field and click SELECT on the Goto button.

Using Folders in the Path Pane

You can display the contents of a folder higher up in the chain that is
displayed in the path pane by following these steps:

1 Move the pointer to the folder and click SELECT.

2 Press MENU to display the Path Commands pop-up menu.

3 Move the pointer onto the Open item and release MENU. The folder is
opened, and any folders to the right of the open folder are closed and re-
moved from the display in the pane.

To accelerate these steps, you can move the pointer to a folder and
double-click SELECT to open the folder without displaying the menu. While the
folder is being opened, the busy pointer is displayed, as shown in Figure 12-12.
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O Move the pointer to a folder in the folder pane and click SELECT. Press
MENU to display the pop-up menu for the folder pane, drag the pointer onto
the Open item, and release MENU.

O Move the pointer to a folder in the folder pane and double-click SELECT.

Using either method, the folder highlights in the same way. While the files
are opening, the pointer changes to the standard busy pointer. In the example
shown in Figure 12-14, the contents of the Chapters folder are being opened
and the busy pointer is displayed.

JJ File Manager T
(File v) (Edit ‘7) (Goto:),,
/ horme winsor
o
) -
Chapters Glossaries Status
Template balloon.rs bird.rs
L

Figure 12-14 While the folder is being opened, the busy pointer is displayed.

When you open the new folder, the older folder, winsor in this example, is
closed. The new folder, Chapters, is opened at the end of the chain in the
bath pane. The contents of the folder pane change to reflect the contents of
the Chapters folder, as shown in Figure 12-15.
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drag the pointer onto the Open item, and release MENU. All selected data
file or application glyphs are opened.

O Move the pointer to a data file or application in the folder pane and
double-click SELECT.

Once a glyph has been opened, it becomes an independent base window
with all the properties and functionality of any other base window on the
workspace. Closing the window displays the icon for the application on the
workspace. Applications determine the way windows opened from the File
Manager are displayed as icons on the workspace. See Chapter 3 for more
information about icon specifications.

For data files, an application window—determined by binding—is opened
and the data file is displayed in that application window. The Filte Manager
automatically opens the default editor application if no other application is
specified.

For applications, the application is opened. A new file is not automatically
loaded.

Copying and Moving Files
You can copy or move files within the file structure in either of two ways:

O Direct manipulation
O Using the clipboard

Direct Manipulation

Press the DUPLICATE Modifier key and SELECT to copy a glyph, or press
SELECT to drag a glyph. Drag a glyph onto a folder. Folders are the only
objects that accept move operations for all glyphs. When you move any glyph
onto a folder, you get visual feedback indicating whether or not you can add
the glyph to the folder. Release SELECT to copy or move the glyph.

When copying or moving glyphs, the File Manager implementation deter-
mines what visual feedback is displayed. For example, when a folder under a

jlyph accepts input, the folder highlights and may open to show that the
e or copy can be performed, as shown in Figure 12-16.
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JI File Manager B
(File 7 ) (Edit 7 ) (Goto: )
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L cat.rs chapter1.doc chapter2.doc jester.r |3

Figure 12-18 An example of a folder pane.

Copying a File by Direct Manipulation

Suppose that you want to put a copy of the chapteri.doc data file in the
folder named Chapters. To do this by direct manipulation, use these steps:

1 Move the pointer to the chapter1.doc glyph and press the DUPLICATE
modifier key and SELECT. The glyph highlights to show that it is selected.

2 Then move the pointer. The pointer changes to the duplicate pointer, and
you drag an outline of the glyph as you move the pointer.

3 To copy the file in the same folder, drag the glyph outline anywhere in the
folder pane where the hot spot of the pointer is not over a folder, as shown
in Figure 12-19.
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f@ File Manager T
(File v ) (Editv ) (Goto:),
/ home winsor
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chapteri.doc  chapteri.doc.copy chapter2.doc

Figure 12-20 The copy of the data file is inserted in proper sort order.

You can rename the file by displaying the File Properties command window,
typing a new name in the Name field, and clicking SELECT on the Apply button.

You can copy or move a number of files at the same time by selecting
several files (click SELECT on the first file and then click ADJUST to select
additional files) and dragging them. Outlines of the selected files drag as a
group. The position of the hot spot of the pointer determines the target
destination for the copies of the files. If the hot spot of the pointer is over a
folder that accepts input, the files are copied into that folder. If the hot spot is
anywhere else in the folder pane, the copies are put in the current folder.

Moving a File by Direct Manipulation

Now you want to move chapter1.doc.copy into the Chapters folder by direct
manipulation. The operation is exactly the same as copying except that you
do not need to press a modifier key with SELECT to initiate the move.
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Figure 12-22 The data file is moved to the new folder.

File Manager Icons on the Workspace

You can select any File Manager glyph and drag it off the File Manager
base window onto the workspace. Once you have moved a glyph outside the
borders of the File Manager base window, an operating system link is created
to the application. From the user’s perspective, the glyph becomes an
independent application icon with all the properties and functionality of any
icon on the workspace. The application specifies the appearance of the data
file icon when it is displayed on the workspace. It is recommended that the
name of the glyph be displayed inside the border of the icon when it is on the
workspace. You cannot drag any icon that is displayed on the workspace
back into the File Manager pane.

When these icons are displayed on the workspace, you open them in the
same way as you open any other icon on the workspace—by choosing Open
from the Window menu or by double-clicking SELECT on the icon.

When a data file is opened, a base window for the application that is bound to
that data file is displayed, and the data file is loaded into the application window.

When an application is opened, the base window for that application is
opened. No file 1s loaded.
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_ Interactions Between the File Manager and Applications

The File Manager interacts directly with applications in two ways:

O You can drag a data file from the File Manager and drop it onto an applica-
tion pane to load the file into the application.

O From within an application, you can open the File Manager window, browse,
load a selected file into the application, and close the File Manager window.

The OPEN LOOK Ul implementation must provide a protocol that supports

interactions between applications developed with that implementation and the
File Manager.

Loading a File by Direct Manipulation

The following example shows how to load a file into an application pane by
direct manipulation. In Figure 12-24, you have pressed SELECT and dragged

the glyph for the file romance.doc from the File Manager onto the pane of the
Edit application.

JJ File Manager T

(File w) (Edit v) (Goto: ),

/—Hhomel Edit

(File v) (viewv ) (Editv) 2

Chapters a
)
R [

at.rs chapteri.doc chapter2.doc jester.rs

| . /J__d_\,//b_\J

| ——am

Figure 12-24 Dragging a data file onto the pane of an application.
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In a Level 1 implementation, you define the mappings for keyboard functions
from the Workspace Properties window.

In a Level 2 implementation, a more sophisticated mechanism called the
virtual keyboard is provided. See “Virtual Keyboards” later in this chapter for
more information about the virtual keyboard.

The minimum acceptable keyboard for an OPEN LOOK Ul has up-down
encoded function and modifier keys—it can discriminate between pressing a
function or modifier key down and releasing it—and has the following keys:

O Shift
O Control (or equivalent modifier key)

When you use the Caps key, it changes the keyboard to Caps mode for the
whole workspace.

Accelerators provide a quick way to access functions from the keyboard
without using the mouse. Accelerator functions are mapped either to function
keys or to modified keys such as Ctrl/K so that you do not need to type more
than two keystrokes to access a function.

See "Keyboard Mapping” later in this chapter for more information.

~ Level 1 Keyboard Functions

A Level 1 implementation provides a basic required set of functions for the
keyboard and the mouse. The functions that are required for a Level 1
implementation are:

t Mouse button functions (SELECT, ADJUST, and MENU)
O Mouse modifiers

d Core functions

0 Pop-up window accelerators

d Text field navigation functions

You can reassign the default setting for all required keyboard and mouse
functions in a Level 1 implementation from the Workspace Properties
window. See “Keyboard Mapping” later in this chapter for information about
default settings.
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Table 14-2 Core functions required for a Level 1 implementation.

CcuTt Put a copy of the selected object onto a clipboard
and then delete the object from the workspace. This
key can also be used as a mouse modifier for Quick
Move operations. See Chapter 17 for more information
about quick operations.

COPY Make a copy of the selected object and put it onto a
clipboard.
PASTE Insert a copy of the data on a clipboard at the insert

point. This key can also be used as a mouse modifier
for Quick Duplicate operations.

UNDO Undoes the last operation. If the last operation is an
undo, restores the last operation. Applications may
implement multiple levels of undo functionality.

HELP Display a Help window for the object under the
pointer.
PROPERTIES Display a property window for the selected object.

Pop-up Window Accelerators

A Level 1 implementation requires two pop-up window accelerators that are
mapped to the keyboard, as described in Table 14-3. These accelerators can
be used in all pop-up windows: command windows, property windows, Help
windows, and Notices.

You change the default for the pop-up window accelerators using the
Keyboard Settings category on the Workspace Properties window.

Table 14-3 Pop-up window accelerators required for a Level 1
implementation.

DEFAULTACTION Execute the default button command and dismiss the
pop-up window.

CANCEL Dismiss the pop-up window without choosing an
action.
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Text Field Navigation

A Level 1 implementation requires two text field navigation keys that are
mapped to the keyboard, as described in Table 14-4, You change the default
for the text field navigation keys using the Keyboard Miscellaneous Functions
category on the Workspace Properties window.

Table 14-4 Text field navigation functions required for a Level 1
implementation.

NEXTFIELD Move the caret to the next input area in the pane
and select the contents of the field. When the caret
IS in the last Input area, move the caret to the first
input area

PREVFIELD Move the caret to the previous input area in the
pane and select the contents of the field. When the
caret 1s at the first input area. move the caret to the
last input area

Level 2 Functions

A Level 2 implementation provides an expanded set of functions for the
keyboard and the mouse that includes all Level 1 functionality. This expanded
set defines a minimum list of keyboard functions. Any OPEN LOOK Ul imple-
mentation or application can define and use additional functions. When
additional functions are defined. a mechanism is provided to permit you to
modify the keyboard mapping

Applications are encouraged to use the specified virtual function names
rather than hard-wired keyboard mappings as part of their application design so
that you can change' nappings from the Workspace Properties window

Keyboard equivai ravide a way to access all required functionality
from the keyboari @ useless operation. You can also assign these
mouse buttor pecitic keys on the keyboard If you assign mouse
button funct the keyboard, the functionality is available both
from the mous: from the keyboard keys. Using these mouse
button equix he functionality avalfable troim the mouse
buttons feedback are icentical ior both mouse and

Mmousel
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Mouseless Operations

A Level 2 implementation allows you to move the pointer using the arrow
keys on the keyboard, and to access mouse button functions from function
keys assigned to the SELECT, ADJUST, and MENU mouse button functions.
Table 14-5 shows the pointer movement and mouse function keys required for
a Level 2 implementation.

Table 14-5 Pointer movement and mouse functions required for a
Level 2 implementation.

POINTERUP Move the pointer up 1 pixel (repeats and accelerates).

POINTERDOWN Move the pointer down 1 pixel (repeats and
accelerates).

POINTERRIGHT Move the pointer right 1 pixel (repeats and
accelerates).

POINTERLEFT Move the pointer left 1 pixel (repeats and
accelerates).

SELECT Equivalent to SELECT on the mouse.

ADJUST Equivalent to ADJUST on the mouse.

MENU Equivalent to MENU on the mouse.

Core Functions

A Level 2 implementation requires an additional core function key that is
mapped to the keyboard. You change the default for the core functions using
the Keyboard Core Functions category on the Workspace Properties window.
The additional core function required for a Level 2 implementation is shown in
Table 14-6

Table 14-6 Core function required for a Level 2 implementation.

STOP Cancel pending operations in the window under the
pointer. Cancel modal operations in process.
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Text Caret Movement

A Level 2 implementation requires the following set of text caret movement
functions that are mapped to the keyboard You change the default for the
text caret movement functions using the Keyboard Settings category on the
Workspace Properties window. Text motions cause the text view to scroll in all
text areas if necessary to keep the insert point visible. Table 14-7 shows the
text caret motion functions required for a Level 2 implementation.

Table 14-7 Text caret movement functions required for a Level 2
implementation.

CHARFWD Move the insert point forward one character Beep
when insert point is at the last printable character of
the file

CHARBAK Move the insert point backward one character. Beep

at the start of a file

ROWDOWN Move the insert point down one row In the current
column (or to the end of the next row if column i1s past
the end of the next row).

ROWUP Move the Insert point up one row in the current
column (or to the end of the previous row if column is
past the end of the previous row)

WORDFWD Move the Insert point after the last printable character
of the next word, not including any end-of-line
character when the word is at the end of a line (or the
current word if the insert point is within a word)

WORDBAK Move the insert point betore the first character of the
previous word (or the current word it the Insert point is
athin a word)

LINESTART Maove the insert point betore the tirst character of the

:nt line. When the insert point Is already there, no

LINEEND h ert point aher the Ia&t prictable character
ne, Nt InCiuding the end-of<ine
Whien the insert pont is already there, Ro
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Table 14-7 (continued)

DOCSTART Move the insert point before the first character of the
document. When the insert point is already there, no
action.

DOCEND Move the insert point after the last printable character

of the document. When the insert point is already
there, no action.

PANESTART Move the insert point to the first row and column of the
viewing area. When the insert point is already there,
no action.

PANEEND Move the insert to the last row and column of the
viewing area. When the insert point is already there,
no action.

Text Editing Functions

A Level 2 implementation requires the following set of text editing functions
that are mapped to the keyboard. You change the default for the text editing
functions using the Keyboard Settings category on the Workspace Properties
window. Table 14-8 shows the text editing functions required for a Level 2
implementation.

Table 14-8 Text editing functions required for a Level 2
implementation.

DELCHARFWD Delete the character to the right of the insert point.

DELCHARBAK Delete the character to the left of the insert point.

DELWORDFWD Delete the word to the right of the insert point.

DELWORDBAK Delete the word to the left of the insert point.

DELLINEFWD Delete from the insert point to the end of the line.

DELLINEBAK Delete from the insert point to the beginning of the
line.

ELLINE Delete the entire current line.
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Table 14-10 Scrolling accelerators required for a Level 2

implementation.

SCROLLUP

SCROLLDOWN

SCROLLLEFT

SCROLLRIGHT

SCROLLTOP

SCROLLBOTTOM

SCROLLRIGHTEDGE

SCROLLLEFTEDGE

PAGEUP, PAGEDOWN

Scroll the view up one screen (same as moving the
pointer to the cable above the elevator of a vertical
scrollbar and clicking SELECT).

Scroll the view down one screen (same as moving the
pointer to the cable below the elevator of a vertical
scrollbar and clicking SELECT).

Scroll the view left one screen (same as moving the
pointer to the cable left of the elevator of a horizontal
scrollbar and clicking SELECT).

Scroll the view right one screen (same as moving the
pointer to the cable right of the elevator of a horizontal
scrollbar and clicking SELECT).

Scroll the view to the top of the data (same as clicking
SELECT on the top cable anchor).

Scroll the view to the bottom of the data (same as
clicking SELECT on the bottom cable anchor).

Scroll the view to the right edge of the data (same as
clicking SELECT on the right cable anchor).

Scroll the view to the left edge of the data (same as
clicking SELECT on the left cable anchar).

Page scrolling operations are defined by
application-specific accelerators. These accelerators
are usually mapped to Page Up, Page Down, Home,
and End on a keyboard.

Input Area Navigation

A Level 2 implementation requires the following input area navigation keys
that are mapped to the keyboard, as described in Table 14-11. You change
default for the input area navigation keys using the Keyboard Settings
gory on the Workspace Properties window.
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The Function Keys window is displayed centered at the bottom of the
screen. When you change the input area to a window that uses the function
keys, the Function Keys window is automatically updated to reflect the new
set of functions. If you change the input area to a window that does not use
the function keys, the Function Keys window is updated to clear the labels.

In addition to displaying the functions assigned for each application, you
can use the virtual keys in the Function Keys window to activate the functions
on the key labels. You do this by moving the pointer to any one of the keys
and clicking SELECT. When you press SELECT, the key highlights in the same
way a button in the control area highlights. When you release SELECT, the key
is activated, invoking the function on the key label.

Figure 14-2 shows an example of keys that a text formatting application
might assign to a ten-function keyboard.

1 Function Keys

HE]K)I P'l:uinl[ Bold ’[ Italic ][ Underline [OVEFStI‘ikeJl Center

{C ase

Pa
Down

Pg
up

Figure 14-2 An example of a Function Keys window for a text formatting application.

When the application has more functions than the number of function keys,
the Function Keys facility assigns the function “More” to one of the function
keys. Clicking SELECT on the More key cycles through the complete list of
functions on the remaining function keys.

Figure 14-3 shows an example of the Function Keys window for a text
formatting application with 15 functions and the last key assigned to the
More function.
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Figure 14-5 The Virtual Keyboard window.

The key names that would be displayed on the keys of the Virtual Keyboard
window are for the window with the active input area. The Virtual Keyboard
window for any OPEN LOOK Ul implementation matches exactly the configura-
tion of keys on the physical keyboard and mouse for your system.

Using the Virtual Keyboard Window

You can use the Virtual Keyboard window to customize the mapping of
OPEN LOOK Ul function keys, accelerators, core operations, and mouse
functionality. You do this by editing the contents of each key individually from
a property window or by manipulating existing key names by selecting them
and dragging them to a new location. You can save customized mappings in
files that can be stored and reloaded on your own system or another system
to provide portability for your customized mappings.

You can display all or part of the keyboard, as you choose, by selecting
items from the View button menu in the control area.

The function keys interactively display the functions that are appropriate
for the active input area. For example, if you are using a graphics application
that has specific functions bound to the function keys at the top of the
keyboard, displaying the Virtual Keyboard window shows you how the
function keys are mapped.

One use for the Virtual Keyboard window is to customize your mouse and
keyboard for right- or left-handed use.
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Multiple Language Support

When an implementation provides support for multiple languages, the OPEN
LOOK Ul implementation provides a LANGUAGE function key. When you press
and hold the LANGUAGE key. a Character Sets pop-up window Is displayed
showing keys that correspond to the top row of function keys Labels on those
function keys correspond to different language capabilities. In the example
shown in Figure 14-6, the keys are labeled Help, ASCII, Office, Math, Logic,
Greek, 1SO, Show, Set, and More, and correspond to F1 through F10 on the
physical keyboard.

o=l Character Sets

o e o o | o ol

HelIHﬁSCII

Figure 14-6 The Character Sets window.

The keys Show, Set, and More are always displayed. The remaining keys
display the available keyboard maps by name

Pressing the More key changes the names of the keycaps in the window to
cycle through all available keymaps. Pressing Show opens the Virtual
Keyboard window displaying the entire keyboard with the corresponding
keymaps. You can type directly on the physical keyboard to access those
symbols, or click SELECT o the image on the screen to type a character

While you hold down the Language key, the chosen language is bound to
the keyboard. In this way. you can easily access a few characters or symbols

from another language or altérmate character set interactively, and then return
to typing on your usugi alohaniumeric configuration. For example, 1o type a
few Greek charagters in English text, hold down the Language key, press the
Greek key. and then Typs & characters When you release the Language
key, the Character Set w IS Clisrmissed and the primary character set is
restored to E

Typing Set et thayt o5 heghiighied 0 be tha prnmary characier set

When you refe w2 vy thes Uharacter Sal wingiow = dismissed
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For example, to change the keyboard character set from English to Greek,
hold down the Language key, press the Greek key, and then press the Set
key. When you release the Language key, the Character Sets window is
dismissed and the primary character set is Greek. Any alphabetic key you
press on the keyboard types the corresponding Greek character at the active
text insert point.

If you do not press the Set key, the primary character set is restored when
the Language key is released.

If you do not know which keys correspond to the characters for the
language you have selected, hold down the Language key and press the
Show key. The Virtual Keyboard window is displayed or updated with the
appropriate labels on the keycaps. This window remains on the screen when
you release the Language key, and it can be closed to an icon or dismissed
separately.

This specification describes the mapping of keyboard functions in terms of
a “reference” keyboard layout. The OPEN LOOK Ul specifies a number of
functions that are bound to specific keys on any individual keyboard. The
reference keyboard, shown in Figure 14-7, is not intended to suggest that this
is an ideal keyboard design. It simply contains enough modifier and function
keys to assign each required Level 1 and Level 2 function to an individual key.

Left keypad Function keys Right keypad

Alphanumeric
keys

Modifier keys

Figure 14-7  The reterence keyboard layout.
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Any keyboard meeting the minimum requirements can use combinations
of keys to provide the functionality, as described briefly in the paragraphs
that follow

When your keyboard has up-down encoded alphanumeric keys, you can
access additional modifiers by pressing Control with an alphanumeric
character. For example, if your keyboard lacks a “Meta” key. you can assign
an alphanumeric key to that function—the “M" key would provide a good
mnemonic. When you press this assigned key with Control (Ctrl/M) it works as
if you had pressed Meta. Ctrl/M, Ctrl/X would then generate a Meta/X
command. You can release the M key, and as long as Control is pressed, it
acts as the Meta modifier.

When your keyboard does not have a left keypad, you can assign the
functions to single modified alphanumeric keys such as Ctrl/X or Ctrl/S. It is
suggested that, for ease of use, you keep these functions on the opposite
side of the keyboard from the mouse.

Although any keyboard has a limited number of function keys. you can
“create” additional function keys in a Level 2 implementation by using the soft
function key facility and assigning one of the existing function keys to More.
When you press a designated modifier for FKEYS (for example, Ctrl/F), a
window is displayed that shows the currently assigned functions for the
function keys. Pressing More cycles through a set of assigned functions. When
the names of the keys change on the screen. the function listed on the display
can be accessed by pressing the corresponding key on the keyboard Refer
back to “Soft Function Keys" in earlier this chapter for more information

If your keyboard does not have any function keys, pressing this FKEY modifier
can change the top row of numeric keys to correspond to the display shown on
the screen. For example, after you press Cirl/F and while you hold down Ctrl, 1
corresponds to F1. 8 corresponds to F8, and = corresponds to F12. Additional
functions may be also be assigned to modified alphanumeric keys

For any given keyboard a combination of these methods provides the
functionality specified for the OPEN LOOK UL See “Level 1 Keyboard Func-

tions,” “Level 2 Funciions, and Sample Reyboard Maps”™ earlier in this
chapter for more informanos
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Sample Keyboard Maps

This section provides sample mouse and keyboard function default
mapping assignments. Not all of the modified mouse functions need to be
mapped initially. In fact, when hardware limitations exist, it may not be
possible to assign all of the modifiers simultaneously. Table 14-12 shows
suggested default mappings for mouse functions.

Table 14-12 Suggested default mappings for Level 1 mouse functions.

Mouse buttons Three Two One

SELECT Left Left Left

ADJUST Middle Shift/Left Shift/Left
MENU Right Right Ctrl/Left
DUPLICATE Ctrl/Left Ctrl/Left Alt/Left
CONSTRAIN

SETMENUDEFAULT Ctrl/Right Ctrl/Right Shift/Ctrl/Left

Table 14-13 shows suggested default mappings for the optimum condition
in which the keyboard contains labeled keys for all required functions.
Suggested mappings for the Sun4 and PC-style keyboards are also included
in this table.

Some keyboards have both an Enter and a Return key. The OPEN LOOK Ul
implementation determines whether the keyboard hardware makes a distinc-
tion between these two keys. When the Enter and Return keys use different
scan codes, the implementation can choose whether to make a functional
distinction between these keys or to define them as equivalent.
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Multi-Click Selecting

You can use multiple clicking on mouse buttons or their equivalents as a
quick way (an accelerator) to perform some specific functions. For example,
double-clicking SELECT on an icon is an accelerator for Open. Double-clicking
SELECT on a window header is an accelerator for Full Size. See Chapter 17 for
information about multi-click selecting.

You can set the maximum length of time permitted for multi-click operations
(the multi-click timeout factor) from the Workspace Properties window. The
multi-click timeout measures the amount of time that elapses between the
release and press of the mouse button.

Mouse Button Actions

Selecting objects in an OPEN LOOK Ul implementation occurs on the down
stroke of a mouse button or its equivalent, and other selections are cleared.

When the pointer is moved beyond the damping factor, the current selec-
tion is maintained. When the pointer is not moved beyond the damping factor,
other selections are cleared when you release SELECT.

Initiation of an action (such as invoking a menu, setting the insert point, and
executing a command on a button or menu item) occurs on the up stroke of a
mouse button or its equivalent.
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A Level 2 implementation has an option that you can set to activate the
default setting of pop-up menus without moving the pointer. This option is
explained in detail under “Using Pop-up Menus" later in this chapter. When
this option is set, click-move-click functionality for menus is not available.

Click-Move-Click

Click-move-click displays a menu so that it stays on the screen. You do not
need to keep pressing the MENU button. You can click MENU on a menu
button to display a button menu. When you click on a control to activate it, the
action is performed and the menu group is dismissed. Click MENU off a
control to display a pop-up menu. Click-moveclick works as follows:

1 Click MENU. The menu appropriate for the pointer location is displayed on
the screen and stays up.

2 Move the pointer to the control you want to choose. The controls on the
stay-up menu work the same as controls in a control area. There is no
visual feedback as you move the pointer across the controls, unless you
press the mouse button.

3 When the pointer is on the control you want, click SELECT or MENU to
choose it. When you click on the control, the visual feedback appropriate
for that control is displayed: Items highlight, and settings show a 2-point
border. Clicking SELECT or MENU on a menu item displays the submenu.
The originating menu item displays the standard busy pattern, and does
not accept further input.

When you click SELECT or MENU anywhere off the active area of the menu
controls, the menu group is dismissed from the screen.

These selection mechanisms are described more completely later in this
chapter.




s

Usin-g Menus

Using Menu Buttons

This section describes how you use menu buttons from a control area to display
button menus using the press-drag-release and the click-move-chick method.

Viewing Button Menus With Press-Drag-Release

When menu buttons are displayed in a control area, you view the contents
of a button menu by pressing MENU. The button highlights, and the menu Is
displayed. The default control has a 1-point default ring around it. The pointer
never jumps onto the menu Drag the pointer onto the menu, moving the
pointer from control to control, as explained in Chapter 5. When a control 1s
highlighted or the pointer is on the pushpin, the default ring is not displayed

When a menu has a pushpin, dragging the pointer onto the pushpin pops it
into the hole. Moving the pointer off the pushpin pops it out of the hole.

When a menu has exclusive settings, the default setting displays the default
when the pointer is not in the menu. When the pointer is on the menu, the
current setting is displayed. and no default is shown.

When a menu has nonexclusive settings. the nonexclusive settings
accurately reflect the state of the object If a setting is “on” for the selection,
the setting has a bold border. If the setting is “off" for the selection, the setting
has a one-point border. The setting that 1s under the pointer 1s the only one
that toggles to show a change of state

Drag the pointer onto a control in the menu and release MENU to make a
choice. When the pointer moves onto the menu, the originating menu button
in the control area is nighlighted. Drag the pointer off the menu and release
the MENU button when no selection Is desired.

When a menu has items. each menu item—an item that i1s folliowed by a
menu mark—has a submernu attached to it and has an active region that
always displays a subn whether or not you drag the pointer to the nght
The submenu regic v In Figure 15-1
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The submenu is displayed with the default control aligned with the originat-
ing menu item and the left side of the menu aligned one point to the right of
the default ring. You can move the pointer anywhere on the workspace, and
the menu group remains displayed on the screen. All menu controls except
the busy controls are active, not just the controls on the submenu. If you
decide you want to choose a control from the menu rather than the submenu,
simply move the pointer to a control and click SELECT or MENU. The control is
activated and the menu group is dismissed.

To display another submenu and dismiss the first submenu without
choosing a control, move the pointer to a different menu item, as shown in
Figure 15-7.

(£t 7)
1R 2
Cut *
Copy g
Paste R ini] g
Undo = ]
{_Regions 51| ')
Text
&=
i)
2

Figure 15-7 To display a different submenu, move the pointer to a different
menu item.

Then click MENU. The submenu for that menu item is displayed. In the
example shown in Figure 15-8, the Regions submenu is dismissed and the
Text submenu is displayed.
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Figure 159 When a pop-up menu is displayed, the pointer does not move.

The pointer is positioned slightly off the default item to prevent you from
inadvertently choosing an item from the pop-up menu. You must move the
pointer a short distance to the right and release MENU to choose the default.
In this example, moving the pointer onto the Create item by dragging the
pointer to the right displays the Create submenu.

You make other choices from pop-up menus exactly the same way as you
do from button menus: Move the pointer to a different control and release
MENU to make a choice. Move the pointer off the menu and release MENU to
dismiss the menu without making a choice.

As with button menus, moving the pointer to the right on a menu item displays
the submenu, as shown in Figure 15-10. The pointer remains at the same
location, and the submenu is positioned as appropriate for the pointer location.
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Figure 15-11 When the Executes Default option is set, the pointer is positioned on the
default item.

In this example, releasing MENU while the Create menu item is highlighted
executes the default item on the Create submenu and dismisses the pop-up
menu.

Viewing and Choosing from Pop-up Stay-up Menus

When you click MENU on any area of the screen that is not a menu control,
the appropriate pop-up menu is displayed and remains on the screen until
you choose an action or dismiss the menu. As with normal pop-up menu
displays, the pointer is positioned a few points to the left of the default item.

In all other respects, choosing from a pop-up menu in stay-up mode is the
same as choosing from a button menu in stayup mode.

This section describes how you pin a menu. When a menu has a pushpin,

you choose it by moving the pointer to a menu button and pressing MENU, as
shown in Figure 15-12.
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Figure 15-14 A menu that is pinned is a pop-up window.

The highlighting is removed from the originating menu button, and the
menu becomes a pop-up command window with all the attributes and
functionality of a command window:

O Title
O Pushpin
O Pop-up Window menu

If you do not want to pin the menu to the workspace, with MENU pressed,
move the pointer off the pushpin and it pops out again.

When a menu is pinned, the name of the originating control becomes the
title of the pop-up window that is displayed. For example, the pinned pop-up
window shown in Figure 15-14 originated from the Edit menu button.

The first time you pin a menu, the upper left corner is anchored at the upper
left corner of the menu it replaces. When the pinned menu is moved, it
remembers its new location. If you dismiss the pinned menu and pin it again,
the position of the pinned menu is determined by its location the last time it
was displayed.

The size of the pinned menu may not be the same as the size of the
unpinned menu, since the pop-up window must be large enough to permit the
title of the control to fit completely in the header, regardless of the scale
setting of the window. The guideline for menu titles is the same as for pop-up

indows: When there is enough room, the title is preceded by the name of the

ipplication followed by a colon.

——
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Using Menus

As a general rule, items on a pinned menu retain the same orientation as
the items on the originating menu. When items are displayed vertically, there
may not be room in the header to display the name of the application as well
as the menu name. In such a case, the name of the application i1s dropped
from the header, as shown in Figure 15-14

When a menu is already pinned and you display the menu again, the
pushpin is dimmed, as shown in Figure 15-15, so that you cannot pin the
menu a second time. The contents of the pinned menu window are not
updated to match the contents of the menu. For example, if a menu window
displays an item that is not dimmed, and that item is dimmed on the transient
menu, the button in the menu window need not dim

(View 7) !Sn! Find v)
“And here’s a piece ¥ ing ... Ugh. It is so z
disgusting,” said Djx»_cm ) fhat is this awful curse -
that prevents us fr¢ Copy [<e normal folks?” ;
I Paste
“We must be brave| Again them Kknow how
frightened we really Undo | © edit
. (Cut )
Copy
Paste
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Figure 15-15 Displaying a button menu when the menu is already pinned.

Changing Menu Defaults

This section tells you haw to change the detfault settings on menus. You can
change a menu default at any time Dy using a SETMENUDEFAULT modifier key
in conjunction with KMkl fe option to specity the SETMENUDEFAULT
modifier key is set ! JWorkspace Properties window and is described in
Chapter 11

You can pre tha SETMENUDEFAULT modifier key to display the
default contr Foup either before or after pressing MENU to
display a raqQ the poirtter over the manu, the visual
feedbact ¢ Of Nt you have pressed the modiher key. If
you h ner. the leadback is the normal teedback for




OPEN LOOK Graphical User Interface Functional Specification

the control. If you have pressed the SETMENUDEFAULT modifier, controls do
not show the normal feedback. Instead, the default ring is displayed and
follows the pointer as it moves from item to item within the menu. When you
drag the pointer to the right on a menu item when the SETMENUDEFAULT
modifier is pressed, the submenu is not displayed.

When a menu group is displayed, the pointer is not on a menu, and you
press the SETMENUDEFAULT modifier, the default controls for that menu group
are displayed.

When the SETMENUDEFAULT key and the MENU button are both pressed,
you set the default in one of two ways:

O By releasing MENU (which sets the default and removes the menu from the
screen) and then releasing the SETMENUDEFAULT modifier key

O By releasing the SETMENUDEFAULT modifier key (which sets the default) and
then releasing MENU (which invokes an action or dismisses the menu)

By using the second way of setting the default, you can change the default
and use an item in a single step.

Figures 15-16 through 15-20 show how you can change a menu default for
a submenu without choosing the item from the menu. Press MENU on a menu
button in a control area. The menu is displayed and shows the default setting.
The default setting for the Edit menu is Cut, as shown in Figure 15-16.

{_Edit 7]
Y X
(Cut____}

Copy

Paste
Undo

Regions
Text [

Figure 15-16  To change a default setting on a submenu, first display the menu.

Drag the pointer to the Regions item and then right to display the submenu,
wown in Figure 15-17.
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You can press MENU and the modifier key in any combination and at any
time. The highlighted item under the pointer gives you visual feedback that
the command will be executed when you release MENU.

You set defaults on menus with exclusive or nonexclusive settings in the
same way.

~ Menu Placement

This section describes the specifications for the placement of submenus
and pop-up menus. See Chapter 6 for a description of menu button menu
placement.

Submenu Placement

When you are viewing submenus, the default item is always aligned
horizontally with the originating menu item. The vertical positioning of the
submenu depends on the location of the pointer when you drag the pointer
past the drag-right distance.

Leftmost Submenu Placement

Once the drag-right distance is reached, the submenu is displayed, with
the submenu positioned under the pointer as appropriate.

For example, if you press MENU and drag the pointer into the menu item
from the left, the submenu is displayed when the pointer moves beyond the
drag-right distance set in the Workspace Properties window, as shown in
Figure 15-26. The default drag-right distance is 5 points. This is the leftmost
position for any submenu using press-drag-release.
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left side of the highlighting for submenus, and to the right of the default ring
for pop-up menus. Figure 15-28 shows a pop-up menu group with the normal
submenu alignment on the left, and the adjusted placement for the same
menu when it is at the right side of the screen. The drop shadow never moves
off the screen.

—— Screen
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Figure 15-28 Submenu alignment on the right border of the screen.

Figure 15-29 shows a pop-up menu group with the normal menu alignment
on the left, and the adjusted placement for the same menu when it is at the
bottom of the screen. The pointer moves up and to the left so that it is
positioned on the left side of the highlighting for the submenu and to the left of
the default ring for pop-up menus.
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5-29 Submenu alignment at the bottom of the screen.
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You can select a window or windows and manipulate them directly (for
example, by pressing SELECT and dragging). In addition, you can select
multiple windows and/or icons and operate on them by using controls from
the Window Controls pop-up that you access from the Workspace menu. See
Chapter 10 for more information about the Window Controls pop-up.

Selecting a Window

You select a window by clicking SELECT anywhere in the window back-
ground. The window is brought to the front of the screen and the border
thickens, as shown in Figure 16-3.
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Figure 16-3 A selected window that overlaps an unselected window.
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Figure 16-5 To select a window, move the pointer onto the window background and
click SELECT.

2 To add another icon or window to the selected group, move the pointer
onto an icon or onto the background of a window and click ADJUST. In
Figure 16-6, the Mail icon is added to the selection.
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Figure 16-6  To add an icon to the selected group, move the pointer onto the icon and
click ADJUST.

add another window or icon to the selected group, repeat this proce-
fure. In Figure 16-7, moving the pointer to the Edit window and clicking
e Edit window to the selected group.

o8]







OPEN LOOK Graphical User Interface Functional Specification

=

1=

(& Edit
(File 7) (View 7) (Edit v) (Find |
] shell | A =) Draw ]
;[Gskasﬂe{m'nsor}zﬁ‘ (Line) (Rectangle) (Circle) (FilD)
|
| b,

w|

=4
="
CONSOLE

_man

h

Figure 16-8 Press SELECT and drag the pointer to define a bounding box.

3 Release SELECT. The objects within the bounding box are selected. In
Figure 16-9, the Edit and Draw windows and the Console and Mail icons

are selected.
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Figure 16-9 Release SELECT to select the objects within the bounding box.
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Figure 16-11 Click SELECT on a Window Controls button to operate on selected
windows and icons.

You can leave the Window Controls pop-up displayed so that it is available
for other operations, or dismiss it by clicking SELECT on the pushpin.

Double-Click Selecting

Double-clicking SELECT is used as an accelerator—a shortcut way to
perform an operation without displaying a menu—in the following ways:

0 Double-clicking SELECT in the header of a base window is an accelerator to
expand a window to full size or restore it to its previous size.
O Double-clicking SELECT on an icon opens it.

ving Windows and lcons

You can move selected windows and icons one at a time or in groups by
dragging SELECT on a selected object, as shown in the following examples.
The OPEN LOOK Ul implementation determines whether border boxes that
epresent the outline of selected objects are displayed or whether the object

s dragged directly
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the 5-pixel damping factor, the current text or graphics selection is maintained
and is not cleared. When you release SELECT without moving the pointer, the
window or icon at the pointer location is selected and any other selection is
cleared as usual.

Moving a window with an active insert area does not change the insert
point. Releasing SELECT moves the objects to the new location. The objects
remain selected.

Constrained Moving of Windows and Icons

When you move objects by dragging, the movement is unconstrained—you
can move the object in any direction. There are times when it is useful to
move an object either along the x or the y coordinate of the screen to keep it
positioned horizontally or vertically relative to some other object displayed on
the workspace.

You can constrain any dragging operation by pressing the CONSTRAIN
modifier key before, during, or after pressing SELECT to initiate the drag. You
set the constrain modifier key from the Workspace Properties window. When
you press the CONSTRAIN modifier, the movement is constrained to the
direction in which you are dragging the pointer. If you release and then press
the CONSTRAIN modifier during a single drag, you can change the direction.

Moving Windows and Icons Off the Screen

You can move part of a selected window or icon off the screen, but you can
never move a window or icon completely off the screen. It is suggested that
OPEN LOOK Ul implementations bump the side of the window against the side
of the screen before it can move off the screen. This makes it easy for you to
position a window at the side of the screen. When you move the window past
a threshold distance, say 10 pixels, the side of the window is moved off the
side of the screen.

The minimum amount of a window or icon that must be displayed at the
edge of the screen is a strip equal to the width of a resize corner, as shown in
Figure 16-13. This strip allows you to select and manipulate the object,

fragging it back onto the workspace by the visible portion. When you move
part of a selected window or icon off the screen in any direction, the pointer
ps when the minimum amount of the object is reached, and you cannot
any farther off the screen.
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Figure 16-14 To resize a window, move the pointer to one of the resize corners and
press SELECT.

2 Drag the pointer to a new location. A border box is displayed to show the
dimensions of the new window. Note that the resize corner remains high-
lighted at the original location, as shown in Figure 16-15. It is not dragged
with the pointer.
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Figure 16-15 Drag the pointer to adjust the area of the window.

3 Release SELECT. The window is redisplayed in its new size, as shown in
Figure 16-16. The contents of the pane are anchored at the upper left
rner, regardless of which resize corner you use. Note that more of the
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2 Drag the pointer to change the area of the window. In the example shown
in Figure 16-18, you drag the pointer upward and to the left.
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Figure 16-18 Drag the pointer to resize the window.

3 Release SELECT. The area of the window is adjusted. Note that the text in the
example shown in Figure 16-19 is redisplayed to conform to the size of the
new pane. This happens when it is specified by the application. The applica-

tion did not specify that the buttons in the control area should be repositioned.
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igure 16-19  Release SELECT to readjust the area of the resized window.




Selecting and Operating on Windows, Icons, and Panes

When you resize an application with more than one pane, the application
determines how to allocate the area of the panes to adjust to the resizing
keeping all panes visible when possible.

Selecting Panes

You can select a pane when the application developer has specified that an
operation such as setting properties, resizing, or deleting can be performed
on it. See Chapter 3 for a description of panes.

Normally, panes have a 1-point border. When you select a pane, the border
thickens 1 additional point. The width of the active area at the border is
determined by the OPEN LOOK Ul implementation and the application. To help
you position the pointer correctly, when the pointer is on the border of a
selectable pane, the target pointer is displayed. When the target pointer is
displayed, select the pane Dy clicking SELECT. The border thickens, as shown
in Figure 16-20.
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Figure 16-20 A selected pane.

You can select addiiional panes within the same window by clicking
ADJUST on the border. You cannot select a pane in one application and then

click ADJUST to sel pane In a different application window. If you click
ADJUST on a pang i fiffarant application window, the first pane 1s
deselected, and the parne under the pointer Is selected

You can apply ¢ specifiad by the applicaiion to that pane. As ar
example, supt liting application has a praperty setting for word
wrapping i ine. display the proparty window. set Word Wrap
and clic iy button to apply the seting 1o the entire

docun i 15 wisibie in he pane
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" Resizing Split Panes

When a window has more than one pane, or when panes have been split,
the selected pane displays resize handles that you can use to adjust the total
area of the pane. See Chapter 7 for information about using the cable
anchors to split a pane. When you select a pane that can be resized, it
displays resize handles on the sides of the pane that can be adjusted, as
shown in Figure 16-21.

Draw

Resize handle

Figure 16-21 A selected pane with a resize handle.

Press SELECT on the resize handle, and drag it toward the center of the
pane to reduce the area of the pane; drag it away from the center of the pane
to increase the area of the pane. The adjacent pane automatically expands or
contracts in relationship to the changes in the resized pane.

The contents of a split pane are always anchored at the upper left corner of
the originating pane, and the view of the data is expanded or contracted from
that anchored point. The minimum size of a split pane is the length of the
minimum scrollbar, as described in Chapter 7. You cannot use the resize
handle to remove a split pane. See Chapter 7 for information about how to
remove a split pane.
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Draw
(tine) (Rectangle) (Circle)

=

You can remove a split pane using the Join Views item on the Scrollbar
menu. See Chapter 7 for information about using the Scrollbar menu to
remove a split pane. You can also remove a split pane by selecting it and
pressing and releasing the Delete key on the keyboard, or choosing a delete
function from the application menu, if one is provided.

You can remove multiple splits in the same window by selecting several
panes and deleting them. You ordinarily cannot delete a primary pane from an
application (however, some applications may permit you to). When selecting

ind deleting multiple split panes, the panes rearrange according to their
tionship when they were created.
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=
JJ Draw

(Line) (Rectangle) (Circle) (“Patterns v)

Figure 16-31 How the panes in Figure 16-30 look after two panes are deleted.

When there is more than one way for the panes to fill in the space left by a
deleted split, the OPEN LOOK Ul implementation specifies a rule, such as
“Always fill from the left and from the top” or some other rule, that the toolkit
can implement. The panes shown in Figure 16-32 are three split views of the
same pane. If you select and delete the middle pane, 1 double-prime, the
pane to either the right or the left could fill in the vacant space, as determined
by the implementation.
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Table 17-1 Selecting text and graphics.
TEXT GRAPHICS
Action Off Selection On Selection Off Object On Object
Click Insert point is set When SELECT is All selections are Object at pointer
SEBECT at the pointer released, insert cleared. location is se-
location. point is set at lected. Any other
pointer location objects are
and selection is deselected.
cleared
Drag Text is highlighted ~ Text move pointer  Traces a bound- A bounding box
SEEECT as pointer is is displayed. ing box. All defining the
dragged (wipe- When you release  objects falling shape of each
through SELECT, text is entirely within the object is dis-
selection). moved to pointer box are selected. played, and the
location if that The pointer must group of bound-
location is outside  begin outside the  ing boxes moves
the highlighted objects to be with the pointer
area. selected. as you drag
objects.
Click Extends the Moves the end of  No operation. Toggles the state
iy highlighting to the  the highlighting to of the object
pointer location the pointer under the pointer,
either extending location. Begin- selecting if not
the beginning or ning of selection selected or
the end of the is preserved. deselecting if !
current. selected.
Drag Adjusts an Adjust an existing  Traces a bound- Toggles the state
e existing selection selection as ing box. All of the object
as the pointer is pointer is objects falling under the pointer,

dragged (wipe-

through). Begin-

ning of selection
anchored at

ert point
ert Ppo

dragged (wipe-
through). Begin-
ning of selection
is anchored at
nsert point.

entirely within the
box are toggled.

selecting if not
selected or
deselecting if
selected.
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you are dragging the pointer. You can move the pointer either forward or
backward in the text.

Edit
(File 7 ) (View v ) (Editw ) (Find v )

blackness that was following me,"

— .D

“We must be brave, and not let them know how
frightened we really are,"

dizgusting," said Dozolina, “What is th1 auful |
curze that prevents us from being like normal folks?" é
=
1

i

Figure 17-2 Drag the pointer to highlight selected text.

3 When the text you want to select is highlighted, release SELECT. The insert
point is set at the end of the highlighted text (to the right of the highlighting
if you drag the pointer forward, to the left if you drag backward), as shown

in Figure 17-3.

Edit
(file 7)) (view v ) (Editv ) (Find v)
‘blaanez: that waz_FollDl-lmg e, " :'
It is so |
disgusting," :1j Ilﬁ nlmc Uha*r is thlxamFul
curse that prevents us from being like normal folks?"
‘e must be brave, and not let them know how
frightened we really are."
= = =
el

Figure 17-3  Release SELECT to end the selection.
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When you make a wipe-through selection, the highlighting is anchored at
the insert point. When you drag the pointer to the right and downward, the
insert point marks the beginning of the selection. When you drag the pointer
1o the left and upward, the insert point marks the end of the selection.

You can make a wipe-through selection in the same way with ADJUST when
the caret is inactive and the first mouse button you use in the text pane is
ADJUST. Under those circumstances, making a wipe-through selection with
ADJUST is the same as using SELECT.

When the caret is active, pressing ADJUST extends the selection 1o the
pointer location. You can drag the pointer to adjust the highlighting and
release ADJUST to complete the selection

Selecting Text with SELECT/ADJUST

You can also select text by clicking SELECT to mark the beginning, and then
clicking ADJUST to mark the end of the text that you want to select When the
caret is inactive, you can begin your selection by clicking ADJUST. Otherwise
the ADJUST click extends or reduces the selection. This type of selection is
shown in the following steps and examples:

1 Move the pointer to the beginning of the text you want to select and click
SELECT. The header of the window highlights and the insert point is set at
the pointer location, as shown in Figure 17-4

File v ) ((View ¢ ) Fditv ) (Find w)

N

blackness that was folluwiry me. ]

&d heres"s
diegustlr

curse that prevent

3 piece of -’ 4 ... UG, L I

this awful
be1tig like normal felhs

"We must be bra
frightened

:[ﬂ ]

A -

[:igurt‘ 17-4 the beginning of a text s tion
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2 Move the pointer either forward or backward to the end of the text you
want to select and click ADJUST. The text between the insert point and the
pointer is highlighted. The active caret is displayed at the end of the
selected text, as shown in Figure 17-5.

7 Edit
(File v ) ((wiew v ) (Editv ) (Find 7 )

‘blackness that was following me,"”

=
(]
]

"And here’s a piece of something ... Lgh. ESAEERES)
disgusting,” zaid Dozolina, “What 1= th13k@wfu1
curze that prevents us from being like normal folks?" @
i
—
45

"le must be brave, and not let them know how
frightened we really are,”
{

ik

Figure 17-5 Click ADJUST to mark the end of the text selection.

Adjusting a Text Selection

To change (adjust) the end of the highlighting, move the pointer to a
different place in the text, either on or off the highlighting, and click ADJUST.
The active caret moves to the location of the ADJUST click.

When you click ADJUST off the highlighting, the selection is expanded in the
appropriate direction. For example, clicking after the selection extends the
end of the selection, and clicking before the selection extends the beginning
of the selection.

When you click ADJUST on the current highlighting, the end of the selection
is adjusted to the pointer location, maintaining the beginning of the selection.

When you click SELECT with the pointer on the current highlighting, the
selection is cleared when you release SELECT without moving the pointer. If
you move the pointer beyond the damping factor, the selection is moved by
dragging and is not cleared.







OPEN LOOK Graphical User Interface Functional Specification

Click SELECT to select a single object...

Press Release
& seLect SELECT
Drag SELECT to select a group of objects... I
Drag Release
SELECT SELECT

AN

Release
Q\ ADJUST

Drag ADJUST to toggle the state of a group of objects...

x
) E Drag I Release
& aojust ) ADJUST e

Figure 17-6  Selecting graphic objects.

. Y . y :
1) EYERLERANN .

“Multi-click SELECT" in text or graphics means “select the next larger unit" in
any application that has a hierarchical structure.

When selecting text, multi-clicking SELECT selects a unit at successive
syntactic levels, but does not include any terminating end-of-line character.
For example, double-clicking selects a word, triple-clicking selects a sen-
tence or a line, and quadruple-clicking selects a paragraph or the entire
document. When you use multi-clicking to select text, the active caret is
positioned at the end of the highlighting.
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Copying from this window...

to this window

" &) Edit

Edit

(File v) (vView v) (Edit v)

How now brown cow

i

| 0—eon |

(File ) (View v) (Edit V)

The quick fox jumped
over the 1%y dog.

i

Figure 17-8 Set the insert point where you want to insert the text.

4 Press and release the Paste key. The text is copied at the caret location, as

shown in Figure 17-9. The caret is repositioned at the end of the inserted
text, as it is when text is typed directly at the insert point.

Copying from this window...

to this window

") Edit

1

(7] Edit

(File v) (View 7) (Edit 7)

How nOW//,/bI'OWn cow

L

| 0—GImo

(File 7) (View v) (Edit ¥)

The quick brown fox jumped
over the 1% dog.

L

| =L

Figure 17-9

Copying Text by Dragging

You copy text by first selecting text and then using the DUPLICATE modifier
key with SELECT to initiate dragging the text. The default DUPLICATE modifier
s the Shift key. You can change the DUPLICATE modifier key from the Work-

D

Properties window.

Press and release the Paste key to copy the text to the caret location.
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Selecting and Operating on Text and Graphics

Quick Duplicate

A Level 2 implementation provides a Quick Duplicate function that allows
you to perform the following functions.

O Copy read-only text that may not be otherwise selectable
O Copy text that is otherwise selectable without clearing the current selection

Quick Duplicate operations always maintain the current selection and
bypass the clipboard, preserving the current contents of the clipboard

You can quickly copy text using the Quick Duplicate method by following
these steps:

1 Set the insert point.

2 Hold down the Paste key

3 Press and drag SELECT to highlight a temporary selection with a sohd
underline.

4 Release SELECT.

5 Release the Paste key

The selected text is inserted at the insert point

The clipboard does not keep track of Quick Duplicate selections.

As much as possible. the application developer should allow all text on the
screen to respond to Quick Duplicate, including read-only text that cannot
normally be selected For example, text from a Help window or the header of
an application could be selected and copied into any window The application
developer ultimately decides what text can be accessed in this way. For
example, it may not be productive to program the clock so that its text can be
quick duplicated

To permit you to select text for Quick Duplicate, when the Paste key Is
pressed, all the usual window selection and dragging operations are sup-
pressed so that press ECT on a message area In the header or tooter of
a window marks €1 j of the text selection, and dragging SELECT
underlines the i&x { dragging the window

When an OFEl plemantation provides Quick Duplicate function
ality in the h&3 t & window, it alows you to use Quick Duplicais
to Include ' >piayed in e header or In the 1oGler message
area In ol ample, you might wan 10 include such ntorma-

tion In a e COMDOSING
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Figure 17-13 shows an example of a window in which you have initiated a
Quick Duplicate operation but have not yet released the Paste key. The word
“windshield” is the active selection, and the phrase “Selection starts in line 1.”

is underlined.

[ i Edit
(File 7) (View v) (Edit 7) (Find 7)

Oh no. It’s the dreadedm viper.

| —D)]

_L‘Selection starts in line 1.

Figure 17-13 A window with both a current selection and a Quick Duplicate selection
highlighted.

When you release the Paste key, the highlighted text is deleted and the
underlined text is inserted at the active caret, which marks the insert point.

 Copying Graphic Objects

An OPEN LOOK Ul implementation supports the following ways to copy
graphic objects:

O Copying a graphic object to a clipboard and then pasting it in a window I
O Pressing the DUPLICATE modifier key and SELECT on a selected graphic

object and dragging it

Each method works the same as it does for text.
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Moving from this window...

to this window

. = -
] Edit @ Edit 5
(File 7) (View v) (Edit v) (File v) (View ) (Edit v)

How now ,cow? The quick fox jumped over
] the lazy dog. u
vl © =]
=] =]
= Ao 21

Figure 17-15 Press the Cut key to move the selected text from the pane onto the clip-

board.

3 Move the pointer to the place where the text is to be moved, and click

SELECT to set the insert point, as shown in Figure 17-16.

Moving from this window...

to this window

=) Edit

-l

(File v) (view v) (Edit v)

How now cow?

a

NEOEn)

(File v) (View v) (Edit v)

The quick‘fox jumped over
the lazy d<}§;.

.

V] Edit

N T Cima

Figure 17-16 Move the pointer to the other window and click SELECT to set the in-

sert point.

4 Press and release the Paste key. The text is inserted at the insert point, as

shown in Figure 17-17.
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Bring up the text property window by choosing Properties from the Edit
button menu or by pressing and releasing the Properties key.

The input area is changed to the property window, and the pointer jumps to
the Apply button, as shown in Figure 18-2. Note that the header of the
property window highlights to show that it has the active input area. The
settings Sans Serif, 12, Bold, and lItalic in the text property window show the
attributes of the text that you selected.

]

= Edit
(File v) (view v) (Edit v)

it was a dark and stormy
[ I T8 All of the beagles were
safely in their kennels. The bats
flew around the tower,
squeaking frantically.

| =m0

' Edit : Text

‘ Font: [ Serif [Sans Serif | Typewriter |
size: [8[12]16720]
Style:  [Bold ] [ Underline |
[Otalic] [ strike Through |

{ {Capply ) (Reset )
~

o ]

Figure 18-2 Display the text property window.

You are going to change the font style for the selected text to make it match
the rest of the text. To do this, you move the pointer to the Bold setting and
click SELECT. This turns off the Bold setting. Notice that a change bar is
displayed to the left of the Style label to show you that you have changed the
setting, as shown in Figure 18-3.
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You are now ready to apply properties. Move the pointer to the Apply menu
button and click SELECT. The Apply menu button shows the standard busy
pattern while the changes are being applied, as shown in Figure 18-5.

m

i Edit

(File 7) (view 7) (Edit 7)
it was a dark and starmy
All of the beagles were
safely in their kennels. The bats
flew around the tower,
squeaking frantically.

(D)

L 0

0 Edit : Text

Font: [ Serif [Sans Serif | Typewriter |
size: [8[12]167]20]
| style: Bold Underline

[Titalic | [ strike Through |

(Bply 7y

N &

Figure 18-5 Click SELECT on the Apply menu button to apply properties.

The selected text is changed and remains selected, as shown in Figure 18-6.
The active input area is restored in the text window, as shown by the highlight-
ing in the header and the active caret. The property window is dismissed.

(7] Edit

(File 7) (View v) (Edit v)
E

was a dark and stormy night,
All of the beagles were safely
in their kennels. The bats flew
| around the tower squeaking

[ frantically.

D: yo—

-

Figure 18-6  Changes are applied to the selected text.
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Application A
(File 7) (View v) (Edit ¥) (File 7) (View v) (Edit v)

Original selection

= Application B

New selection

I i Y

Jf——ammn

New selection of the same type (but r —_—
not necessarily the same properties) K| Application C
in the sarme window. 5 5
: (line) Rectangle (Circle )
s X | R e o
Q A: Properties | O e 5%

Font: Roman sans serif

Size: [12]14] 16 | 20 ]
8 x i
)

Y Il

Figure 18-7 Original selection.

Suppose you want to change the information in the text field of the Proper-
ties window for Application A. You can select text in the Properties window
without losing your original selection. Move the pointer to the text field and
highlight the words “Roman sans serif.” The new selection is highlighted in the
usual way, and the original selection is dimmed, as shown in Figure 18-8. The
Properties window is still active, and you can apply changes to the original
selection at any time by clicking SELECT on the Apply menu button.
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-
B sopbcations 7
(File_7) (View v) (Edit 7) (File_7) (View v) (Edit 7)

=)

Original selection

A

=

P —TTNLIT

| New selection of the same type (but Py —
| not necessarily the same properties) i) Application C
in the same window. e ae———_—
! ' = - (line ) (Rectangle ) {Circle)
(@] A: Properties O 3
[
| Font: Roman sans serif B\

size: [32 [14] 16 20 |
(Apply 7) (Reset ) - -

N 5

Figure 18-9 The original selection is preserved when you make selections in other
windows.

You do not have to limit your selections to objects within an application. You
can select a window or an icon, perform operations on it, and still maintain the
original selection for the Properties window.

In Figure 18-10, a selection of a different type is made in the same applica-
tion. The circle is selected.

Application A f Application 8 E

file v) (View v) (Edit v) (file v) (View v) (Edit 7)
— - [ = =)
Driginal sefection Q New selection a
| a

L]

New selection of the same type (but —

not necessarily the same pr ”'”::\ ' ® Application C
o (Line ) (Rectangle) (Circle’

© A: Properties h o
font: Roman sans serif
Size: [12]T9] 16 [ 20

|
Apply = ) © Reset )

e

Figure 18-10 A new selection of a different kind in the same application window.
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o Application A ﬂ Application B R
(File ) (view v) (Edit ) (File v) (View v) (Edit 7)
S N =
[ Original selection @ New selection
3 o L. =
not necessarily the Application C B
o the same uindow (Line ) (Rectangle ) (Circle)
4 o
< A: Properties Q
\r Font: Roman sans serif
size: [12[13] 16 20
] . —_
[ “Reset ) L -
; Original Selection
New Selection
L ]

Figure 18-12 Press MENU on the Apply menu button to display the Apply menu.

Drag the pointer to the New Selection item, as shown in Figure 18-13.

(7] Application A f Application B N

File v) (view v) (Edit 7) (File_7) (view 7) (Edit 7)
T =
| Original selection

New selection
|

-

|

v

1) Application C b
(Line ) (Rectangle ) (Circle)

New selection of the same type (but
llnot necessarily the same properties
in the same window.

line)
© A: Properties l O I
Whhdmtenbam ) 1 |
fFont: Roman sans serif l e O
Sice: (12 T3] 16 20] t : |
OB o) - .
| oOriginal Selection [}
| e

Figure 18-13 Drag the pointer to highlight the New Selection item in the Apply menu.

| 15w

Release MENU to apply the properties to the new selection and dismiss the
Apply menu
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Basic window types: base, command, property, Help, and Notice
windows

Control areas with:

O Button controls O Exclusive and O Basic horizontal
O Abbreviated menu nonexclusive settings sliders
buttons O Text fields (scrollable) O Check boxes
Icons
Menus

O Both press-drag-release and stay-up modes
O Controls of the same kind: items, exclusive or nonexclusive settings
O Optional pushpins

Mouse/keyboard:

O Mouse buttons: SELECT, ADJUST, MENU

O Mouse modifiers: DUPLICATE, PAN, CONSTRAIN, SETMENUDEFAULT
O Core functions: COPY, CUT, HELP, PASTE, PROPERTIES, UNDO

O Pop-up accelerators: DEFAULTACTION, CANCEL

O Text Field Navigation: NEXTFIELD, PREVFIELD

Pointer jumping (with preference to disable)

Pointers
O Basic pointer O Move pointer O Text duplicate pointer
0O Busy pointer O Question mark pointer O Text move pointer
O Duplicate pointer

Scrollbars
O Basic scrollbar O View need not be O Vertical or horizontal
O Scrollbar without updated while O Scrollbar menus

cable elevator is dragged

0O Abbreviated scrollbar

102
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Normal and selected details for 85—point monochrome icons
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Mormal icon border detail Selected icon border detail

for B5 x B5-point icon for B5 x B5—point icon

Figure B-12 65-point monochrome icons.

Browse 3

3-pixel border shows selected icon
Symbol image area maximum 57 x 38

Detail for 6S-point
monochrome icon
.

Figure B-13  65-point monochrome icon detail.
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Using the Mouse

You use the mouse pointer to control windows and icons and to choose
activities from menus. You use the pointer by moving it with the mouse to a
specific place on the screen and then pressing or clicking a mouse button to
perform an action. You can perform the following actions with the mouse:

0O Press a mouse button down and hold it.

O Release a mouse button to initiate the action.

O Click a mouse button by pressing and releasing it without moving the
pointer.

O Double-click a mouse button by clicking twice within a short time period.

O Move the pointer by sliding the mouse with no buttons pressed.

O Drag the pointer by sliding the mouse with one or more buttons pressed.

To maintain consistency, each mouse button is assigned a specific function.
The three basic mouse functions are:

O SELECT to select objects or manipulate controls
O ADJUST to add or take away from a group of selected objects
0O MENU to display and choose from menus

Starting Applications

You start applications by moving the pointer anywhere on the background
of the workspace and pressing MENU to display the Workspace menu. Drag
the pointer to the right in the Programs item to display a submenu with a list of
applications. Drag the pointer to an item in the submenu, and release MENU
to start the application and dismiss the menu group.

Using Menus

Each region on the workspace, the window background, or in an application
pane that is not a control has a pop-up menu associated with it. Each menu
button has a button menu associated with it. Menus contain items or settings.
You can view and choose from any OPEN LOOK Ul menu in two ways using the
MENU mouse button:

Press-drag-release
Click-move-click




OPEN LOOK Ul Help Text

To use press-drag release, press MENU. The menu appropnate for the
pointer location is displayed. When the pointer 1S not on a control in the menu,
the default ring is displayed. When you drag the pointer onto a control, it
highlights. When you drag the pointer from control to control, the highlighting
follows the pointer. When the pointer is on the control you want, release MENU
The control is activated and the menu is dismissed

When an item has a menu mark (an open triangle). that item has a submenu
with additional items. Releasing MENU when an item with a menu mark is hugh-
lighted activates the default from the submenu. To display a submenu for an
item that has a menu mark, drag the pointer to the right. Drag the pointer to the
left to dismiss the submenu while leaving the originating menu displayed

If you do not want to choose an item from a menu or submenu, move the
pointer off the menu and release the MENU mouse bution

To use click-move-click, click MENU. The menu appropriate for the pointer
location is displayed and stays on the screen. You do not need 10 keep press-
ing the MENU button. Move the pointer 10 the control you want to choose, Click
SELECT or MENU to activate the control. The control 1s executed and the menu
is dismissed. If you do not want to choose a control, move the pointer off the
menu and click SELECT or MENU to dismiss the menu. Clicking SELECT on an
item that has a menu mark executes the default from the submenu. Clicking
MENU on an item that has a menu mark displays the submenu

Selecting and Moving Windows and Icons

You can move windows and icons on the workspace ingividually or in
groups by selecting and nen dragging them You select a window by mov-
ing the pointer to the top oF boliom of a window and clicking SELECT You

select an icon by maving the pointer onto the Icon and chicking SELECT Tc
move a window or fcan, press SELECT and drag the panter. Depending on
the implementation, & bounding box Is displayed showing the outling ol the
window or icon Whan the bounging box Is &l the placa whate you wanl 1o
move the window O reiease SELECT

Moving groups 0% @ ws @and lcons works In the same way onCe they are
selected. To select 1 i) ONE Winoow Of Icon, cick SELECT o seiact The
first window o : ~ick ADUUST 10 Salect andinonal windows of
icons. Clicking y selected window of icon desalacis . wilhoui

affeching o

401
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Window Basics

This section provides help text for the basic OPEN LOOK Ul window
elements: Window menu button, window and pane borders, resize corners,
scrollbar elements, and resize handles.

Window Menu Buttons

Use the Window menu button to activate the default item from the Window
menu without displaying the menu. For example, when Close is the default
item on the Window menu, moving the pointer to the Window menu button
and clicking SELECT closes the window to an icon.

Window Borders

The window border thickens to show that you have selected the window.
Select a window for the following reasons:

O To set the input area to that window, a process that activates an inactive
caret and brings the window to the front of the screen
O To move it by dragging with SELECT

To select a window, move the pointer onto the window background (header,
footer, or border edge without a scrollbar) and click SELECT.

Select groups of windows or icons when you want to do the same operation
on all of them, such as moving by dragging or quitting all selected items. To
select additional windows or icons, or toggle the state of the window or icon,
move the pointer onto the window background and click ADJUST.

To operate on groups of selected windows and icons, choose Window
Commands from the Workspace Utilities submenu. When the Window Com-
mands pop-up window is displayed, select the windows and icons you want
to operate on and then click SELECT on the appropriate button in the Window
Commands pop-up.

Pane Borders

When you can perform an operation on a pane such as setting properties,
resizing, or deleting, you select the pane by moving the pointer onto the
border of the pane. When the pane can be selected, the target pointer is
displayed. Click SELECT. The border thickens to show that it is selected.
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Cable Anchors

Use the cable anchors to move quickly to the beginning or end of the data
by moving the pointer to the cable anchor and clicking SELECT.

When a pane can be split into multiple views, you do this by moving the
pointer to one of the cable anchors of that pane. Press SELECT and drag the
cable anchor. The cable anchor highlights, and a bounding line is displayed
to show you where the pane will split. Release SELECT to split the pane. You
have created two separate views into the same pane.

To resize a split pane, move the pointer onto the pane border and click
SELECT. A resize handle is displayed on the side or sides of a pane that can
be resized. Move the pointer to the resize handle, press SELECT, and drag the
pointer to adjust the sizes of the adjacent panes. The resize handle highlights,
and a bounding line is displayed to show you where the new pane border will
be. Release SELECT to resize the panes.

To delete a split pane, move the pointer to one of the cable anchors for the
pane, press SELECT, and drag the cable anchor until it overlaps the other
cable anchor for that pane. Release SELECT to delete the pane. The split
pane is removed and the remaining panes readjust to fill the available space.

You can also create or remove splits from the Scrollbar menu. Move the
pointer to any part of the scrollbar and press or click MENU to display the
scrollbar menu.

Arrow Buttons

Use the arrow buttons on the scrollbar elevator to change the view on
the data that is displayed in the pane. When an arrow in the arrow button is
dimmed, the elevator is at the beginning or the end of the data. Move the
pointer to an arrow button and click SELECT to scroll the contents of the
pane one unit at a time. Press SELECT to repeatedly scroll the contents of
the pane.

Move the pointer to any part of the scrollbar and press or click MENU to
display the scrollbar menu.

Drag Area

Use the drag area of the scrollbar elevator to move to an arbitrary location
in the data. Move the pointer to the drag area and press SELECT. The drag
area highlights. Drag the pointer to move the view in the pane forward or
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Using Click-Move-Click

To use click-move-click, click MENU. The menu is displayed and stays on
the screen. Move the pointer to the control you want and click SELECT or
MENU. The control is executed and the menu is dismissed. If you do not want
to choose a control, move the pointer off the menu and click SELECT or MENU
to dismiss the menu.

Using the Pushpin

To pin up any menu that has a pushpin, press MENU, and drag the pointer
to the pushpin. When the pin pops into the hole, release MENU. The menu
becomes a pop-up window, and you choose from it in the same way that you
use controls in the control area of a window: Click SELECT to choose a control.
The pinned menu remains on the screen until you dismiss it. To dismiss a
pinned menu, move the pointer to the pushpin and click SELECT.

Changing the Default Setting

Each menu in a menu group has a default setting. The menu default is
displayed when the pointer is off the menu and when you press the DEFAULT
modifier key. You can change the default setting for any menu using the steps
below:

1 Press MENU to display the menu. To change the default for a submenu,
drag the pointer into the submenu.

2 Press the DEFAULT modifier key.

3 Drag the pointer from control to control. The default ring follows the pointer.

4 When the default ring is on the control you want to use as the default,
release MENU and then release the modifier key.

You can press and release the DEFAULT modifier key at any time, either
before or after you press MENU. If you release the DEFAULT modifier key first
and then release MENU, in addition to setting the default, the command is
executed.
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Pop-Up Windows

This section provides help text for the pushpin. and for common elements
of Help and property windows

Pushpin

Use the pushpin to pin up a pop-up window for continued access. Move
the pointer to an unpinned pushpin and click SELECT to push the pin in the
hole. Click SELECT on a pinned pushpin to pop it out of the hole and dismiss
the pop-up window.

When the pop-up window is displayed In an unpinned state, the pop-up
window is automatically dismissed the next time you click SELECT on an
action button in that window If you want to dismiss the window without issuing
a command, click SELECT on the pushpin to pin the window, and then click
SELECT to dismiss the window

Help Window

The Help window for each application displays help for the object under the
pointer. To see more help text for the same application without dismissing the
Help window. move the pointer 1o another object in the same application angd
press the HELP key again The view in the magnifying glass changes, and
appropriate help text is displayed In the pane of the same Help window

If you move the pointer to a different application window and press the
HELP key without alsrmuissing the original Help window, a second Help window

is displayed

You dismiss a Help #indow Dy moving the pOinier 1o ing pushpm and
clicking SELECT Alternalively, you can move ina poier 1o ine header of the
Help window, press ME! move the poinigr oo the Dismuss dam. and

release MENL

Magnifying glass

The wview iy 1 1 lase shows the objeci at the pomiar DOSHION
when you pressed i ay. To change the view i 1ha magralying glass
and disg # for tha new obpacl, move the pomied 10
anothi cabon and prass tha HELF sey agan
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Property Windows Settings

This section provides help text for the following elements of property
windows:

O Apply, Reset, and Set Defaults buttons
0O Settings menu items

Apply Buttons

Use the Apply button to apply properties that you have changed to the
selection.

Move the pointer to the Apply button and click SELECT. If the pushpin is
out, the changes are applied and the property window is dismissed. If the
pushpin is in, the changes are applied and the property window remains
displayed until you dismiss it.

When the original selection is dimmed, you can still apply changes to it in
the usual way with the Apply button.

New Selection Item

Use the New Selection item on the Apply menu to apply properties that you
have changed to the highlighted selection without changing the original
selection.

Drag the pointer to the New Selection item and release MENU. The changes
are applied and the property window remains displayed until you dismiss it or
click SELECT on the Apply button.

Original Selection Item

Use the Original Selection item on the Apply menu to apply properties that
you have changed to the original selection.

Drag the pointer to the Original Selection item and release MENU. The
changes are applied and the property window remains displayed until you
dismiss it or click SELECT on the Apply button.

Reset Button

Use the Reset button to change the settings in the property window so that
they reflect the settings for the original selection.
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Set Default

Use the Set Default item to change the default settings for the property
window to the current settings. First change the settings in the property
window to reflect the values you want to use as the defaults.

Then display the Settings menu, drag the pointer onto the Set Default item,
and release MENU to set the defaults. The property window remains displayed
until you dismiss it or click SELECT on the Apply button.

Icon

An icon is a window that has been closed. To open an icon, move the
pointer onto the icon and double-click SELECT, or press or click MENU to
display the Window menu and choose Open.

To move an icon, move the pointer onto the icon, press SELECT, drag the
pointer to a new location, and release SELECT.

Clicking ADJUST toggles the state of the icon between being selected and
not selected.

Active Caret

The active caret shows the place in the window where characters that you
type are displayed. To set an active caret in a text area, move the pointer to
the place at which you want to type characters and click SELECT or ADJUST.

The header of a window that has the active input area is highlighted.

Inactive Caret

The inactive caret shows the place in the window that had the last active
input area. To activate an inactive caret, click SELECT on the window back-
ground. To set a new active caret, move the pointer to the place at which you
want to type characters and click SELECT or ADJUST.







OPEN LOOK Graphical User Interface Functional Specification

Clipboard

The clipboard is for cut/copy/paste operations. Use the Clipboard item to
display the contents of the clipboard.

Drag MENU onto the item and release MENU to display the clipboard
window.

Window Controls

Window Controls are for operating on groups of selected windows and/or
icons. Use the Window Controls item to display the Window Controls pop-up
window.

Drag MENU onto the item and release MENU to display the Window Controls
pop-up window.

Properties

Use the Properties item to display the Workspace Properties window. Use
the Workspace Properties window to set global workspace properties. The
Categories menu of the Properties window offers the following choices:

O Color

O Icons

O Keyboard Core Functions

O Keyboard Miscellaneous Functions
O Menus

O Miscellaneous

O Mouse Modifiers

O Mouse Settings

O Programs Submenu

To display the Workspace Properties window, drag MENU onto the Proper-
ties item, and release MENU.

Exit

Use the Exit item to quit all applications on the workspace, leave the
workspace, and return to your system prompt.
Drag MENU onto the item and release MENU to exit the workspace.
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Restore Size

Use the Restore Size item to return the dimensions of the window at the
pointer location to the default window size. The Restore Size command does
not return windows to an iconic state.

Drag MENU onto the item and release MENU to restore the size of the
window at the pointer location to the default size.

You can use the Restore Size command without displaying the Window
menu by moving the pointer onto the window background and double-click-
ing SELECT.

Properties

Use the Properties item to display the application property window. You can
set the following properties from this window:

O Window color

O Initial location

O Initial state

O Initial size

O Base window scale

O Pop-up window scale
O Manage windows

O Record current state

To display the Properties window, drag MENU onto the Properties item, and
release MENU.

Window Color Category

Use this setting to change the default background color for the application
window and its pop-up windows. The area to the right of the menu button
shows the color that you chose from the Color button menu.

To return to the default color setting, move the pointer to the menu button
and click SELECT. To choose a different color setting, move the pointer to the
menu button, press MENU to display the Color menu, move the pointer to the
color you want to set, and release MENU.

To apply the color setting to the application, click SELECT on the Apply
button.
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X Numeric Field

The number displayed in this field shows the x coordinate for the upper left
corner of the application base window. You can type a new number in this
field to change the x coordinate.

Click SELECT in the numeric field to set the active caret and highlight the
default number. Type a new number.

To apply the setting, click SELECT on the Apply button.

Y Numeric Field

The number displayed in this field shows the y coordinate for the upper left
corner of the application base window. You can type a new number in this
field to change the y coordinate.

Click SELECT in the numeric field to set the active caret and highlight the
default number. Type a new number.

To apply the setting, click SELECT on the Apply button.

Initial State Category

Use the Initial State category to set how the application window is displayed
when you choose it from the Workspace menu. When you choose Window,
the application is displayed as an opened window. When you choose Icon,
the application is displayed as an icon.

Move the pointer to the Window or Icon setting and click SELECT. To apply
the setting, click SELECT on the Apply button.

Initial Size Category

Use the Initial Size category to determine the total area of the base window
for the application in units of rows and columns. When the property window is
displayed, the current numbers of rows and columns are displayed in the
numeric fields.

Rows Setting

Use the Rows numeric field to choose the number of rows for the base
window of the application.

Move the pointer to the numeric field and click SELECT to set the active
caret and highlight the default number. Type a new number.

>06
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Base Window Scale

Use the Base Window Scale setting to choose the scaling size for the base
window of the application.

Move the pointer to the drag area of the slider, press SELECT, and drag the
pointer to the left to choose a smaller scaling size or to the right to choose a
larger scaling size. Release SELECT. To apply the setting to the application
base window, click SELECT on the Apply button.

Pop-up Window Scale

Use the Pop-up Window Scale setting to choose the scaling size for all the
pop-up windows of the application. You cannot scale pop-up windows
individually.

Move the pointer to the drag area of the slider, press SELECT, and drag the
pointer to the left to choose a smaller scaling size or to the right to choose a
larger scaling size. Release SELECT. To apply the setting to the pop-up
windows, click SELECT on the Apply button.

Back

Use the Back item to move the window or icon at the pointer location to the
back of the workspace and tuck it behind any overlapping windows and
icons.

Drag MENU onto the item and release MENU to move the window or icon at
the pointer location to the back of the workspace.

You can bring a window or icon to the front of the screen by selecting it. To
select a window, move the pointer to the window background and click
SELECT. To select an icon, move the pointer onto an icon and click SELECT.

Refresh

Use the Refresh item to redisplay the window or icon at the pointer location.
Drag MENU onto the item and release MENU to refresh the window or icon.
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Cancel

When you have made changes to a property window but have not applied
those changes, the label on the top menu item of the pop-up window menu is
Cancel to show you that the changes to the property window will be dis-
carded when you dismiss it.

The Cancel submenu has two choices:

O This Window
O All Pop-ups

When you use This Window, the property window at the pointer location is
dismissed.

When you use All Pop-ups, the property window and the rest of the pop-up
windows for the application are dismissed.

You can choose the default setting from the Cancel submenu without
displaying it by dragging MENU onto the Cancel item and releasing MENU. To
display the Cancel submenu, drag MENU to the right in the Cancel item. To
choose an item from the Cancel submenu, drag the pointer onto an item and
release MENU.

This Window

Use This Window to dismiss the pop-up window at the pointer location.
Drag MENU onto the item and release MENU to dismiss selected windows.

All Pop-ups

Use All Pop-ups to dismiss all the pop-up windows for the application that
are open on the workspace.

Drag MENU onto the item and release MENU to dismiss all pop-up windows
for the application.

Back

Use the Back item to move the window at the pointer location to the back of
the workspace, tucking it behind any overlapping windows and icons.

Drag MENU onto the item and release MENU to move selected windows and
icons to the back of the workspace.
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You can bring a window or icon to the front of the screen by selecting it. To
select a window, move the pointer to the window background and click
SELECT. To select an icon, move the pointer onto an icon and click SELECT.

Refresh

Use the Refresh item to redisplay the pop-up window at the pointer location.
Drag MENU onto the item and release MENU to refresh selected windows.

Owner?

Use the Owner? item to identify the base window that originated the pop-up
window. The title bar of the originating base window flashes and comes to the
front of the screen.

Drag MENU onto the item and release MENU to locate the owner of the
pop-up window at the pointer locatton.

Scrollbar Menu

Use the Menu Background help text when the pointer is on the background
of the Scrollbar menu. The following sections provide help text for each item
of the Scrollbar menu.

Here to Top

Use the Here to Top item to scroll the line at the pointer location to the top of
the pane. Drag MENU onto the item and release MENU.

Here to Left

Use the Here to Left tem to scroll the line at the pointer location to the left of
the pane. Drag MENU onto the ttem and release MENU

Top to Here

Use the Top to Here item to scroll the line at the top of the pane to the
pointer location. Drag MENU onto the item and release MENL

w,
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Character Sets and Fonts

To support multinational functionality, it is very important for the program-
matic interface to provide support for a suitable collection of character sets.
The collection of character sets depends on the intended market and may be
tailored to local needs. Most of the European languages can be supported by
adding a small number of characters such as nonspacing accents to the
ASCII (American Standard Code for Information Interchange) character set or
by using ISO character sets.

International requirements differ for different markets. For example, a
product designed primarily for the European market is unlikely to include a
capability to display Asian character sets.

All software must handle characters from all supported sets in the collec-
tion. In particular, you must be able to type, display, edit, delete, and print all
characters. When applications validate text, it must validate characters from
all available character sets.

When considering fonts, remember that some character sets such as Asian
languages support specific font heights, do not support text attributes such
as bold, and do not have serifs.

The Virtual Keyboard that is defined as a Level 2 requirement for the OPEN
LOOK Ul provides a specified mechanism that you can use to view the current
keyboard mapping and change between specified character sets.

Text Strings

All text that an application displays must be translatable. This includes text
such as window titles, button and setting labels, menu items, error messages,
and text that is displayed in Notices and help windows.

It is recommended that the programmatic interface provide a mechanism
such as “message” or “resource” files to separate text strings from the
program code. It may also be necessary for the programmatic interface to
externalize the format of the strings as well as the text, since the order of
arguments provided by the application may differ among languages.

Text Directions

The programmatic interface must support different directions of text flow, as
pecified below:




International Considerations for the OPEN LOOK User Interface

O Left to right for languages such as English
O Right to left for languages such as Arabic and Hebrew
O Vertical for some Asian languages

Multiple directions must also be supported. This is required so that an
application can mix languages with different directions on the same screen
These are also required because certain languages, such as Japanese,
require both horizontal and vertical typesetting. Other languages, such as
Arabic, read characters from right to left and numbers from left to right

Formats

In general, the programmatic interface must permit both users and
translators to specify choices of formats, units, and sort sequences, and for
applications to reflect the specified choices.

Consider the following when designing an international implementation

O Languages have different punctuation types and rules

O A word is defined differently in different languages. Japanese. for example,
does not have spaces between "words.” The language’s definition of a word
affects white space and word delimiter definitions.

O Formats and rules for numbers differ

O Formats and rules for dates differ

O Formats for calendars differ For example. some countries define a week as
Monday through Sunday, while others define it as Sunday through Saturday

O Decimal and thousands separators differ. This issue also affects decimal-
aligned tab formats

O Standard page sizes differ. at both the workstation and the printer

O Monetary units and rules differ

O Units of measuremennt and rules differ

O Sort orders and collaung sequences vary or are inappropriate

O Certain languages have specific requirements for placement of characters
and prohioit some characters from displaying at the beginning of a line
Asian languages have many restriictions for character placement

T When windows afe resized, care must be taken to runcaie 18x! sirings ma
sensible
Word wrapi ] 1l 2 8 nonspacing accemad Charatiar w th IS 3550

O <

ated charall | s a single unt
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Layout

The sizes of OPEN LOOK Ul elements that contain text strings must not be
hard-coded. Most text strings expand when translated from English to another
language.

The programmatic interface should provide a facility that the application
developer can use to measure the length of text strings and adjust the
elements that contain the strings accordingly. Window placement and size
should also use these measurements. Positions and layout of elements should
be relative to one another to prevent overlapping elements or unneeded white
space between elements when translation increases or decreases the length
of the text strings.

When the application sizes windows dynamically using this measurement
facility, it is possible that the contents may not fit on the screen at the required
size and place. It is strongly recommended that all windows have resize
handles and scrollbars.

Physical Devices

Consider the variety of physical keyboards and pointing devices that may
be used with your implementation. A virtual input mechanism that allows
these devices to be mapped is extremely useful.

Consider international standards for communications protocols when
designing a programmatic interface.

OPEN LOOK Ul Elements

This section addresses the issues of font size, direction of text flow, and
localization for OPEN LOOK Ul elements.

Font Size

This specification defines elements relative to the size of the characters in
the default system font. Some languages require a larger minimum point size
than that for English. When larger characters such as accented or Asian
characters are part of the default system font, the implementation should
scale all the elements to accommodate the height and width of the font

[16
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O The header is displayed at the right side of the window.

O The horizontal scrollbar is the primary scrollbar. The top of the scrollbar is to
the right, and the elevator is, therefore, initially positioned on the right.

O Controls in the control area are arrayed vertically, top to bottom, and right to
left.

O The basic pointer points to the upper right corner of the screen, opposite to
the direction of text flow.

O The light source for shadows is the upper right corner of the screen.

Localization

Other elements of the OPEN LOOK Ul that should be considered for
localization are:

O Color has special local meaning. Some colors are taboo in certain cultures.
The concept of background and foreground may be reversed.

O Symbols often need to be localized. For example, the pushpin may be an
unfamiliar glyph, and a check mark has an opposite connotation in some
cultures.

O Characters from languages with large character sets and inflection distinc-
tions such as Kanji or Chinese require careful consideration to present
unambiguous information.

When developing a toolkit for international markets, consider the issues dis-
cussed in this appendix as a preliminary checklist. The languages and char-
acter sets to be supported determine the scope of development work
required and the issues to be considered.
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ASCII

Automatic scrolling

Back

Base window

Basic pointer

X

Binding

Bottom cable anchor
14

Bounding box

Busy pattern

Busy pointer

)
Button

( Print )

Button menu

American Standard Code for Information Inter-
change.

When not all of a file is visible in a window, the view
in a pane automatically shifts to follow the move-
ment of the pointer as you press SELECT and wipe
through the data.

An item on the Window menu that is used to move
the window or icon to the back of the screen.

The primary window for an application.

An arrow pointing northeast that shows the mouse
position on the workspace.

Logically connecting data files, icons, and images
to File Manager functionality.

The button at the bottom of a scrollbar cable.

A rectangle that is displayed on the screen to
define a region for selection.

A standard pattern displayed in the header of a
window or in the border of a button to show that the
application is temporarily performing a function
and cannot accept input.

A stopwatch is displayed by the system when an
application is busy and cannot accept input.

A one-choice element of a control area or a menu.
Buttons are used to execute commands (com-
mand button), display pop-up windows (window
button), or to display menus (menu button).

A menu that is displayed when the pointer is on a
menu button and you press MENU.
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CHARFWD

Check boxes

v
[

Click

Click-to-type

Clipboard

Close

COLUMNBAK

COLUMNFWD

Command window

A Level 2 text caret motion function that you use to
move the insert point forward one character.

A nonexclusive setting that shows a check mark in
a square box when the setting is chosen.

To press a mouse button once and release it
without moving the pointer beyond the damping
factor.

You set the insert point by clicking SELECT in an
area of the screen that accepts keyboard input.

The clipboard keeps track of data that are cut or
copied. The Paste key is used to insert information
from the clipboard into a pane. The contents of the
clipboard are viewed in a window that is accessed
from the Workspace menu. An item on the
Workspace Utilities submenu displays a window
that shows the contents of the clipboard.

A choice on the base Window menu that is used to
change the visual representation from a window to
an icon. When Close is chosen, only the visual
representation of the window is changed, and the
item name toggles to Open. See also “Open.”

A Level 2 text caret movement function that you
use to move the insert point up one line in the
current column (or to the end of the line if the
column is past the end of the previous line).

A Level 2 text caret movement function that you
use to move the insert point down one line in the
current column (or to the end of the line if the
column is past the end of the previous line).

A pop-up window that is used to execute applica-
tion commands or set parameters.
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CuT

Cut/copy/paste

Damping factor

Default ring
Cut

Default icon region

DEFAULTACTION

DELCHARBAK

DELCHARFWD

DELLINEBAK

DELLINE

DELLINEFWD

DELWORDBAK

A Level 1 core function that you use to put a copy
of the selected object onto a clipboard and then
delete the object from the workspace. This key can
also be used as a mouse modifier for Quick Move
operations.

Functions that are provided from keys on the
keyboard and that use the clipboard to store and
transfer text and graphics.

The number of pixels you can move the pointer
before a drag is initiated.

The default button in a pop-up window has a ring
displayed inside the button border. The default
item on @ menu or submenu has a 1-point ring
around the item when an item is not highlighted.

The side of the screen (top, bottom, left, or right)
the icon moves to the first time it is displayed.

A Level 1 pop-up window accelerator that you use
to execute the default button action and dismiss
the pop-up window.

A Level 2 text caret motion function that you use to
delete the character to the left of the insert point.

A Level 2 text caret motion function that you use to
delete the character to the right of the insert point.

A Level 2 text caret motion function that you use to
delete from the insert point to the beginning of the
line.

A Level 2 text caret motion function that you use to
delete the entire current line.

A Level 2 text caret motion function that you use to
delete from the insert point to the end of the line.

A Level 2 text caret motion function that you use to
delete the word to the left of the insert point.

?
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Drag area

oo

Drop shadow

Elevator

.

Embedded objects

Exclusive setting
| Apples [Oranges |

File Manager

Font

Footer

Full Size

The area in the middle of the scrollbar elevator or
slider.

The 75 percent gray pattern to the right and below
the border of a menu.

The part of the scrollbar that has up and down
arrows and a drag area. The elevator rides the
scrollbar cable and shows the position of the view
in the pane relative to the total data available.

Objects that are nested in other containers,
typically frames, either of the same or a different
type.

A control that is used for mutually exclusive
settings and is shown by touching rectangles.
The chosen setting is shown with a bold border
around it.

The file management application used in an OPEN
LOOK Ul implementation to load, store, and browse
through files from the workspace and from within
an application.

A complete set of characters in one typeface and
size.

The bottom area of a window. The footer is used by
an application for information and error messages.

To increase the size of a window to its maximum.
The specifications are determined by the applica-
tion. Full Size is an item on the Window menu that
allows you to perform that function. After you make
a window full size, the label in the item toggles to
Restore Size.




Glossary

Gauge

4 = —ESTS N
0

100

Glyph
Grab handles

Halation

Header

Help

HELP

Highlighting

Hot spot

lcon

A read-only control that shows the percent of
use or the portion of an action that has been
completed

A picture or graphic representation of an object

The small squares that are displayed at the corners
and midpoints of the region that defines a selected
graphic object.

The effect of screen elements “glowing” and giving
off light.

The band across the top of every window. Each
header has a centered title. Base windows have a
Window menu button on the left. Pop-up windows
have a pushpin on the left.

An OPEN LOOK Ul implementation provides
on-screen help for each element in a window, The
application provides help for application functions
and elements. The Help function must be available
from the keyboard.

A Level 1 core function that you use to display a
Help window for the object under the pointer

A visual indication that an object is in a special
state. In monochrome implementations the visual
indication Is reverse video. In color implementa-
tions, the user can set the selection highlighting
color. Button highlighting is shown by a pseudo
three-dimensional effect

The place on the pointer that determines the exact
spot on the screer where an action is performed

A small pictorial representation of & base wingow
splaying objects as icons conserves screen rea
estate while keeping the win: avle for easy
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Important message

Inactive controls

Indeterminate state

Input area

Insert point

Internationalization

Keyboard accelerator

Keyboard equivalent

Keyboard input

A message from the operating system or an
application that provides information that is
essential to continued operation.

An inactive control is dimmed. It cannot accept
input from the mouse or the keyboard.

When the application cannot clearly show all the
attributes of a selected object, the borders for
settings that are indeterminate are dimmed. The
label and setting names are not dimmed.

The place on the screen that accepts keyboard
input. Click SELECT to set the insert point in the
input area (click-to-type).

The specific location in the input area where
keyboard input is displayed. When you set the
insert point, an active caret is displayed.

A way of writing applications that facilitates
translation to other languages. Generally, key
names, prompts, messages, and warnings are
grouped in separate files that are not part of the
application code.

A key or sequence of keys on the keyboard or
multiple clicks of mouse buttons that quickly
perform specific menu or application functions
without using a menu.

Keyboards and mice are not the same from system

to system. An OPEN LOOK Ul implementation

provides specific default key sequences to provide

uniform functionality when specific keys or mouse
buttons are not available on a system. You can
change the default keyboard equivalents from the
Workspace Properties window.

To type alphanumeric characters from the key-

board at the insert point, a place on the screen that

accepts text.
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More button
Mouse
Move pointer

Multi-click

NEXTFIELD

NEXTWINDOW

Nonexclusive setting
| Bold || Italic |

Normal message

Normalization

A button an application can add to its Help window
to allow you to access other types of on-line help
such as on-line documentation.

An electronic or mechanical device that you use to
select and manipulate information on a computer
screen.

When you move an object by dragging, the move
pointer is displayed.

Clicking a mouse button rapidly a specific number
of times. Multi-clicking is usually an accelerator for
functions that can be accessed in other ways.

A Level 1 text field navigation function that you use
to move the caret to the next input area in the pane
and select the contents of the field. When the caret
is in the last input area, the caret moves to the first
input area.

A Level 2 input area navigation accelerator that
you use to cycle the active input area to the next
window (least recently used).

A list of nonexclusive choices indicated by
separated rectangles. The chosen settings are
surrounded by a bold border.

A message that is displayed in the footer of a
window to inform you about the status of a
requested operation.

Moving scrolled objects in discrete units so that a
defined unit is always visible in the pane. For
example, normalized text scrolls line by line.
Characters in a line are never chopped in half.
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Paste

PASTE

Picture frame corners

F—'_

Pinned menu

Pixel

Point

Pointer

Pointer jumping

POINTERDOWN

POINTERLEFT

To insert data from the clipboard into a window.
Selected data are placed on the clipboard with the
Copy or Cut key.

A Level 1 core function that you use to insert a
copy of the data on a clipboard at the insert point.
This key can also be used as a mouse modifier for
Quick Move operations.

See “Resize corners.”

A menu that has its pushpin pushed in. A pinned
menu is a pop-up window and remains on the
workspace until you dismiss it.

An abbreviation for picture element; the smallest
unit of display on a video screen.

The standard typographical unit of measurement,
equal to approximately 1/72 of an inch (0.352
millimeters).

Any graphic representation of the location of the
mouse on the screen. See also “Basic pointer,”
“Busy pointer,” “Duplicate pointer,” “Move pointer,”
“Panning pointer,” “Text duplicate pointer,” and
“Text move pointer.”

When the pointer automatically moves to a specific
location, such as to a Notice or a pop-up window.

A Level 2 pointer movement function that you use
to move the pointer down one pixel (repeats and
accelerates).

A Level 2 pointer movement function that you use
to move the pointer left one pixel (repeats and
accelerates).




Glossary

POINTERRIGHT

POINTERUP

Pop-up menu

Pop-up window

Pop-up Window menu

Press

PREVFIELD

PREVWINDOW

Programs

Properties

PROPERTIES

A Level 2 pointer movement function that you use
to move the pointer right one pixel (repeats and
accelerates).

A Level 2 pointer movement function that you use
to move the pointer up one pixel (repeats and
accelerates).

A menu that you access by pressing MENU on any
area of the workspace that is not a control. The
menu that is displayed depends on the location of
the mouse pointer.

A window that pops up to perform a specific
function and is then dismissed. Command
windows, property windows, Help windows and
Notices are all pop-up windows

The Window menu that is displayed when you
press MENU on the background of a pop-up
window.

To push and hold a mouse button.

A Level 1 text field navigation function that you use
to move the caret to the previous input area in the
pane and select the contents of the field. When the
caret is in the first input area, moves the caret to
the last input area.

A Level 2 input area navigation accelerator that
you use to cycle the active input area to the
previous (most recently used) window

An item on the Workspace menu that displays a
submenu with a list of application programs that
~an be accessed from the workspace
Characteristics of an object that you can set, such
1he color of a window
avel 1 core function that y ise 1o aisplay a
perty window for the s i&=a object
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Property window

Proportion indicator

Pushpin

~H O

Question mark pointer
2

Quick Duplicate
Quick Move

Quit

Refresh

Release

Reserved area

A pop-up window that is used to set properties
associated with an object, an application, or a
window.

The dark area of the scrollbar cable shows the
proportion of data that is currently viewed in the
pane, relative to the total length of the cable, which
represents the total size.

A glyph that can be used to keep a menu, property
window, or command window displayed on the
screen.

The pointer that is displayed when you click or
press a mouse button and the window manager
cannot perform an action. This pointer is also
displayed if you drag an object to an inappropriate
destination.

A means of copying text without changing the
existing text selection.

A means of moving text without changing the
existing text selection.

To exit an application. Quit is an item on both the
Window menu (quit the window) and the Work-
space menu (quit the workspace).

An item on the Window menu that redisplays an
icon or the contents of the window. Also an item on
the Workspace menu that is used to redisplay all
the windows and icons on the workspace.

To stop pressing a mouse button.

An area of the screen that is reserved for the
display of icons and a certain class of applications.
See also “Virtual edge.”
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Resize corner

F’_

Resize handles

Restore Size

Sans serif

Scale

Scrollbar
Scrollbar menu

SCROLLBOTTOM

SCROLLDOWN

Windows that can be resized have a resize area in
each corner. These areas provide unconstrained
resizing of the boundaries of the window without
changing the scale of the contents of the window.

When you select a pane that can be resized, resize
handles are displayed on the sides of the pane that
can be adjusted.

To return a window to its size before it was
displayed at full size. Also, an item on the Window
menu that allows you to perform that function. After
you restore the size of a window, the label in the
item toggles to Full Size.

Type styles that do not have serifs, small
cross-strokes or ornaments at the ends of the main
strokes making up a character.

To make everything in the window bigger or smaller
while keeping all elements of the window propor-
tional to one another, and the contents anchored at
the upper left corner. You choose the scale for
base or pop-up windows from the application
property window.

The scrollbar is used to move the view of the data
displayed in the pane

Each scrollbar has a pop-up menu that i1s used to
reposition the data in the pane

A Level 2 scrolling accelerator that you use to
scroll the view 10 the bottom of the pane (same as
clicking SELECT on the bottom cable anchor)

A Level 2 scrolling accelerator that you use to

scroll the view down one screen {same as moving

the pointer to the cable below the eigvator of a
artical scrollbar and chickif ECT
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Scrolling

Scrolling button

Scrolling list

SCROLLLEFT

SCROLLLEFTEDGE

SCROLLRIGHT

SCROLLRIGHTEDGE

SCROLLTOP

SCROLLUP

Select

SELECT mouse button

Moving through data that cannot be viewed entirely
in a pane.

An abbreviated button with a solid triangular
arrowhead inside the border that is used for
scrolling.

A pane containing a list of text fields. The list can
be read-only or it can be editable.

A Level 2 scrolling accelerator that you use to
scroll the view left one screen (same as moving the
pointer to the cable left of the elevator of a
horizontal scrollbar and clicking SELECT).

A Level 2 scrolling accelerator that you use to
scroll the view to the left edge of the pane (same
as clicking SELECT on the left cable anchor).

A Level 2 scrolling accelerator that you use to
scroll the view right one screen (same as moving
the pointer to the cable right of the elevator of a
horizontal scrollbar and clicking SELECT).

A Level 2 scrolling accelerator that you use to
scroll the view to the right edge of the pane (same
as clicking SELECT on the right cable anchor).

A Level 2 scrolling accelerator that you use to
scroll the view to the top of the pane (same as
clicking SELECT on the top cable anchor).

A Level 2 scrolling accelerator that you use to
scroll the view up one screen (same as moving the
pointer to the cable above the elevator of a vertical
scrollbar and clicking SELECT).

To distinguish an object or objects on the screen
so that they can be operated on.

The mouse button that is used to select objects,
set the insert point, manipulate controls, and drag
objects.
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Target pointer

Gk

Text duplicate pointer

]

Text move pointer

Text field

Tiling

Title

TOGGLEINPUT

Toolkit

Top cable anchor
Transitory window

Unbind

Undo

UNDO

The halo that is displayed around the hot spot of
the basic pointer when the pointer is on the border
of a narrow or small object.

The pointer that is displayed when you are copying
text directly by dragging.

The pointer that is displayed when you are moving
text directly by dragging.

An area in a window into which you type text from
the keyboard.

Panes that are laid out separately in a window so
that they do not overlap.

The name of the application or function that is
displayed at the top of a window or a pop-up
menu.

A Level 2 text caret movement function that you
use to toggle the input area to the most recently
used window.

A set of programming components used to build
applications.

The button at the top of a scrollbar.
Another way of referring to a pop-up window.

Logically disconnecting data files, icons, and
images from File Manager functionality.

To return an object to its state before you per-
formed the last operation. Levels of undo are
determined by the application.

A Level 1 core function that you use to undo the
last operation. If the last operation is an undo, it
restores the last operation.
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Unpinned menu

Up-down encoded

Validate

Virtual edge

Virtual keyboard

Window background

Window button

Window item

Window mark

Window menu

A menu with a pushpin that is not pinned to the
workspace. When you make a choice from an
unpinned menu, the action is performed and the
menu is dismissed.

A keyboard that can discriminate between
pressing a key down and releasing it

To have the application veriy that the contents of a
text field are appropriate to the function

A Workspace Properties setting that permits you to
define an artificial edge of the screen. The area
between the virtual edge and the actual edge of
the screen is reserved for the display of icons and
certain specified application windows. See also
Reserved Area.

An image of the keyboard that i1s displayed in a
window and that you can use to change the
mapping of keys, specify international character
sets, and bind accelerators.

The area outside any panes, including the header
footer, and sides of the window.

A button that you use to display a window contain-
ing additional controls.

An item on a menu that you use to display a
window containing additional controls

The three dots (,..) that are displayed following the
button label on window buttons, and following a
window Item on a menu

The menu that i1s accessed from the background of
a window: Pop-up windows have a wingow menu
with slightly different choices from those of the
base window menu
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Window menu button

il

Wipe-through
selection

WORDFWD

Workspace

Workspace menu

Workspace Properties
window

The abbreviated menu button that is always
displayed at the left of the header that you can use
to execute the default setting on the Window menu
(by clicking SELECT) and to display the Window
menu (by pressing MENU).

Pressing SELECT and moving the pointer through
objects to be selected (text or graphics).

Level 2 text caret movement function that you use
to move the insert point after the last printable
character of the next word, not including any
end-of-line character when the word is at the end
of a line (or the current word if the insert point is
within a word).

The background screen area on which windows
and icons are displayed.

The menu that controls global functions.

The property window accessed from the Work-
space menu that allows you to customize your
workspace environment.







OPEN LOOK Graphical User Interface Functional Specification

applying changes, to original

selection, 395

applying properties, 387, 390

area
cable, 162

control, 13, 14, 48, 51, 127

input, 62

message, 55

pane, 54

reserved, 36, 47, 223

scrollbar, 157

unsplittable, 167
arrow

More, 38, 54, 428

scrolling, 439
arrow buttons, help, 494
ASCIl character set, 514
AT&T Trademark Guide, 401
attributes, help text, 89

automatic scrolling, 121, 175
automatic word wrapping, 89

B

back, 87
Back button, 224
Back item, 228, 230
help, 508, 510
background, 24, 87, 129
color, 201, 203, 204, 248
icon, 43
scrollbar area, 59
window, 57, 58, 64, 248,
344
bar, slider, 117
base window, 12
border, 48
control, 57
control area, 48, 51
default positions, 60
elements, 12
File Manager, 265
header, 48, 51

=y .
Japanese, 517

minimum layout, 49
multiple, 57
nonstandard, 50
optional elements, 52
pane, 48, 51
positions at startup, 60
scale, 85
standard, 48
subsidiary, 57
title, 51
typical layout, 49
Window menu, 48
Window menu button, 13,
48
Base Window Scale slider,
help, 508
basic design principles, 3
basic functions, File Manager,
263
basic pointer, 38, 408
basic scrolling list, 475
dimensions, 476
Beep setting, 256
beeping, 256
messages, 55
when no insert point, 67
Before item, 190, 236
BG1, 207
BG2, 207
BG3, 207
binding, 274
application, 275
data file glyphs, 272
default, 275
file typing, 275
glyph, 274
magic numbers, 275
bitmap specifications, 407
black-and-white design, 5, 95,
203, 204
with color implementation, 5
blindless, color, 205
blocking
Notices, 92
pop-up window, 69

border box, 351
resizing with, 354
Border setting, 251
borderless icon, 43, 44, 204,
345
borders
base window, 48
color, 202
icon, 40, 41, 204
menu, 142
pane, 51
dimensions, 432
help, 492
three-dimensional, 216
scrolling list, 182
selected icon, 42, 345
setting, 105, 106, 107, 111
thickened, 60, 344
window, 25, 54, 60
help, 492
selection feedback, 344
bounding box, 370
selecting with, 347
Browse button, 263
browser, on-line help, 90
buffer queue, 92
bumping, screen edge, 352
busy
beeping, 62
button, 98
keystrokes and mouse
clicks, 62
window, 61, 62
busy pattern, 61, 132
command button, 446
header, 418
icon, 40
pop-up window, header,
420
in stay-up menus, 320
busy pointer, 37, 38, 410
busy state, 96
icon, 42
button, 8, 16, 96, 100
abbreviated, 16




Index

busy pattern, 98, 446
command, 444 446
command window, 73
default, 98
default size, 100
dimensions, 445, 446
feedback, 98
glyph, 97
highlighting, 98, 446
three-dimensional, 99
horizontal, 97
inactive, 98

increment/decrement, 119,

451
indeterminate state, 98
label, 96, 97, 100
menu, 447
pattern, 97
scrolling. 16, 103, 119-20
shadow, color, 203
three-dimensional, 97, 209
using command, 133
vertical, 97
window. 100
window mark, 100
button controls, 14, 96
abbreviated, 102
in control area, 127, 129
feedback, 99
summary table 125
button menu, 8. 19, 102, 141
467, 469
click-move-chick. 320
default, 134
dimensions, 468, 470
displaying. 98
placement, 151
position. 467
press-drag-release 317

cable, 18. 158
area. 162

help, 495

proport

cable anchors. 162-63
help, 494
spht pane, 167
three-dimensional, 215
CANCEL. 296
suggested mapping, 311
cancel, 70, 253
property window, 82, 229
Cancel item, 229
help. 510
caps key, 294
caret, 62. 71
active, 62, 434
dimensions, 435
help. 500
blinking. 63
color, 202
inactive, 63. 64, 435
dimensions 435
help, 500
multiple in sphit panes, 66
none, 66
number of, 66
number per window, 66
position. muiti-click
selection, 376
position in text field, 119
category
abbreviated menu button,
79
exclusive setting, 79
nonexchusive setiing, 79
certification. 401
Level 1, 401, 402
Level 2, 401, 404
Level 3 401, 406
change bar, 81, 262, 388
vhangmg categories, 81

demmed, 81

et fasa, 123

wige flem, 188, 236
PANING

ipidess, 27V

wemen) Gelat 330

character forward function,
253
character placement, 515
character sets, 513, 514
ASCIl, 514
international, 305
1SO, 514
Character Sets window, 307
dismissing, 307
More key 307
Set key. 307
Show key. 307
CHARBAK, 299
CHARFWD, 299
check box. 17. 112, 456
in control area, 129
default, 113
dimensions, 456
elements, 112
feedback. 113
inactive state, 113
indeterminate state, 113
matrix, 113
three-dmensional, 213
choosing
from menu, 315
from stay-up menu, 316
Clear All Chaices rem, 185,
23
chck 10
multiple, 259
chck-move-chick. 20. 316, 320
and Executes Default
option, 325
compining with
press-drag-release, 321
help. 496
Cack-E-type. 1
hpboard, 51, 225, 263, 368
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replace or copy functions,
52
scrolling list, 181
using, 281
window, 225, 369
clock application, 50
Close item, 227
help, 503
close lines, 342
closed folder, 271
code, color, 205
collating sequences, 515
color
active caret, 202
background, 201
BG1, 207
BG2, 207
BG3, 207
blindness, 205
borders, 202
bright, 205
button shadow, 203
codes, 205
controls, 203
design philosophy, 201
guidelines, 204
high contrast, 206
highlighting, 202, 203
highly saturated, 202
icon, 43
individual controls, 202, 204
input area, 202
internationalization, 518
lightly saturated, 202, 204
muted, 204
Notices, 201
palette, 202
panes, 201
pop-up windows, 201
proximity, 206
restraint, 201
restricted in interface
regions, 201
scrollbar, 201
selection, 202, 206
spectral extremes. 206
text, 203

window background, 203
windows, 83, 206
workspace, 35, 201, 204,
206
Workspace Properties,
201-2
Color category, 243, 245
color groups, for
three-dimensional
design, 207
color implementation, 5
with black-and-white
design, 5
palettes, 6
window background, 6
Color menu, help, 505

Color menu button, help, 505

Color Palette menu, 247
Color Sample window, 246
Columns setting, help, 507
command button, 444, 446
dimensions, 446
using, 133
command item, 16, 143
command window, 68, 71
blocking, 69
buttons, 73
control area, 130
dismissing, 229
optional elements, 72
pointer jumping, 70, 73
pushpin, 72
required elements, 71
resize corners, 72
state of parameters, 74
title, 74
consistency, 3
CONSTRAIN, 295, 352,
379, 385
suggested mapping, 310
constrained
dragging, 379
moving, 352, 385
panning, 176-77
contents, split pane, 358
context-sensitive help, 88

control area, 9, 13, 14, 48, 51,
127
command window, 130
controls, 95, 127
File Manager, 266
for multiple panes, 128
within pane, 129
position, 128
property window, 78, 79
read-only messages, 124
rearranging controls, 54
transitory, 139
typical location, 127
Workspace Properties
window, 243
control base window, 57
control key, 294
controls, 14, 15, 16, 95, 444
busy state, 96
button, 96
color, 203-204
in control areas and panes,
95
default, 73
inactive state, 96
indeterminate state, 96
individual color, 202
on menus, 95, 143
in pinned menu, 329
summary table, 125
visual feedback, 96
as window foreground, 59
coordinates, initial location, 84
COPY, 296
suggested mapping, 311
Copy item, 239, 266
copying
files, 280
graphic objects, 382
text, 369
text by dragging, 378
text with clipboard, 377
core functions, 294, 295, 298,
369
COPY, 296
CUT, 296
default, 295
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HELP, 296

PASTE, 296

PROPERTIES. 296

scrolling list, 181

STOP, 298

UNDO, 296
Create File item, 266
Create Folder item, 266
Current Color setting. help,

505
current item, 182, 183, 184,
476
deleting, 184

dimensions, 477
hierarchical scrolling list,
191
remembered, 184
current path, 193
Custom settings, 244-45
customized mapping. 306
customizing, Workspace
menu, 226
CUT, 296
suggested mapping. 311
Cut item, 239, 266
cut key, 383
cut/copy/paste, 369
File Manager glyphs. 263
functionality, 181
operations, 51, 225, 369

D

damping factor, 37. 311,312
352, 379
data file glyph. 263, 268, 2
272
default size. 42
date formats. 515
default
abbrevisted
104

activating menu, 316

background cotlor, 202

base window positions, 60

binding, 275

button, 98

button size, 100

changing. 329
submenu. 330

changing menu, help, 496

check box, 113

command window, 72

controls, 73

core functions, 295

data file glyph, 42

displaying button menu, 98

drag-nght distance, 336

executing menu, 255

File Manager glyph size,
271

glyph, hierarchical scrolling
hist, 480

Help window, dimensions,
483

hierarchical glyph, 194

icon region, 47

icon size, 39

menu, 134, 142, 149
and other windows, 149

menu button, 134

menuy item,
three-dimensional, 211

menu option, 325

mouse button assignments.
293

Notices. 91

ponters, 39

property window, 76

pushipin, 137, 334

pushpin state, 72

rze corners for base
windows, 53

riny M

aning. 108, 11

EEUNgE on memus. 14

slider. 116
suggested keyboard
mapping. 310
text field 123
viewing inactive, 138
viewing menu, 134, 135
Window Controls pop-up.
223
workspace grid increment,
35
Workspace menu, 11
default action, 253
detault control. alignment for
submenus, 322
default option, menus. 325
default ring, 96. 317, 444, 468
highlighting. 144
on submenus, 319
Detault setuing. help. 505
DEFAULTACTION, 73, 296
suggested mapping, 311
defining. syntactic level for
multi-clicks, 377
definition of word, 515
DELCHARBAK 300
DELCHARFWD. 300
delete character back
function, 253
delete character forward
function, 253
Delete item, 191, 237, 239
266
deleting
prmary pane, 364
sehscted charscters. 371
SpMt pilnes, 364

DELLINE. 30X
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design
basic principles, 3-4
black-and-white, 5, 95, 203,
204
goals, 4
philosophy, color, 201
three-dimensional, 5, 95,
206
visual, 5
device independence, 4, 293,
516
dimensions
abbreviated menu button,
449, 450
abbreviated scrollbar, 442
abbreviated window button,
451
active caret, 435
basic scrolling list, 476
button, 445
button menu, 468, 470
check box, 456
command button, 446
current item, 477
default Help window, 483
exclusive setting, 453
footer, 425, 426, 427, 430
header, 417
header highlighting, 418
Move Pointer option, 422
Help window, magnifying
glass, 482
hierararchical scrolling list,
glyph, 481
hierarchical scrolling list,
479, 480
horizontal gauges, 463-65
horizontal sliders, 457-60
inactive caret, 435
increment/decrement
buttons, 452
menu, 470
menu button, 447
menu item, 469
menu mark, 448
minimum scrollbar. 443

More arrow, 428

More arrow placement, 431
More button, 485
nonexclusive setting, 455
Notice, 486
page-oriented scrollbar, 440
pane, borders, 432
pinned pushpin, 424
pop-up menu, 474
pop-up window header, 420
resize corners, 417
resize handle, 434
scrollbars, 436-38
scrolling arrow, 439
scrolling buttons, 452
scrolling list, 477, 478
selected header, 419, 421
selected pane border, 433
sliders, 457-62
state message, 431
submenu, 472
text field scrolling buttons,
453
unpinned pushpin, 423
vertical gauges, 465-66
vertical sliders, 461-462
dimmed
arrows, 161
border, setting, 111
change bar, 81
diamond, 63
highlighting, 77, 82, 397
pane, 170, 172-73
pushpin, 329
selection, 391-93
direct manipulation, 23, 280
File Manager glyphs, 263,
264
directory glyph, 263, 271
disabling, pointer jumping, 70
Dismiss item, 229
help, 509
Dismiss submenu, 229
dismissing
Character Sets windows,
307
command windows, 73, 229

menus, 134, 315
pop-up windows, 22, 69,
133
property windows, 82, 229,
397
stay-up menus, 316, 321
Display Options, 274
displaying
another submenu, 319
button menus, 98
menus, 315
pop-up windows, 16
property windows, 388
stay-up menus, 316
submenus, 145, 318
for stay-up menus, 321
Window menus, 24
Displays Default setting, 255
Displays Menu setting, 255
Displays Stay-up Menu, 255
distance, drag-right, 254, 318
DOCEND, 300
DOCSTART, 300
dot, title area, 192
double-click, 10, 312
selecting, 350, 376
double-clicking, in hierarchical
scrolling list, 195
down arrow, 161
down stroke, mouse button,
312
drag and drop, 286, 288
drag area, scrollbar, 161
help, 494
drag box, slider, 114, 116, 117
drag-right distance, 145, 254,
318, 336
dragging, 10
border box, 351
constrained, 379
beyond damping factor, 352
text, 378, 385
text or graphics, 369
drop shadow, 142
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color implementation, 143

dimensions, 142

pattern, 142, 413

submenu alignment, 338
DUPLICATE. 295, 378

suggested mapping, 310
duplicate, quick, 381
duplicate pointer, 38, 409

B

edges, virtual, 36, 258
Edit List item, 183, 185, 235,
236
Edit menu, 19, 267
adding choices, 238
elements, 238
text field, 119, 221, 237
Edit menu button, 266
editing
palettes, 203
Programs submenu, 226,
261
scrolling lists, 186-89, 191,
235
text fields, 119
text functions, 300
Workspace menu. 226, 261
editor, icon, 39
efficiency, 3
elements
abbreviated button, 102
abbreviated menu button
103
base window. 12
check box. 112
exclusive setting. 105
File Manager
File Manager pat
269
gauge. 117
hierarchsca
191

Level 2

mem

nonexclusive setting, 109
pinned menu, 328
pop-up Window menu, 228
scrollbar, 156
Scrollbar menu, 232
scrolling list, 182
Scrolling List menu, 234
Settings menu, 231
slider, 114
text field, 118
text field Edit menu, 238
three-dimensional design,
207
vertical scrollbar, 18
vertical slider, 115
Window Controls pop-up.
223
Window menu, 226
Workspace menu, 221
Workspace Properties, 242
elevator, 18
adjusting, 174
drag area, 161
mowving. 18
position, 160
three-dimensional. 215
embedded objects. 367
end. 302
end box. dmensions, 459
end boxes. skder, 115, 459,
460
End Editing ttem, 191, 237
engineenng drawings
optimization, 407
Enter, scan code, 310
Enter key. 310
equivalents, keyboara, 252
253, 297
& 100 checHhing, numeric helgs
=age, 13,55, 133

@ sceolling list, 181

exclusive setings, 17, 105,
143, 453
dimensions. 453
elements. 105
in menus, 317
states, 454
three-dimensional. 212
vanation, 108
Executes Default option, 255
325
exit, workspace, 1o apply
properties, 242
Exit item, 221, 226
help, 502

F

factor
damping. 311, 352
multi-chck timeout, 312
Factory setung, 244
feedback
busy state. 96
button controls, 98-99
check box. 113
closing window, 342
controls, 96
graphic object selection
376
inactive state, 96
indeterminate state. 96
input area. 65
keyboard wput area, 67
opening an icon. 341
powdets, 37
selection, 25
setimg, 108 11
shiger, 1€

! e 1
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increment/decrement
buttons, 119
text, 118
File Manager, 12, 263
application glyph, 41
base window, 265
resizing, 269
binding, 274-75
Browse button, 263
control area, 266
data file glyph, 42
drag and drop, 286, 288
Edit menu, 267
elements, 264
File menu, 267
folder pane, 265, 270
footer, 265
glyphs, 41, 46, 263
default size, 271
operating on, 263
Goto button, 266, 268
images, 41
interaction with applications,
288
Load menu button, 266
naming new files, 283
operations, 264
path pane, 265, 269
properties, 273
protocol, 288
text field, 266, 268
using, 275
File menu, 267
Flle menu button, 266
file name, in header, 52
File Properties item, 266
file typing, 275
files
copying, 280
folder, 271
loading, 288
moving, 280
opening, 279
five-color implementation, 203
fixed elements, 13
flash, title bar, 230

flashing, messages, 55
flushing buffer queue, 92
Folder Commands pop-up
menu, 270
folder glyphs, 266, 271
folder panes, 265, 270, 277
Folder Commands menu,
270
files, 271
glyphs, 271
folders, 276-77
changing, 276
lock, 281
write-protected, 281
font size, 516
fonts, 13, 514
application, 5
OPEN LOOK Ul, 5
sans serif, 5
variable width, 5
footer, 13, 52, 54, 55, 425, 427,
430, 431
dimensions, 425, 426, 427,
430
File Manager, 265
message area, 426
messages, 55
state message area, 429
foreground
controls, 59
objects, 58
text field, 59
window, 57
formats
dates, 515
international, 515
numbers, 515
four-color implementation, 203
frames, 367
Full Size item, 227
help, 503
Full/Restore Size button, 224
function keys
LANGUAGE, 307
mapping, 308

More, 304

soft, 303, 309
Function Keys window, 3034
function names, virtual, 297
functionality, Process Manager,

291

functions

core, 295, 298

text caret movement, 299

text editing, 300

text selection, 301

G

gauges, 17, 117
dimensions, 463
elements, 117
horizontal, 117, 118, 463,
464
inactive, 118
labels, 118
summary table, 125
three-dimensional, 214
tick marks, 117
vertical, 117, 118, 465
global properties, 241-242
glyphs, 39, 89, 191
in abbreviated buttons, 16
application, 271, 273
binding, 274
in buttons, 97
data file, 266, 271, 272
default hierarchical, 194
File Manager, 41, 46, 263,
265

folder, 266

folder pane, 271

hierarchial scrolling list, 194,
480-81

opening, 280

Goto button, 266, 268

Goto text field, using, 276

grab handles, 258, 375

graphic image. 39

548
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graphic objects
copying, 382
grab handles, 375
moving. 386
selecting, 31, 369, 375
selection feedback, 376
graphics
automatic scrolling, 175
selecting, 370
grayscale, icon, 43
grid
default increments, 35
icon, 47
workspace, 35. 47
Grid Ongin setting. 251
Grid Spacing setting, 251
group commands. 101
grouping
menu items, 145
nonexclusive settings, 110
pop-up window. 70
windows, 86

H

halation. 206
handles, resize 358
header, 13, 48, 51, 53, 54 417
busy pattern. 418 421
dmensions, 417, 420
flashing. 230
highfighting. 64 418 421
dimensions, 418-19, 421
for Move Pointer aptior
421=22
property window. 3
pop-up window, 56, 41
busy patterft 4
highlighting L
pushpin. 419
resizing, 5
selected 'w i, &

suggested mapping. 311
help, 22, 90-91

active caret, 500

All Pop-ups item, 510

application, 88

Apply button, 498

Apply item, 499

Apply to New Selection
item. 499

arrow buttons, 494

Back item, 508, 510

Base Window Scale shder,
508

cable anchors, 494

Cancel ftem. 510

changing menu defaults,
496

chck-move-click, 496

Chpboard item, 502

Close item, 503

Color menu. 505

Color menu button, 505

Columns setting. 507

context-sensitive. 88

Current Color setting, 505

Default setting. 505

Dismiss item. 509

Exit item, 502

Full Size item. 503

Help window, 497

Here to Left tem, 511

Here to Top item. 511

icon. 500

inactive caret, 500

increment/decrement
buttons, 507

niiaal Location category,
505

irsikal Size category, 506

i State calegory, 506

joun Viewes item, 512

Lal 10 Here idsm 512

oWirifyng giaks, 407

harade Yanoows catlegory
Wi Gackground. 495

matus 91

More arrow, 493

mouse. 490

moving windows and 1cons,
4N

New Selection item, 498

on-lne, 90

on-screen_ 88

Open item, 503

Onginal Selection item, 498

Owner? item, 511

pane borders. 492

panes, 88

POP-up windows. pushpn
497

pop-up Window menus. 509

Pop-up Window Scale
sliders, 508

press-drag-release, 495

Previous item, 512

Programs item, 501

Properties item. 502, 504

pushpin, 496

Quit item_ 509

Record Current State
category. 507

Refresh item 501, 508, 511

Reset button 498

Reset item. 499

resize corners, 493

resize handles, 493

Restore Size item. 504

Rows setung. 506

scrolibar cable. 495

scrollbar drag area. 494

Scrollbar menu. 511

scrolibars, 88, 433

selecting windows and

icans. 491
S’"l D_-' mlt Dl 409
Set Defat faem, S0
Spracifey) sty 505

(e o deary &4
oF v W ooy £
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using menus, 490
Utilities submenu, 501
window, 88

window borders, 492

Window Color category, 504

Window Controls, 502
Window menu, 503
Window menu button, 492
workspace, 489
Workspace menu, 501
X numeric field, 506
Y numeric field. 506
HELP key, 22
Help window, 22, 68, 88, 89,
484
accessing other help, 90
automatic word wrapping,
89
blocking, 69
dimensions, 483
glyph, 89
help, 497
length of text lines, 89
magnifying glass, 88, 481
messages, 55
More button, 90, 485
pane size, 88
pointer jumping, 70
pushpin, 88
resize corners, 484
scrollbar, 89, 484
standard elements, 88
Here to Left item, 233
help, 511
Here to Top item, 233
help, 511

hierarchical scrolling list, 181,

478, 480
current item, 191
default hierarchical glyph,
194, 480
dimensions, 479
double-clicking. 195
elements, 191
glyph dimensions, 481
glyphs, 194

application-specified,
194
levels, 192
Levels menu, 191, 193
current path, 193
history, 193
item labels, 193
minimum scrollbar, 191
scrolling arrows, 192
text items, 194
title area, 191, 192
title area dot, 192
using Levels menu, 197
using scrolling buttons, 199
high contrast, 206
high resolution, icon, 414
highlighting, 16
abbreviated menu buttons,
449
buttons, 98-9, 446
color, 202, 203
dimmed, 82
header, 418
for Move Pointer option,
421-22
input area, 62
menu items, 144, 318, 468
move pointer option, 64
scrolling list, 477
three-dimensional, 203, 208
history, Levels menu, 193
home, 302
horizontal
buttons, 97
gauges, 117-18, 463-64
nonexclusive settings, 110
scrollbars, 17
position, 155
submenu alignment, 337,
472
horizontal Scrollbar menu, 232
horizontal sliders, 457, 459,
460
hot spots, 9, 37, 38

I

icons, 8, 9, 39

background color, 43
bordered, 39-40, 41, 204
selected, 345
borderless, 39, 43, 44, 204,
345
busy, 40, 42
color, 43, 202
default elements, 40
default region, 47
editor application, 39
grayscale, 43
grid, 47
help, 500
high resolution, 414
image, 40, 41
independent, 57
label, 204
low resolution, 415, 416
monochrome, 414, 415, 416
moving, 350
off screen, 352
nonrectangular, 46
nonstandard, 39, 45
open, 14
open feedback, 341
operating on, 26, 349
overlapping, 9
position, 47, 250
positioning, 35
positions at startup, 60
in reserved areas, 36
scaling, 39
selected, 40, 42
selecting, 25, 343, 345
size, 39, 41
state change, 41
state feedback, 42
text label, 40
title, 42
unselected, 40
workspace grid, 35
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Icons category, 243, 250
Align to Grid setting, 251
Border setting, 251
Grid Origin setting, 251
Grid Spacing setting, 251
Location setting, 250

image
graphic, 39
icon, 40, 41

images, File Manager, 41

implementation
five-color, 203
four-color, 203
three-color, 203

inactive, button, 98

inactive caret, 63, 64. 435
activating, 64
dimensions, 435
help, 500

inactive state, 96
check box, 113
gauge, 118
setting, 108, 112
slider, 116
text field, 123

inches, 86

increment/decrement buttons,

16, 119, 121, 451
dimensions, 452
help, 507
increments, workspace grid
35

independence. device. 4, 293

indeterminate setting. 80
applying, 81

indeterminate state. 81
button, 98
check box. 113
setting, 107 111
shder. 116
text field, 123

inimial location 83
window coord

Inttial Location =g

505

intial size, 83

Intial Size category. help, 506
inmal state, 83
Initial State category. help. 506
Input area, 62, 418
caret, 62
color, 202
feedback, 65
highlighting. 62, 63
insert point, 62
keyboard, 67
moving window with, 352
navigation, 302
NEXTWINDOW, 68
with no caret, 66
pop-up window, 420
PREVWINDOW. 68
restoring previous, 67
scrolling list, 182
setting, 257
TOGGLEINPUT, 68
window to front, 63
on workspace, 67
Input Area category. 245
Input Area palette menu, 249
Insert item, 190, 236
Insert menu
After item. 190
Before tem, 190
insert point, 62, 370
restorng. 71
for wipe-through selection,
378
inserting, text, 371
interface region, 201
nternational character set, 305
internationalization, 6, 513
character validation, 514
color, 518
dewvice independence, 516
font size, 516

frmiats. 515

Rifelll 516

oiptioery 6

oy Al malasE G
et OSpkRy Oeachxon, ©

o =engs 514

user interface level, 6
vertical display. &
ISO character sets, 514
item labels. Levels menu 193
tems, 16
choosing, 183
command, 16, 143
current, 182
dimensions, 469
grouping, 145
hierarchical scroliing hst,
194
menu, 16, 102, 143, 317
properties for scroling lst,
189
summary table, 125
three-dimensional, 211
window, 16, 143

J

Japanese base window. 517

Join Views item, 163, 164, 170
help, 512

jumping. pointer, 11_70

K

Kanp, 37, 517

keyboard
accelerator. 294
core functions, 295
equivalents, 252 253, 297
Nput area, 62
input area feedback, 67

insert porut, 62
mappng, 293, 308, 310
rrel Q7 294
Wiars 09
WA
ey 204
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keyboard functions
cancel, 253
character back, 253
character forward, 253
core, 294
default action, 253
delete character back, 253
delete character forward,
253
Level 1, 294
Level 2, 297
mouse button, 294
mouse modifiers, 294
next field, 253
pop-up window
accelerators, 294
previous field, 253
text field navigation, 294
keyboard input, 16, 62
text fields, 118
with no caret, 66
keyboard mapping, default,
310
Keyboard Miscellaneous
Functions category, 243,
253
keys
caps, 294
control, 294
Enter, 310
HELP, 90
Return, 310
shift, 294
soft function, 303
virtual, 304

)

labels
button, 96, 97, 100
gauge, 118
icon, 204
menu button, 97, 101
scrolling list. 182
slider, 114, 459, 46(

dimensions, 46(

text field, 118
tick marks, 464
dimensions, 465, 466
LANGUAGE, 307
language, support, 307
LANGUAGE key, using, 307
languages, mixing, 515
layout
minimum base window, 49
typical base window, 49
Left to Here item, 234
help, 512
length, of text field, 119
Level 1
certification, 402
keyboard functions, 294
scrolling lists, 181
slider elements, 114
window properties, 83
Level 2
automatic scrolling, 175
certification, 404
keyboard functions, 297
menu default option, 325
move pointer option, 10
multi-level scrolling list, 191
panning functionality, 175
quick duplicate, 381
scrolling list, 181
sliders, 115
text field Edit menu, 237
window properties, 85
Level 3
certification, 406
Process Manager, 291
levels, hierarchical scrolling
list, 192
Levels menu, 191, 193
current path, 193
history, 193
item labels, 193
using, 197
light source, 208
LINEEND. 299
LINESTART, 299

list, scrolling, 181
Load menu button, 266
loading, file, 288
localization, 6, 513, 518
Locate Choice item, 183, 235,
236
Locate Next Choice item, 185,
235
location
Function Keys window, 304
pop-up menu, 323
pop-up window, 74
Location setting, 250
lock, folder, 281
log, message, 55
low resolution, icon, 415, 416

M

magic numbers, 275
magnifying glass, 88
dimensions, 482
help, 497
Help window, 481
Manage Windows category,
help, 507
manage windows setting, 70,
85
mapping
ADJUST, 310
CANCEL, 311
CONSTRAIN, 310
COPY, 311
customized, 306
CuT, 311
default, 310
DEFAULTACTION, 311
DUPLICATE, 310
HELP, 311
keyboard, 310
keyboard keys, 293
MENU, 310
mouse button, 293
NEXTFIELD. 311
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PASTE, 311
PREVFIELD, 311
PROPERTIES, 311
SELECT, 310
SETMENUDEFAULT, 310
UNDO, 311
matrix, check box, 113
maximum/minimum value
labels, slider, 114, 115
measure in, 85, 86
MENU, 10, 293, 298
suggested mapping, 310
menu, 8, 19-20, 141, 467
abbreviated menu button,
103
activating default, 316
border, 142
changing default, help, 496
choosing from, 315
click-move-click, 20, 316
color implementation, 143
controls, 19, 95, 142
default, 134-35, 142, 149
and other windows, 149
changing, 329
default option, 325
default ring, 317
dimensions, 468, 474
dismissing, 134, 315
displaying. 315
drag-nght distance. 254
drop shadow. 142, 413
elements, 142
exclusive settings. 317
executing default, 255
freezing screen, 91
group. 141
help, 490
tighlighting. 144
highlighting item=. 318
items, 102
Levels, 193
MENU mouse
mult-colums
mixed contr
nonexclu
817

outhne, 142 -
pinned, 139

pinned size, 328
pinning, 326, 327
placement, 336

at screen edge, 153

pop-up, 9, 473
position, 449

press-drag-release, 20, 138,

815

pushpin, 11, 21, 142, 150,
317, 469

Scrolling List, 183

SELECT mouse press, 254

stay-up, 139, 255, 316, 320

submenu, 141

titles, 148

transparent drop shadow,
142

types, 141

width, 143

Workspace, 11

menu background. help, 495
menu button, 9, 97, 101, 317,

447
abbreviated. 16. 103, 448
dimensions. 449, 450
default, viewing. 134
dimensions, 447
displaying default, 98
mighhghting, 98
label, 97_101
menu mark, 101
three-dimensional, 210
using, 134 317
Window, 51

menu kems, 16, 143, 317, 468

amensions. 469
aisplaying submenu, 318
arag-right distance_ 318
grouping. 145

SUbITETIU regon S0P
threa-dmansional. delaut

TR |

s k. 16 101, 317, 448

abgniment, 143

ferardans, 448

MENU mouse chck setting,
254 255
Menus category, 243, 254
drag-nght distance. 254
MENU mouse chck. 254
SELECT mouse press, 254
messages, 54-55, 124
beeping, 55
in control areas. 124
error and slate, 13, 133. 429
flashing 55
in footers. 55, 426
Help window. 55
log, 55
long-term, 52, 53
in panes, 124
quick duplicate, 381
read-only. 17
status and error, 52
truncated. 54. 427
migration, 4
milimeters. 86
minimum
keyboard, 293, 294
part of window on screen
362
pattern matching, scroling
hst, 182
proportion indicator, 160
scrolibar, 56. 157, 167, 44
dimensions; 443
split pane size. 358

text area, 158
width, pop-up wandow
ST

window size, 56
miscellansous, Reyboard
funclions, 255
NMiscefianeous catigony
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Set Input Area setting, 257
Virtual Edges setting, 258
mixed controls, on menus, 148
mixing, languages, 515
modifier keys
CONSTRAIN, 352, 385
DUPLICATE, 378
mouse, 258
mouse button, 293
PAN, 175
SETMENUDEFAULT, 329
modifiers, 309
creating, 309
mouse, 295
monochrome, 204
icon, 414, 415, 416
More, function key, 304, 305,
307
More arrow, 38, 54, 427, 428,
431
dimensions, 428
help, 493
placement, dimensions, 431
text duplicate pointer, 379
More button, 90, 485
dimensions, 485
mouse
acceleration, 259
help, 490
MENU click, 254
one-button, 10
three-button, 10
two-button, 10
Mouse Acceleration slider, 260
mouse buttons, 9-10
actions, 312
ADJUST. 10
click, 10
default assignments, 293
double-click, 10
down stroke, 312
drag, 10
functions, 10, 293-94
mapping, 293
MENU, 10
modifier keys, 293

move, 10
press, 10
release, 10
SELECT, 10
up stroke, 312

mouse functions

ADJUST, 298
MENU, 298
SELECT, 298

mouse modifiers, 294, 295

DUPLICATE, 295
PAN, 295
SETMENUDEFAULT, 295

Mouse Modifiers category,

243, 258

mouse press, SELECT, 254
Mouse Settings category, 243

mouse acceleration, 259

multi-click timeout factor,
259

pop-up pointer jumping,
259

scrollbar pointer jumping,
259

mouseless operations, 298
move, 10

quick, 385

move pointer, 38, 408

feedback, 65
highlighting feedback, 64

Move Pointer option, 64

header highlighting,
dimensions, 422
highlighting, 421

moving

border box, 351
constrained, 385
files, 280
graphic objects, 386
pop-up windows, 87
text

dragging, 385

with clipboard, 383
text and graphics, 369
window with insert area, 352
windows, 87

windows and icons, 350
constrained, 352
help, 491
off screen, 352
multi-click selection, 312, 376
caret position, 376
multi-click timeout factor, 259,
312
Multi-Click Timeout slider, 260
multi-column menus, 146
multi-level scrolling list, 191,
478, 480
dimensions, 479, 480
using, 195
multi-line text field, 118, 121
fixed size, 121
variable size, 121
multinational, toolkit, 6
multiple
base windows, 57
quitting, 57
categories, 78
language support, 307
operations, 23
panes, 13
split panes, 361
windows and icons, 23
multiple invocation, pop-up
window, 69

N

name, application, 48
navigation
input area, 302
text field, 294, 297
new selection, 83
property window, 391, 395
New Selection item, 76, 395
help, 498
next field, 253
NEXTFIELD. 297
suggested mapping. 311
NEXTWINDOW. 68, 303




Index

non-numeric characters, In
numeric field. 121

nonexclusive scroling lists,
181, 185

nonexclusive settings, 17, 109,

143, 454
check box, 17, 112
dimensions, 455
elements, 109
grouping. 110
horizontal, 110
in menus, 317
states, 455
three-dimensional, 212
vertical, 110
nonrectangular icon, 46
nonstandard
base window, 50
icon, 39, 45
icon size, 45
normal message. 55
normalization, 161, 165, 178
notebook, 50
Notice window. 92
Notices, 21, 68, 91, 486
blocking. 69
border, 92
button, 92
button placement, 93
color. 201
default button, 91
dimensions. 486
flushing buffer queue. 92
font scaling size, 92
placement, 93-94
pointer umping. 70, 93
shadow patterns, 487
three-dimensional shadow
92
using. 93
number formats. 515
numbers, magic
numeric fields, 11
in control aren
Edit mer
error cheGer

increment/decrement
buttons, 16, 119, 121
451
dimensions, 452
non-numeric characters
121

O

on-screen help, 22, 88, 90
open folder, 271
Open item, 227. 266
help. 503
open lines, 341
OPEN LOOK UI
application-specified
elements, 13
fixed elements, 13
open window, 14
Open/Close button, 224
opening
File Manager glyph, 280
files, 279
operating on
File Manager glyphs, 263
icons, 349
selected windows and
icons, 26
operations
cut/copylpaste, 51
File Manager. 264
mouseless, 298
option. move ponter. 64
optional elements
base window. 52
command window. 72
footer, 52
property window. 76
rEZizE corners, 52

scrolitar, 52
ety ATE&T Traoemiark
Gedice, a0
nige sRleciarn. 391

opiyng changes. 395

dimmed, 82
rmaintaining, 394
Onginal Selection itern. 76
397
help, 498
outhne, menu, 142
overlapping. windows and
icons, 9
Owner item, 230, 511

ownership, pop-up window. 69

P

padding, 120
page sizes, 515
page-oriented scrolibar, 173,
440
PAGEDOWN. 302
PAGEUP. 302
palettes. 5. 202
color, 247
editing. 203
Input Area menu, 249
Selection menu, 248
selecton/input area. 202
summer, 206
system-wide. 202
window background, 202
Windows menu, 248
winter. 206
workspace background
202
Workspace i, 247
PAN. 295

PAN fraccfisr hy

ceEND 300
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color, 201
contents when resized, 354
control area, 128
deleted split, 366
dimmed, 170, 173
folder, 270
help, 88
messages, 124
minimum size, 56
multiple, 13
primary, deleting, 364
rearranging removed, 364
related, 363
resize handles, 358
resizing, 53
resizing multiple split, 361
scrollbar, 13, 155
selected, 433
applying properties, 357
selecting, 39, 52, 357
size, Help window, 88
split, 163-69, 358
removing, 169-73

three-dimensional, 216
tiled, 51
types, 52

PANESTART, 300

panning, 175
constrained, 176
functionality for panes, 175
normalization, 178
using, 176

panning pointer, 39, 411

paradigm, select-then-operate,

23, 341
parameters, command
window, 74
PASTE, 296
suggested mapping, 311
Paste item, 239, 266
paste key, 381, 384
Path Commands pop-up
menu, 269
path pane, 265
elements, 269
pPop-up menu, 269

pattern
button, 97
menu drop shadow, 413
Notice shadow, 487
workspace, 35, 412
pattern matching, scrolling list,
182
pending delete, 371
pinned menu, 139, 326-27
elements, 328
orientation of controls, 329
pushpin, 329
size, 328
title, 328
pinned pushpin, 424
dimensions, 424
pinned window, 73
pixel, 86
placement
abbreviated button menu,
152, 153
button menu, 151
buttons in Notices, 93
menu, 336
at screen edge, 153
Notices, 93
scrollbar, 257
slider, 114
state message, dimensions,
430
submenu, 336
at screen edge, 337
leftmost, 336
rightmost, 337
stay-up menus, 339
platform, internationalization, 6
pointer, 9
basic, 38, 408
busy, 37, 38, 410
changing shape, 37
default, 39
drag, 10
duplicate, 38, 409
hot spot, 9, 37, 38
jumping, 11
suppressing, 11

move, 10, 38, 408
panning, 39, 411
position
pop-up menu, 323
submenu alignment, 337
question mark, 38, 96, 411
standard shapes, 37
stopwatch, 38
target, 39, 357, 367, 412
text duplicate, 38, 379, 409
text move, 38, 410
pointer jumping, 70
in command windows, 70,
73
disabling, 70
in Help windows, 70
in Notices, 70, 93
in pop-up windows, 259,
260
in property windows, 70,
388
restoring insert point, 71
scrollbar, 18, 259, 260
suppressing, 71
pointer movement functions,
298
POINTERDOWN, 298
POINTERLEFT, 298
POINTERRIGHT, 298
POINTERUP, 298
pop-up menus, 9, 19, 141,
3283, 473
dimensions, 474
File Manager Path
Commands, 269
location, 323
pointer position, 323, 324
press-drag-release, 323
Scrollbar, 174
stay-up, 326
title, 142
titles, 148
Pop-up Pointer Jumping
setting, 260
pop-up Window menu, 19, 69,
87, 221
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elements, 228
help, 509
pop-up windows, 9, 21
accelerators, 294, 296
blocking. 69
Character Sets, 307
color, 201
command, 68, 71
dismissing, 69, 73
displaying. 16
Function Keys, 303
grouping. 70
header, 419
busy pattern, 420
dimensions, 420
highlighting, 420
Help, 22, 68, 89
invoking, 68
layering, 87
location, 74
minimum width, 57
moving, 87
multiple invocation, 69
Notices, 68, 91
ownership, 69
pinned menu, 327
pointer jumping, 70, 259,
260
property, 68, 75
pushpin, 11
help, 497
resizing, 56
Window Controls, 26
Pop-up Window Scale slider
help, 508
position
caret, multi-click selection
376
default base window, 60
icon, 47, 250
submenu. 318
positions at startup
base windows, 60
icons, 60
preferences. globai, 241
press, 10

press-drag-release, 20, 138
3116, 817
help, 495
for pop-up menus. 323
PREVFIELD. 297
suggested mapping, 311
previous field, 253
Previous item, 234
help, 512
PREVWINDOW, 68, 303
Print item, 266
Print Screen item, 222, 225
print screen pop-up window.
225
Process Manager, 291
programmatic interface. 514
internationalization, 6
Programs item, 222
help, 501
Programs menu item, 221
Programs submenu, editing.
226, 261
Programs Submenu category,
243, 261
prompts, 55
PROPERTIES. 296
suggested mapping, 311
properties
applying, 387
applying global, 242
applying to selected pane
a7
File Manager. 273
scrolling kst items, 189
window, 14, 50 83
workspace, 241
Properties item, 189, 226, 228
236
nalp. 502, 504
Prop@stes winoow grm, 221
propéaty window. 21, 68, 75
W Ornated menic Distion

apcication. 202

Apply button_ 22, 75
Apply menu, 77
Apply menu button, 76. 395
applying properties, 390
blocking. 69
canceling. 70, 82, 229
change bars, 81, 388
control area. 78, 79
default settings. 76
dimmed highlighting, 77
dimmed origmal selecton
82
dismissing. 82, 229, 397
displaying, 388
header, 388
indeterminate setting, 80
multiple categories. 78
new selections. 391, 395
optional buttons, 76
optional elements. 76
original selection, 391
pinning. 391
pointer jJumping. 70, 388
required buttons, 75
Reset button, 75
scaling size, 87
scrofling list. 189
selection, 82
Set Default button, 76
Settings meny, 19, 77, 221
231
single cal&gory. 78
title, 78
two selectons, 76, 391
jsing, 387

proportan ihdsssine 18, 1569
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default, 72, 137

dimmed, 329

help, 496

help window, 88

menu, 142, 150, 317, 326,
469

help, 501, 508, 511

region

application, 201
default icon, 47
interface, 201

menu default, 150, 334
pinned, 424

dimensions, 424
pop-up window, help, 497
pop-up window header, 419
states, 72, 74
unpinned, 422

dimensions, 423

related panes, resizing, 363
release, 10
removing
dimmed highlighting, 397
multiple splits, 364
split pane, 169, 171, 364
Replace function, 52
replacing, text, 371
required elements

Q

quadruple-click selection, 376

question mark pointer, 38, 96,
411

quick duplicate, 369, 381
read-only messages, 381

quick move, 369, 385

quit, 14

Quit button, 224

Quit item, 228
help, 509

quitting, multiple base
windows, 57

R

read-only gauge, 117

read-only messages, 17, 124
quick duplicate, 381
summary table, 125

rearranging, removed panes,

command window, 71
property window, 75

required menus, 221

adding choices to, 20

Edit menu for text fields, 19,
119, 221

pop-up Window menu, 19,
221

Scrollbar menu, 19, 221

Scrolling List menus, 19,
181, 221

Settings menu, 19, 77

Window menu, 19, 221

Workspace menu, 19, 221

reserved areas, 36, 47, 223
Reset button, 75

help, 498

Reset item, 231

help, 499

resize corners, 13, 26, 52, 53,

353, 417
command window, 72
dimensions, 417
help, 493
Help window, 484

File Manager base window,
269
pane contents, 354
panes, 56
pop-up window, 56
window behavior, 54
Restore Size item, 227
help, 504
restoring, insert point, 71
restraint, color, 201
Return, scan code, 310
Return key, 310
ring, default, 96
ROWDOWN, 299
Rows setting, help, 506
ROWUP, 299

S

sans serif font, 5
save configuration, window
properties, 74
scale, 27
at startup, 257
base window, 30, 85
pop-up window, 30
sizes, 87
windows, 87
scan codes, 310
screen edge
bumping, 352
submenu placement, 337
screen resolution, engineering
drawings, 407
scrollable text pane, 55
scrollbar, 13, 52, 55, 155, 436
abbreviated, 157, 441
abbreviated dimensions,

364 Window Controls pop-up,
. 442
record current, 83 224 .
récord current state, 85, 86 resize handles, 358, 433-34 arg
: cable, 18, 158
507 help, 493
: Wi using, 358, 359 heloge
R 2 N proportion indicator, 159
sh item. 22 resizing, 26

| chors, 162
border box, 354 Ol
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cable area, 162
color, 201
dimensions, 437
with no footer, 438
drag area, 161
help, 494
elements, 18, 156
elevator, 18
position, 160
help, 88, 493
Help window, 89
horizontal, 17, 155
minimum, 56, 157, 167, 443
dimensions, 443
minimum text area, 158
multi-line text field, 118
page-oriented, 173
dimensions, 440
placement, 257
pointer jumping, 18, 259,
260
position, 155
proportion Indicator, 18
resizing, 56
spacing when no footer, 438
three-dimensional, 215
unsplittable area, 167
up and down arrows, 161
using, 18, 160
vertical, 17
scrollbar area, as window
background. 59
Scrollbar menu, 19. 163, 174
221
elements, 232
help, 511
Join Views item, 163, 164
Spiit View, 163
splitting pane, 163
Scrolibar Pointer Jumpsig
setting. 260
SCROLLBOTTOM. 302
SCROLLDOWN. 302
scrolling. 17
accelerators 3012
automatc 121
Help window. 48

normalization. 161, 165
panning, 175
text field, 16, 119

scrolling accelerators, 302
scrolling arrows, 439

dimensions, 439
hierarchical scrolling list
192

scrolling buttons, 16, 103

dmensions, 453

dimmed, 161

hierarchical scrolling list
19

text field, 119, 120, 452

using. 199

scralling list, 181

automatic scrolling. 175

basic, 475

border, 182

choosing from, 181

clipboard, 181

core function keys, 181

current item. 182, 183, 184

476

deleting. 184
remembered, 184

cut/copyipaste functionalty.
181

default glyph, dimensions
481

dimensions, 476

edit menu, required items
235

ediung. 186

exclusive, 181, 183

exclusive vanation. 181, 184

rserarchucal 181, 47
dimensions. 479. 480
selection, 480

nput area, 182

sRTIS 182-83

soel. 182

el 11BN

Le=apd 2. 181

nl\_.-‘"'!.rl.r;&-."l"A 182

-l 191

nonexclusive, 181, 185
pattern matching, 182
properties. 189
property window, 189
required elements. 182
selectable, 477
selecting items, 187
selection, dimensions. 478
text entry field, 189
three-dimensional, 217
using multi-level. 195
validatng entry. 189
Scrolling List menu, 181, 183
185, 221
adding items. 188, 235
Change item, 188
Clear All Choices item, 185
Delete item, 191
Edit List tem, 183, 185
elements 234
End Editing item, 191
Insert tem. 190
Locate Choce 1tem, 183
Locate Next Choxce tem
185
Properties item. 189
using. 188
SCROLLLEFT 302
SCROLLLEFTEDGE. 302
SCROLLRIGHT 302
SCROLLRIGHTEDGE. 302
SCROLLTOP 302

SCROLLLF. 302
SELCHARFWID, 301
SELECT 1 Foi

Sugogestc il S
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header dimensions, 419
pane, 433
selecting
double-click, 350
embedded objects, 367
frames, 367
graphic objects, 369, 375
icons, 25, 343, 345
items, 187
multi-click, 312
multiple panes, 357
multiple windows, 345
panes, 39, 52, 357
syntactic levels, 376
text, 369
multi-click, 376
with SELECT/ADJUST, 373
text and graphics, 370
windows, 25, 60, 343, 344
windows and icons, 342
help, 491
with bounding box, 347,
370
selection
adjusting. 370
adjusting text, 374
color, 202, 206
dimmed, 393
feedback, 25
for graphic objects, 376
graphic objects, 31
hierarchical scrolling list,
480
with more than one value,
80
multi-click, 376
objects, 341
oniginal, 391
property window, 76, 82
scrolling list, 477
temporary, 381, 385
text, 371
wipe-through. 371
text functions, 301
toggle, 370
wipe through. 3(

Selection palette menu, 248

SELLINEFWD, 301
SELWORDFWD, 301
separators, 515
Set Default button, 76
help, 499
Set Default item, 232
help, 500
Set Input Area setting, 257
Set key. 307
SETMENUDEFAULT, 295, 329
suggested mapping, 310
settings
border, 105, 106, 107, 111
as category, 79, 243
choosing none, 108
in control area, 129
default, 106, 111, 147
dimmed border, 111
exclusive, 17, 105, 453
feedback, 106, 111
grouping, 110
inactive, 112
inactive state, 108
indeterminate state, 80, 107,
111
insert point, 370
manage windows, 70
on menus, 146
multiple values, 109
nonexclusive, 17, 109, 454
summary table, 125
three-dimensional, 106
variation, 108
virtual edges, 258
Settings menu, 19, 77, 221,
231
elements, 231
shadow, menu, 142
shadow, Notice, 92, 487
shift key, 294
Show key. 307
shrink, 56
single category, 78
size
File Manager glyphs, 271

icon, 39, 41
pinned menu, 328
window, 14, 56
sliders, 17, 88, 114
bar, 117
channel, 213
in control area, 129
current value field, 114
default, 116
dimensions, 458
drag box, 114, 116, 117
elements, 114
end boxes, 115, 459-60
feedback, 116
horizontal, 457
inactive state, 116
indeterminate state, 116
labels, 114, 459
Level 1 elements, 114
Level 2 elements, 115
maximum/minimum value
labels, 114, 115
Mouse Acceleration, 260
Multi-Click Timeout, 260
placement, 114
summary table, 125
text field. 17, 114, 117
three-dimensional, 114, 213
tick marks, 115, 116,
459-60
using, 117
vertical, 115, 461, 462
dimensions, 461, 462
soft function keys, 303, 309
Sort By, 274
sort order, 515
specifications, bitmap,
availability, 407
Specified setting, help, 505
spectral extremes, 206
split panes, 163, 358
cable anchors, 167
contents, 358
limitation, 163
minimum size, 358
multiple carets, 66

560
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removing, 169, 171, 364
removing multiple, 364
resizing muttiple, 361
Scrollbar menu, 163
Split View item, 163
help, 512
standard busy pattern, 61
standard menus, 9
startup, scale, 257
state
record current, 86
window, 85
state change, icon, 41
state feedback, icon, 42
state message, 13, 55
area, 429
dimensions, 431
placement, dimensions, 430
states
exclusive setting, 454
nonexclusive setting, 455
status information, 55
stay-up menu2, 139, 255, 316,
320, 326
busy pattern, 320
choosing from, 316
dismissing, 316, 321
displaying, 316
displaying submenus, 321
submenu placement, 339
STOP, 298
stopwatch, 38
submenu, 141, 317, 471
alignment, 145
drop shadow, 338
changing default, 330
default control, alignment,
322
default item alignment, 319
dimensions, 472
displaying. 145 318
displaying another. 319
displaying default ring. 319
honzontal alignment 33
472
horizontal posttior

number of, 141
placement, 336
leftmost, 336
nghtmost, 337
at screen edge, 337
stay-up menus, 339
position, 318
region, 317
for stay-up menus, 321
subsidiary base window, 57
summer palette, 206
supporting, multiple
languages, 307
suppressing, pointer jumping

71
syntactic level, defining for
multi-click, 377

syntactic level selection, 376
system beeping. 256
system-wide palette, 202

T

target pointer, 39, 357, 367,
412
temporary selection, 381, 385
text
adjusting selection, 374
in color, 203
copying by dragging. 378
copying with cipboard, 377
direction, 514
inserting, 371
moving. 369
with clipboard. 383
by dragging. 385
multi-chick selection, 376
replacing. 371
selecting. 369, 370
with SELECT/ADMIST, 373
saleclion
daubke-click, 378

quadrupha-chick, 37
tpds-click, 378
wipe-through. 37 i

lext caret moverren! \cions
200
CHARBAK. 299
CHARFWD, 299
DOCEND. 300
DOCSTART. 300
LINEEND, 299
LINESTART, 299
PANEEND. 300
PAMNESTART 300
ROWDOWM, 299
ROWUP 299
WORDBAK, 299
WORDFWD. 299
text display dsection. 6
text duplicate pointer, 33 372
409
text ediing functions, 300
DELCHARBAK 300
DELCHARFWD. 300
DELLINE, 300
DELLINEBAK, 300
DELLINEFWD, 300
DELWORDEBAR. 300
DELWORDFWD, 300
text entry field, scroling !
189
text field. 6. 118,246
for abbrevusted rmen

button. 103, 104
automatic scxollng, (21
175
borcer. 118
carg! possaon 11
change t [
T A= 1
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multi-line, 118, 121
fixed size, 121
navigation, 297
functions, 294
NEXTFIELD, 297
PREVFIELD, 297
proportionally spaced
characters, 120
scrollbar, 118
scrolling, 16, 119
scrolling buttons, 119, 120,
452, 453
slider, 17, 114, 117
summary table, 125
three-dimensional, 119, 215
underlineg, 118
validation, 81, 117, 123
window foreground, 59
text flow, 517
text label, icon, 40
text line, length in Help
window, 89
text move pointer, 38, 410
text orientation, 513
text selection, 30
text selection functions, 301
SELCHARFWD, 301
SELLINEFWD, 301
SELWORDFWD, 301
UNSELCHARBAK, 301
UNSELLINEBAK, 301
text strings, 514
help, 91
This Window item, 230
help, 510
three-color implementation,
203
three-dimensional
abbreviated menu button,
210
button, 97, 209
button highlighting, 99
cable anchor, 215
check box, 213
design, 5, 95, 206
design elements, 207

elevator, 215
gauge, 214
header, 216
highlighting, 203, 208
items, 211
light source, 208
menu button, 210
menu item, default, 211
pane, 216
raised, 208
recessed, 208
required color groups, 207
scrollbar, 215
scrolling list, 217
settings, 106, 212
shadow, 92
slider, 114, 213
text field, 119, 215
tick marks, 213, 214
window elements, 216
tick marks
dimensions, 460, 464, 465,
466
gauge, 117, 464
labels, 464
slider, 115, 116, 459, 460
three-dimensional, 213, 214
tiled panes, 51
timeout, multi-click, 259, 260,
312
title area
dot, 192
hierarchical scrolling list,
191, 192
titles, 51
application, 42
command window, 74
icon, 42
menu, position, 148
pinned menu, 328
pop-up menu, 142
property window, 78
window, 54
toggle, selection, 370
TOGGLEINPUT, 68, 303
toolkit, multinational, 6

Top to Here item, 234
help, 511
trademark, certification, 401
Trademark Guide, ordering,
401
transitory control area, 139
transitory window, 21
transparent drop shadow, 142
triple-click selection, 376
truncating
long-term messages, 53
window title, 54

U

UNDO, 296
suggested mapping, 311
Undo item, 239, 266
unpinned pushpin, 422
dimensions, 423
unpinned window, 72
UNSELCHARBAK, 301
UNSELLINEBAK, 301
unsplittable area, 167
unzoom, 227
up arrow, 161
up stroke, mouse button, 312
up-down encoded
alphanumeric keys, 309
up-down encoded keyboard,
294
user interface level,
internationalization, 6
using
clipboard, 281, 383
File Manager, 275
folders, 276, 277
Goto text field, 276
help, 90
Join Views item, 170
LANGUAGE function key,
307
Levels menu, 197

=
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menu buttons, 134, 317
menus
chick-move-click, 316
help, 490
press-drag-release, 315
mouse buttons, 9
multi-level scrolling list, 195
page-oriented scrollbar, 173
panning, 176
pop-up stay-up menus, 326
property window, 387
pushpin, 11
resize corners, 353
resize handles, 358, 359
scrollbar, 18, 160
Scrollbar menu, to remove
split, 170
scrolling buttons in
muilti-level scrolling list,
199
Scrolling List menu, 188
sliders, 117
virtual function names, 297
Virtual Keyboard window,
306
window button, 131
Utilities item, 222
Utilities menu item, 221
Utilities submenu, 222-23
help, 501

Vv

validation
internationalization, 514
scrolling list entry, 189
slider text fied, 117
text fields, 81, 123
variable size, multi-ine text
field, 121
variable width font. 5
variation, exclusive seting
108
vertical
buttons. 97
gauges, 117, 11 465-&

nonexclusive setting. 110
scrollbars, 17
shiders, 115, 461, 462
vertical display 6
vertical Scrollbar menu, 232
virtual edges, 36, 223, 251,
258
virtual function names, 297
Virtual Keyboard, 305
customized mapping, 306
using, 306
virtual keys, 304
visual design. 5
visual feedback
controls, 96
highlighting, 16
pointers, 37

W

white space, 145
width of menus, 143
window background
color, 5-6, 201
messages, 124
window button, 100
abbreviated. 450
dimensions 451
using. 131
Window Color category help
504
Window Controls, 26, 223
help. 502
Window Controls iterm, 222
Window Controls pop-up, 349
adaing controis, 225
deiaull, 223
elamerits, 223

rEiZe COMRES, &<
Window ey, 10, 343
W AR 16 "’.1-'
Windiow mpny_ 1419, 24, 48
&5 20}
ISTATNG a4

elermenta. 226
help. 503
pop-up. 69
Window rmenu bution. 13, 48,
51,54
pusy feedoack. €
help, 88, 492
wiINdow Proper s, Sarv
configuraticry, 74
windows. 8
area when meized 356
background. 24, 57, 5& 64
87,344
background cukct, 204. 258
base 12
border color. 202
borders. 54
help. 492
busy. 60. 61, 62
Character Sets 307
clipboard, 51. 225, 364
Close 14
closing feedback. 342
color. 202. 206
Color Samplis, 24k
command, 68, 71
control area. 13
default background oo
202
elemerts
thrpe-Cirer=onal. 216
erTwWITOTEN, &
File Manage Dase. 260

faetest )
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open, 14
operating on, 26, 349
origin, 87
overlapping, 9
pane, 51
pinned, 73
pop-up, 21, 68
positions at startup, 60
print screen, 225
properties, 14, 50, 83-86
base window scale, 85
color, 83, 85
grouping, 86
initial location, 83
initial size, 83
initial state, 83
Level 1, 83
Level 2, 85
manage windows, 85
measure in, 85, 86
record current, 83
record current state, 85,
86
property, 68, 75
resize corners, 13, 353
resizing, 26, 54
scaling, 27, 87
scrollbar, 13
selected, 60
header, 419
selecting, 25, 60, 343,
344-45
selection feedback, 61, 344
size, 14, 56
state feedback, 60
transitory, 21
unpinned, 72
unselected, 60
Virtual Keyboard, 306
Window menu button, 13

Windows palette menu, 248
winter palette, 206
wipe-through selection, 30,

371
insert point, 373

word, definition of, 515

word wrapping, automatic, 89
WORDBAK, 299

WORDFWD, 299

workspace, 8

50 percent pattern, 35
color, 35, 201, 202, 204, 206
exit, to apply properties,
242
File Manager glyphs, 46
grid, 35
help, 489
input area, 67
pattern, 412
properties
future, 241
when set, 241

workspace grid, 47
Workspace menu, 11, 19, 221

category, 243, 262
Clipboard window, 51
customizing, 226
editing, 261
elements, 221

help, 501

Workspace palette menu, 247
Workspace Properties, 241

abbreviated menu button,
246

beeping messages, 55

color, 202, 243

Color category, 245

Color Sample window, 246

core functions, 369

Custom setting, 244
Level 2, 245

default icon region, 47

drag-right distance, 145,
318

editing Workspace menu,
223

elements, 242

Executes Default option,
325

Factory setting, 244

HELP key, 90

icon borders, 44

Icons, 243

Icons category, 250

keyboard core functions,
243, 252, 295

keyboard functions, 294

Keyboard Miscellaneous
Functions, 243, 253

Menus, 243, 254

Miscellaneous, 243, 255

mouse button assignments,
293

Mouse Modifiers, 243, 258

Mouse Settings, 243, 259

move pointer option, 64

PAN modifier key, 175

pointer jumping, 11, 70

Programs Submenu, 243,
261

scrollbars at left, 155

SELECT brings window to
the front, 63

Settings category, 243

system-wide palette, 202

virtual edges, 36

window, control area, 243

workspace grid, 35

Workspace menu, 243

Workspace Menu category.
262

write-protected folder, 281

X

X numeric field, help, 506
Xerox Corporation, 5

Y

Y numeric field, help, 506

Z

zoom, 227

64
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